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Real 720 x 720 dpi. 
While other products pretend, the new BJC-620 

All of a sudden printer brands are talking about plain paper printing. It seems 

they have belatedly discovered something Canon has known for years. 

Plain paper is a lot less expensive than special paper. Which is why Canon 

Bubble Jet printers are optimised for plain paper. 

The Canon Advantage. With the new BJC-620 we go a step further. 

You actually get true 720 x 720 dpi resolution on plain paper for a price 

Printing System of just $999.RRP (This is more difficult than it sounds, which is why 

not everybody has it.) 

Prove it to yourself. We invite you to check out the 

competition. Very carefully. What you’ll discover is that 

only one of the products listed on the right offers full 

720 x 720 dpi resolution on plain paper, and not expensive 

special paper. 

Now faster too. Of course, there are other reasons to consider the new 

BJC-620. For instance, it combines the Windows Printing System® for 

exceptionally fast RTAs, with a new engine that has colour throughput up to 

twice as fast as its preceding model. 

Three year warranty. What’s more, Canon has introduced a new warranty 

option. For an amazingly small price you can extend the warranty on your 

printer from 1 to 3 full years*. 

a % If you would like to learn more about the 

1 BJC-620, or obtain the name of a reseller near 

you, give us a call on 1 800 021 167. 

720 x 720 ON PLAIN PAPER 

Canon BJC-620 Yes 

Epson Stylus Pro No 

Epson Stylus 500 No 

HP DJ 690C No 

Any HP 800 series printer No 

BJC-620 Colour Bubble 
Canon Australia Pty Ltd ACN 005 002 951. 



Even on plain paper. 
has full colour printing on plain paper in finest mode. 

Jet* Printer $999 RRP Canon 
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iVlAKE SURE YOU BUY 

GENUINE 
MICROSOFT SOFTWARE 

Inside info 

Microsoft Press has some great new titles, as does 
MSTV. There’s also the new version of Frontpage to get 

Online 

Spare time on your hands over Christmas? Must be 
time to crank up the modem and jump on the Net. 
We’ll show you some sites which are sure to spark 
your interest. 

Offer of the Month 

A multimedia PC package is on offer this month, with a 
free fax/modem thrown in. There are also some 
fantastic offers for members in Advantage. 

The Big Index — 1996 

No need to scramble through the past year’s Communique 
issues searching for that article you want to read again. 
The search begins and ends here in our annual 
Communique pull-out-and-keep index. 

Meet the Dream Makers 

The marriage between Microsoft and DreamWorks has 
two exciting new multimed@*|#ifS, Goosebumps: 

Discover how th 
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Departments^) 

I Readers share their thoughts and ideas from 
I Windows 95 and merchandising to science fiction! 

Competition Corner 

I The challenge is on again! There ai 
I in our Christmas Comps. 

Computer users come from all walks of life. We 
drop in on two famous users, Kim Watkins and 
Elliot Goblet, who share with us their most 
personal and intimate thoughts on their PCs. 

Riled with the spirit of Christmas, the Wiz is even 
more giving! Those seemingly confounding queries 
and questions are resolved with ease. 

These tips are hot, hot, HOT! Check out what 
advice Communique members offer to the 
rest of us. 

Piracy and You 

’"KsSVlh Each year, software piracy costs the industry $15.2 billion 
dollars. But what is piracy and how does it happen? What can 
be done to stop it? 

Sci-fi Winner 

The second annual Communique Science-Fiction Competition 
has been awarded. Turn to page 64 and discover the winner 
— it’s a ripping yarn! 

The Right Tools for the Job 

Microsoft has the complete solution to all your Internet needs, 
from viewing Web content to building massive corporate Web 
sites. We look at how Microsoft does this and what tools are 
at hand. 

Kids’ Communique 

This month, Kids' Communique is packed to the brim with info! 
We take a look at some brand new multimedia titles, 
Goosebumps: Escape from Horrorland and The Neverhood. 
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Welcome to the annual Communique bumper 

issue. We’ve packed in plenty of holiday reading 

to last you until February, which is when the 

next issue rolls around. 

In our cover story, the DreamWorks/Microsoft 

alliance has produced two hot new multimedia 

titles, Goosebumps: Escape from Horrorland and 

The Neverhood. We take a look at how this 

marriage between a group of computer and 

showbiz industry luminaries has shaped up over 

the past year. 

And, as usual with the bumper issue, we’ve 

included a heap of tutorials to help you better 

use your Microsoft software. One of these 

tutorials features the new Publisher 97 

application. You’ll also find tutorials on that 

perennial favourite, Works 95 and the Web 

management software, Frontpage. 

This issue, we publish the winner of our 

Annual Science-Fiction Competition. Many 

thanks to everyone who entered and helped 

again to make this competition such a success. 

In Online World, we’ve asked technical expert 

Robert Kirwan to take us for a journey online, 

and show us some of the more entertaining sites 

you can visit on the Web. It’s a cracker of a read 

and will more than fill in any free time you have 

on your hands during the Yuletide season. 

One of next year’s most exciting releases will 

be Microsoft Office 97. Turn to page 32 for an 

in-depth look at the great new features this new 

version has to offer. 

Season’s greetings to all and enjoy the issue. 

Darren Edwards 

When Jean Whimp went in search of family history 

halfway across the world, through the air, then 

across the land, and then over the sea, she took her 

favourite magazine along for company and to make it 

the perfect trip. 

She’s pictured here drenched in family history and 

absorbing every drop of it at the ruins of the mill at 

Cornaigmore which her great-grandfather ran for the 

Duke of Argyll. The mill slumbers on the Island of 

Tiree, flat and windswept but endowed with beautiful 

beaches and lying beyond the Island of Mull off the 

west coast of Scotland. 

Her special mix of fidelity and adventure has won 

Jean a bright new Communique T-shirt to help spread 

the news of the hallowed program when hunting 

down further relatives on other continents. 

You too could own this special accoutrement by 

sending us a shot of yourself somewhere interesting 

with a favourite edition of Communique in your grasp. 



The Final Word In 

Turning Your Data Warehouse 

Into Business Intelligence. 
The problem isn’t getting more data. It’s getting more from the data you have. And empowering 

your end users with robust tools to get at, and understand, warehoused information. Put them in 

the drivers seat with powerplay and Impromptu—the best query, reporting and multidimensional 

analysis solution on the market today. It leverages the data warehouse by turning your corporate 

data into business intelligence. And blows your competition away. Call us to find out how. 

Impromptu®. Interactive reporting for the enterprise • PowerPlay®. The worlds most popular OLAP solution 

Call 1-800-811-910 

rATkiAC 
VJV/V8S1IW 

Tools That Build Business™ 

Dealer enquiries phone I.T. ConnXions on 1800 024 233 

Cognos’ Premier Partners are IT Solutions Pty Ltd 08 8332 1977, Hexagon Computer Systems Pty Ltd 02 9955 6322 

8c Dialog Pty Ltd 07 3368 2011 

J1546 



Outlook 97 
STEP.. 

STEP 

Outlook 97 reference 
Microsoft Outlook 97 Step 

by Step 

■soft Outlook 97 Step by Step 

iides a personal training system 

who want to get up and 

ling quickly and easily with 

■soft Outlook 97, the new 

desktop information manager in 

Office 97 which has everybody 

talking. The easy-to-follow lessons 

present clear objectives and real- 

wofld business examples, with 

plenty of screen shots and 

illustrations. 

For the programmers 
Microsoft Office 97 Visual 

Basic Programmer’s Guide 

jaders will learn to create concise, 

Icient code with the powerful 

igramming language now found 

throughout Microsoft jDffice applications - Microsoft 

Visual Basic fbf Applications. Microsoft Office 97 Visual 

Basic Programmer’s Guide shows how to become more 

productive with Visual Basic for Applications by 

customising and adapting tools for specific needs. You’ll 

learn how to create custom commands, menus, dialog 

boxes, messages and buttons, as well as display custom 

online help for all these items. 

ISBN: 1-57231-340-4, ERP: $69.95 

ft 

ISBN: 1-57231-382-X, ERP: $49.95 

More Outlook 97 reference 
Field Guide to 

Microsoft Outlook 

97 

Another title about Microsoft 

Office 97, Field Guide to 

Microsoft Outlook 97 is the 

latest in the best-selling 

Field Guide quick reference 

series. It’s a concise visual 

reference designed to help 

beginning-to-intermediate 

users - especially travellers 

and laptop users who need 

a portable reference. It 

provides quick, to-the-point 

answers about Microsoft 

Outlook 97. 

ISBN: 1-57231-383-8, ERP: 

$17.95 

Getting started with Office 97 
Learn! Microsoft 

Office 97: Getting 

Started 

An entertaining and high- 

quality video, Learn! Microsoft 

Office 97: Getting Started 

covers all the basic features of 

Office 97, along with the 

tricks and concepts that Mi 

put Office 97 to work rigaf 

of the box. You’ll learn ho* 

create and save documents, 

use wizards to get professional 

results with minimal effort, an 

combine text, graphics, and 

numbers into stunning 

multimedia presentations that can 

be published on the World Wide Web. 

ISBN: 1-57231-550-4; ERP: $49.95 

These titles will all be available late January. 

COMAUNIQUEB 
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Web Publishing 
Frontpage 97 is almost here! And there's even a Bonus 

Pack to boot! 

Microsoft Frontpage 97 with Bonus Pack delivers a 

complete set of advanced Web publishing tools to 

webmasters and novices alike, offering an entirely new 

category of software - the Web suite. 

The introduction of FrontPage 97 with Bonus Pack 

includes comprehensive and intelligent support for the 

newest and hottest Internet technologies such as ActiveX 

Controls, Java applets and Netscape plug-ins. These tools 

are now easily accessible from the FrontPage toolbar or 

through new drag-and-drop capabilities. 

The Database Connectivity Wizard walks users through 

the process of connecting to and performing dynamic 

queries from a database, making it easy to deliver this on 

a FrontPage-based Web site. In addition, the ability to 

edit HTML source code directly within FrontPage delivers 

maximum flexibility to users with a knowledge of HTML. 

The code is colour-coded for easy viewing and editing. 

The Bonus Pack introduces Microsoft Image Composer, 

an easy-to-use and powerful tool for creating, arranging 

and customising on-screen graphics. With this application, 

users can customise images by applying any of the more 

than 500 art effects included with the product, as well as 

by running effects through Photoshop plug-in products 

such as Kai's Power Tools. Image Composer includes 

more than 600 royalty-free, Web-ready images from 

leading stock photography companies such as 

PhotoDisk Inc. 

The Bonus Pack also includes the Microsoft Personal 

Web Server, the Windows 95-based version of the 

popular and powerful Microsoft Internet Information 

Server, providing users with enhanced performance and 

management features to make administering an Internet 

or intranet site easy. 

And, of course, there's the Microsoft Internet Explorer 

3.0, the award-winning browser which enables users to 

view rich and exciting Web content, communicate and 

collaborate with users everywhere, and fully personalise 

the online experience. 

FrontPage 97 integrates fully with Microsoft Office. 

OfficeLinks management through FrontPage allows users 

to manage Office 97 hyperlinks easily and accurately. 

FrontPage 97 

intelligently treats 

Office documents like 

any other Web element. 

A consistent user 

interface makes 

FrontPage look and act 

like other Office 

applications, so users 

can easily create and 

manage FrontPage- 

based Web sites with 

many of the same tools 

and features they 

already use to create 

and manage Office 

documents. 

Microsoft FrontPage 

97 with Bonus Pack runs on the Windows 95 and 

Windows NT operating systems. 

Frontpage 97 will be available at the same time as 

Office 97 with an ERP to be announced. In the 

meantime, you can download a beta version free at 

http://www.microsoft.com/frontpage/97beta/ A Macintosh 

version of Microsoft FrontPage is scheduled to be 

available in early 1997. 

It’s Microsoft TV! Opening the door to clearer understanding for the IT 

professional, Microsoft Television Studios have 

released another thirty new video titles aimed at giving a 

quick insight into Microsoft solutions. These information 

videos deal with real-life situations integrating intranet 

and Internet connectivity with Windows 3.11, 95, 

Windows NT and Netware through dynamic Microsoft 

solutions. MSTV will show you how you can deploy, plan 

and tune Microsoft solutions for your particular Net or 

office needs. 

One of the hottest titles from this series is Publishing 

Information on the Internet. It will show you how you 

can use Microsoft’s new Internet Information Server, 

Microsoft’s Internet Explorer, and Internet Assistant for 

Word for Windows to get a jump on your competition 

and start publishing on the Internet or internally. 

Dec/Jan 1996/97 



31 sifuiinim. 

Vj 

Some of the new releases include: 

• Windows NT Workstation 4.0 - Product Overview 

• Deploying Windows NT Workstation 4.0 

• Windows NT Workstation in Business Computing 

• Distributing Computing Series: Messaging and 

Workflow Technologies 

• Inside Microsoft Office: Frontpage 

and the Intranet 

• Microsoft Office Solution! Series: 

Retail Banking Solutions aQthe Bank 

of Newport 

• Networking with Windows 95, 

Including Printing 

• Working with Windows 95: 

Windows 95 Microsoft Exchange Fax 

• Working with Windows 95: 

Windows 95 Microsoft Exchange 

Inbox MS Mail 

• Windows 95 Systems Administration 

& Tools 

• Bill Gates Keynote: Live From 

Networld + Interop 

• Microsoft Internet StrategJBHHraH 

Workshop: Featuring Bill Gates 

• Information Sharing Made Easy 

• Virtual Offices and Alternative 

Workplaces 

• Integrating Microsoft Office and 

Microsoft BackOffice 

All MSTV videos are only $49.90 

each, and Communique members are 

entitled to a 10% discount! 

For a complete and up-to-date list from Computer 

Television call 1-800 999 848 and they will be happy to 

answer any of your questions. Next-day delivery is 

available to most major centres. 

Teamwork for 
Office 97 Managers and their teams need a single tool to 

manage their mutual activities, as well as a 

convenient way to keep everyone on the team up to date 

on the status of their ongoing work. To keep the team in 

CQAMUNIQUEE' 

sync, team members need a product that allows the entire 

team to see and understand the overall team plan. 

Enter Microsoft Team Manager 97, a new workgroup 

software product designed to keep teams in sync by 

consolidating, coordinating and tracking team activities. 

It's the newest member of the Office family of products, 

itibgigned to help managers and their teams communicate 

and collaborate more 

effectively, improving 

teamwork and 

increasing 

productivity. 

Microsoft Team 

Manager facilitates 

better communication 

among team 

members and 

managers by storing 

all team information 

in one tool. It saves 

time by automatically 

consolidating and: 

tracking work 

entered by team 

members, while 

managers and team 

members have access 

to accurate and 

current team 

information using a 

variety of features. 

They include: 

• Task Organizer - types of information such as tasks, 

actual work and status reports are consolidated from 

multiple team members for a more convenient, organized 

way of collecting information. 

• Reports - the Team Manager generates customisable, 

automatic recurring reports, including performance 

evaluations, status reports and multiple, customizable 

views of ongoing work. 

• Sorting and filtering - with the data group sorting and 

filtering features, it’s easy to view the most relevant 

information in the team file. 

• Deadline-Based Scheduling - this feature helps ensure 

that all employees can get their work done to meet 
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deadlines 

Microsoft Team Manager 97 

coordinates individual activity with 

the overall team plan, so everyone 

can participate in the planning 

process. This is easy because Team 

Manager works with existing 

infrastructures and tools. 

It can be used either as a 

standalone application or with the 

Microsoft Outlook desktop 

information manager and Scheduler- 

version 7.0. 

With the release of Microsoft Office 97 just Sgjpund 

the corner, Microsoft has two companion products 

which will also be released, and which have been 

developed specifically for developers. 

The two products are Microsoft Office 97, Developer 

Edition and Mastering Office 97, a multimedia training 

product for developers to learn how to build solutions 

with the new features of Microsoft Office 97. 

Microsoft Office 97, Developer Edition is designed for 

the more than 1 million developers who use Microsoft 

Office to build business solutions. It has everything 

needed to build and distribute solutions with Microsoft 

Office in one product, including Microsoft Office 97 

Professional Edition, software tools, printed 

documentation, sample code, and distribution licensing 

for the royalty-free Microsoft Access runtime and other 

development tools. 

Designed to be the most complete Office-based 

development suite, Microsoft Office 97, Developer Edition 

includes the following components: 

• Microsoft Office 97 Professional Edition, which includes 

Microsoft Access 97, Microsoft Excel 97, the PowerPoint 

97 presentation graphics program, Word 97 and Outlook 

97. 

• Visual Basic for Applications 5.0, the shared 

development environment for Microsoft Office and the 

Internet 
Explorer 3.0 Internet Explorer 3.0 for the Window 95 and Windows 

NT 4.0 platforms has changed the way we view Web 

pages. Now, Microsoft has released the Internet Explorer 

3.0 for the Windows 3.1 operating system, available to 

download free. 

Microsoft Internet Explorer 3.0 now puts users of 

Windows 3-1 a step ahead on the Internet by offering the 

following new and improved features: 

• Low memory requirements - Microsoft Internet 

Office 97 
for the 
developers 

Replication 

nager for adding 

phisticated data- 

1 lication 

liabilities to 

lutions. including 

pport for Internet 

.plication and 

irtial Replicas. 

HTTP, FTP, 

pher and other 

Sinponents that 

extend the capabilities of Microsoft Office 97. 

• Technical information and code samples from the 

Microsoft Developer Network. 

Mastering Office 97 Development, the newest member 

of the Mastering Series of interactive multimedia training 

products, provides developers with hands-on training for 

building solutions with Microsoft Office 97. Mastering 

Office 97 Development includes over 40 hours of 

training, including labs and extensive code samples. 

For more information, you can go to the Office 

Developer Web site at 

http://www.microsoft.com/officedev/ 

COMAUNIQUEB 9 
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Explorer 3 0 for Windows 3.1 offers quick performance 

and access to current Internet technologies without 

requiring the latest hardware. Microsoft Internet Explorer 

3.0 for Windows 3.1 runs on PCs with 386 processors and 

4 MB of RAM, making it a great solution for corporate 

environments where a mix of hardware is used for 

connecting users to intranets and the Internet. 

• Netscape plug-ins - Microsoft Internet Explorer 3.0 is 

compatible with Netscape’s proprietary plug-in 

technology. This support provides backward compatibility 

with existing Web content, further enhancing Microsoft 

Internet Explorer’s broad support for Internet content. 

• New Internet Mail Client - introduces users of Windows 

3.1 to the new Internet Mail Client, which makes it easy 

for anyone to start communicating using e-mail. This 

small, fast client uses SMTP and POP3 protocols to send 

and receive e-mail messages. All of the options needed to 

send, receive and reply to e-mail messages are easily 

accessible, including a new preview panel that enables 

users to find important information quickly. 

• ActiveX Scripting - Microsoft Internet Explorer 3.0 

supports the most comprehensive and language- 

independent script capabilities, including both the Visual 

Basic programming system, Scripting Edition and Jscript 

(Microsoft’s JavaScript-compatible scripting language). 

ActiveX Scripting can be used by developers to build 

Web-based applications that can gather data, react to user 

input and more. 

• Improved security with SSL over proxy - users of 

Windows 3.1 can now use Internet standards for ensuring 

private communications. Support of secure sockets layer 

(SSL 3) and private communications technology (PCT) 

standards ensures that the data cannot be read if 

intercepted. Microsoft Internet Explorer 3-0 for Windows 

3.1 will also warn users when they’re about to use an 

unsecured connection and can even check a Web server’s 

security certificate. 

The Internet Connection Wizard (ICW) for Microsoft 

Internet Explorer 3.0 gives users of Windows 3-1 an easy 

way to sign up with an Internet service provider (ISP) 

and set up an Internet account. Using Microsoft wizard 

technology, the Internet Connection Wizard walks users 

step-by-step through the process of locating an ISP and 

automatically configures their machine to connect to the 

Internet. Microsoft Internet Explorer for Windows 3.1 also 

includes a TCP/IP protocol stack and dialer, offering 

home and corporate users everything they need to get 

online. 

Microsoft Internet Explorer 3.0 for Windows 3-1, as 

well as versions for other platforms, including Windows 

95, the Windows NT operating system and the Macintosh, 

are available for free download at Microsoft’s Web site, 

http://www.microsoft.com/ie/ 

For online product information: Microsoft Internet 

Explorer Web page: http://www.microsoft.eom/ie/B 

IMPORTANT CORRECTION 
On page 29 of the November issue of Communique 

there is a coloured box intended to outline the current 

Office 95 cashback offer. As readers will have found out 

when they checked with Communique. Microsoft or their 

retailer, some of the text in the box was incorrect. 

The box stated that when readers buy Office 95, they 

would be entitled to cashback entitlements on certain 

hardware on the conditions set out in the box. This 

included $100 off either a Banksia My Voice Modem or a 

Panasonic Digital Answering Machine. The discount level 

on these two items is only $50 and to that extent the 

advertisement is incorrect. We apologise unreservedly for 

the error, of which we only just became aware - the rest 

of the information in the box is correct. 

COAMJNIQUE M 
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QUARTERDECK® 

Make the worfd Your Office 
Introducing the Procomm Plus® tor Windows 95. 

Data Communications, Fax, Remote Fax Facilities at Your Fingertips 
Control and Internet All in One! 
Now, the most powerful data communications program 

available gives you point-and-click access to everything you 

need. From wherever you happen 

to be. Send or receive faxes, 

connect to a host computer, get on 

the web, or access a program on 

another computer from a remote 

location. The Connection 

Directory stores all of your key 

telecommunications information — one click automatically 

adjusts your PC’s system settings to make the connection! 

Remotely Access Any PC or Network 

restricts access to your PC 

Access your PC from another 

computer with the fast and 

powerful Procomm Remote. It 

gives you full remote access to 

your PC’s files and 

applications. And a full 

range of security features 

d everything on it. 

Connect to a Wide Range of Corporate 
Hosts and On-Line Systems 

Procomm’s famous Terminal Emulations enable you to 

access a variety of on-line and corporate host systems quickly 

and easily. Connect to any mainframe-, mini- or PC-based 

source by using your own PC as a remote terminal. 

Procomm Plus’s advanced fax 

features give you a wealth of 

options for electronic faxing. 

Just click once, and you’ll see 

the exact status of any fax 

received or pending delivery. 

Fax Viewer cleans up those 

annoying “scan lines” on faxes you’ve received. You can use 

Fax Annotation for editing, adding graphics and including 

your comments directly on a fax to a colleague or a friend. 

OCR even converts faxes to character-based data, and slashes 

the time it takes to re-key information. 

Explore the Internet with Ease 

Procomm Plus even gives you full 32-bit access to the 

internet, including web browsing, Internet mail and a news 

reader. And, because 

Procomm Plus for Windows 

95 is the first 32-bit 

communi-cations program 

to integrate remote control, 

fax, data and Internet, you 

can run all four features 

at once! So go ahead and 

communicate any way you 

want. From anywhere. 

With Procomm Plus, the 

world is your office. 

More detaiisP 
| Enquiries to: Marketing Results 02 9899 5888, Tech Pacific 02 9381 6000, Conexus 02 9975 2799, 

| Available at: Harvey Norman, Dick Smith Electronics, City Software 03 9558 9500, VOX Xsite, 

j Harris Technology 02 9957 1142, Software Express 07 3832 2277,03 9663 6580,08 8223 4470,02 9233 8444 
Q 
g ©1996 Quarterdeck Australia. All rights reserved. PO Box 456, Sutherland, NSW 2232. Quarterdeck is a registered trademark and the 



Unleashed! 

A Few 
Words 
From 
the Boss 
Bill Gates, 
Microsoft's 
chairman and 
CEO, will begin 
an exclusive 
column for 
Communique 
next month 

MSN Revisited 
The Microsoft Network has been 

relaunched on the Internet - We tell 

you where to point your browser. 

On-line travel 
Now, thanks to Microsoft's 

incredible Expedia Web site you 

can book a flight, a hotel and hire 

a car for your next great escape. 

Next month we show you how. 

DON’T MISS a bonus hints 

and tips supplement to get your 

year off to a productive start. 

NEXT MONTH’S new look 

communique also features some 
great new sections including 
home entertainment, networking 
and Windows NT. 

MORE incredible special offers 
for all our members. 

Office 97 

We reveal the secrets of the 

world’s most powerful office 
suite. And give you 10 reasons 

you’ll want to upgrade. 



This letter wins 

a copy of 

Microsoft 

Ah, Win 95! 
Dear Communique, 

Today I received the latest issue of 

Communique, only to find yet another complaint 

about the Windows 95 operating system. Recently 

I purchased Windows 95 (registration sent off last 

week), with great skepticism, due to word of 

mouth and printed matter, about system crashes 

and various parts of the system not performing 

the way they should. 

Well, I do not know what’s going on in these 

peoples’ computers (perhaps gremlins from an 

outside source?), but I can proudly say well done 

Microsoft!!!!! 

I can find no fault with it. In fact, I have had 

more problems with Windows 3.1 than I care to 

discuss. 

I am also pleased that Windows 95 handles non- 

95 programs such as Works for Windows 3.1 and 

Printmaster Gold on my computer without error, 

whereas it always crashed under 3.1. I also had a 

lot of trouble using the DOS Prompt from inside 

3.1 but not anymore. 

A month prior to purchasing Windows 95 I went 

into the control panel of 3.1 and checked the Use 

32 Bit Access box which sped things up a lot, 

maybe that has something to do with the way 

Windows 95 operates so well. Anyway, thanks for a 

great product and keep on going on. 

J.R. Kaup, 

Wangaratta, Vic. 

Stranded 
Dear Communique, 

I was deeply engrossed in my latest 

Communique magazine when I read that the 

Microsoft Internet/Intranet Show would soon 

“hit a town near you” in November. 

When 1 read on though I had to throw that 

magazine across the room in absolute disgust! 

Our “nearest town” is apparently considered 

by Microsoft to be Brisbane - 1717 kilometres 

away!! 

Come on guys! You don’t expect people 

from Sydney to travel to Adelaide (only 1426 

kilometres away) to see the show, do you? I 

wouldn’t have minded going to Townsville 

(346 km) to see it, but it is not even coming 

that far. 

We might as well be bn Mars with the 

attitude city folk have to us. Or were ) ou 

perhaps worried that the people who travelled 

with the Sydney Show may not return to the 

city once they saw the best part of Australia? 

Also I noticed the show doesn’t even get 

into the Northern Territory or Tasmania. Has 

there been an earthquake we don’t know 

about? 

If you can find us to sell us Microsoft and 

magazines, how come we get ignored when 

we want to know something. I might have to 

reconsider before I buy any more Microsoft 

products. 

(Oh, by the way, I typed this with my, um, 

new Microsoft Natural Keyboard which I, um, 

just bought this morning. It’s hard to be mad 

with you guys when you make all the best 

gear.) 

Debra Raisin, 

North Cairns, Qld. 

Microsoft Replies: 

We do try to take our shows and events to as 

many places as possible. Limited resources 

don't allow us to always go to as many 

centres as we'd like. If you are unable to 

attend our shows don't forget you can see 

similar content on our MSTV videos. See 

page 7 for the latest titles. 

Communiquation? 
Dear Communique, 

I wish to inform you that I will not be 

renewing my current subscription to 

Communique magazine which expires on 31st 

Dec/Jan 1996/97 
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Communiquation 

Dear Communique, 

I received my copy of your magazine today and I just 

thought that I had to write and tell you how great I 

think it is. The varied articles, great graphics, Your Say 

section and all those fun competitions you keep running 

combine to make Communique a great read every 

month, without fail. 

I am particularly impressed by the way you publish 

articles which aren’t necessarily barracking for Microsoft, 

and the wealth of information you provide. 

Overall, I think Communique is just great and I truly 

look forward to the next edition. 

Oh, and one last question before I go. What on earth 

does http stand for? May the mouse be with you. 

Harmony Kemp, 

Cardiff, NSW. 

Editor replies: HTTP stands for HyperText Transport Protocol. It's 

the protocol used for passing hypertext documents over the Web. 

October. I find the magazine increasingly 

difficult to read and hence it does not 

meet the aim implied in its title. 

According to the Macquarie dictionary, 

communique’ means “an official bulletin 

or communication... to the press or 

general public”. Communicate, according 

to the Macquarie dictionary means “to 

impart knowledge”. 

The readability of the magazine and 

hence its ability to impart knowledge is 

reduced to the use of the following 

practices. 

1. Using very narrow columns and 

different column sizes. 

2. The practice of placing text in 

apparently randomly sited boxes on a 

page. 

3. Printing over Coloured backgrounds 

and pictures, and using “wall paper” type 

backgrounds for text. Wrapping text 

around pictures. 

4. What Communique does 

communicate very well, however, is that 

the designer of the magazine has a very 

nice DTP package, and that he/she likes 

showing it off. 

Ivan Hiiser, 

Mount Gambier, SA. 

Saving a strange 
little world 
Dear Communique, 

I’d like to note the 

importance of such 

competitions as 

Communiques Science 

Fiction competition for 

writers of fantasy fiction in 

this country. There are 

few, if any, avenues for 

this genre in Australia. In 

fact, last year’s winning 

entry was the first of my 

stories ever published, 

after years of trying and 

almost giving up. 

I guess I owe this 

competition a debt of 

gratitude. “Doors and 

Windows” (.last year’s 

entry and winner - Ed) 

was written after not having written 

anything in over three years, and 

basically resigning myself tp the fact that 

to publish fantasy fiction you have to go 

overseas. 

To win last year was not only a great 

thrill, but also resurrected a belief that 

there is a market for the genre in this 

country. Since winning your competition, 

I have almost completed a book of short 

stories and recommenced a long- 

unfinished novel. Your encouragement 

and belief in my work is the sole 

inspiration for this, and I thank you. I 

hope you enjoy the enclosed stories, 

again specifically written for the 

competition. 

Happy reading, and welcome once 

again to what my family and friends call 

“My strange little world”! 

Rick Stone, 

Bundamba, Qld. 

Merchandising support 
Dear Communique, 

I must say I enjoyed reading Rick Teh’s 

letter in your October edition. I like my 

current mouse mat just fine, so I’m not 

concerned if I don’t get a free Microsoft 

mouse mat when 

register your 

products. Rick 

makes a good 

point, though. I 

would much 

rather receive a 

“cool Microsoft 

T-shirt” or a 

“Snazzy Microsoft Mug” than a mouse 

Back in the early days surrounding the 

release of Windows 3.1,1 was lucky 

enough to attend a “Windows day” 

which the Sydney PC Users Group put 

on for its members. At that day one of 

your staff was giving an overview of the 

product and was asking questions about 

the product to test members’ knowledge. 

When an answer was correct, people 

were awarded Microsoft Caps. 

Imagine how privileged I felt when, on 

answering a question on what “grabber 

files” were, I was awarded a Microsoft 

Windows Watch! That was 1992 and I 

still have It to this day. The original 

battery only just stopped working this 

month, which shows how reliable your 

products are! This is still the coolest 

accessory I have and it impresses 

everyone who notices it, 

Warren Thrush 

warren_thrush@msn.coM 

We welcome letters from 
Communique members on all 
subjects regarding Microsoft 
and Communique. 

The most interesting letter each month will 
win a Microsoft product. 
Send your letters to: 
Your Say, Microsoft Communique. 
115 Alexander St 
Crows Nest 2065 
Email: cmq_ed@msn.com 

Communique regrets we are unable to enter into 
Individual correspondence In every case; we resen/e 
the right to edit letters for reasons of space; and the 
views expressed in these pages do not necessarily 
represent those of Communique magazine or Microsoft 
in Australia. 
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Now you can access the resources you need 

no matter where you are. With CoSession 

Remote you can connect to distant PCs and 

networks and work just as if you were there. 

Run programs, check e-mail, transfer files, access 

data, print reports. You can even use CoSession 

Remote over the Internet to avoid long distance 

phone charges. 

And with industry-leading features 

like high-speed intelligent File Transfer and 

Windows 95 support - it's no wonder that 

CoSession Remote is the most widely used 

remote control product around. What's more, 

it comes from a company that's been a leader 

in network solutions for over 12 years. 

All this for an industry low $99. 

So if you want reliable, affordable, 

intelligent remote access and control, get 

CoSession Remote. And Get INSYNC. 

Access Your PC froi Anywhere ai Anytime. 

Over 4.5 Million Installed! 
Call 1-800-808-432 

for your nearest reseller 
www.artisoft.com. 

Making the World Your Office 



Summertime 
products - game demos, desktop themes 

and the monthly content updates 

While you’re waiting for the downloads 

to finish make sure you check out the 

other extensive resources to be found. 

There are customer guides, the Internet 

Centre, MSN and the latest product info all 

just a hyperlink away. 

THE NASA HOMEPAGE 
http://www.gsfc.nasa.gov/nasa_homepage.html 

Maybe it’s just me but I find all things to 

do with rockets and space pretty 

fascinating, after computers and networks 

of course. If you share my fascination, or if 

you just want to view the sort of images 

that can only be taken froth space, then 

launch yourself into the NASA. (National 

Aeronautics and Space Administration) 

Homepage. 

Free Windows software, a trip to the moon and the 

wonderful world of cockroaches. Communique’s Robert 

Kirwan takes you on a tour of Web-thangs to do over 

Christmas. 

MICROSOFT 
http://www.microsoft.com/ 

For all you folks running Windows 95 a 

regular stop-off point has to be the 

Microsoft Free Downloads page 

http://www.microsoft.com/msdownload/ The 

content is continuously changing, with 

things both for work and play to be found. 

Have you got the latest release of Internet 

Explorer? How about some add-ins or 

maybe the latest Microsoft Mail, News, 

NetMeeting and NetShow products? And 

you must have the latest entertainment 

Oec/Jan 1996/97 



Aussie soap on offer today, with loads of 

multimedia content, live chat sessions and 

biographies of the stars, then Friday’s 

Beach is the one. 

(http://www.microsoft.( 

Stupid Things 
diskloads of material here, but 

let me run through a couple of 
FOR KIDS AGED 5 TO 13 YEARS 

i page is maintained by Lisa tl3).Tfm- >t.- I, ajid Brooke O). COCKROACH WORLD 
Teni-Aim would like you to send in your short stories and poems so she can 
publish them in our kids page 

Brooke is looking for people to send her some of their favourite drawings they 

my favourites. The gallery is a 

must - it includes image, video , 

and audio archives of all things _____ 

space-related, they even have a 

live CU-SeeMe link. Also worth a look is 

the ‘Mission to Planet Earth’, especially for 

those with an environmental interest, and 

the RealAudio tour found under 

‘Technology Development’ (you’ll need the 

RealAudio 2.0 player for this - 

http://www.realaudio.eom/products/player2.0.htm 

That’s enough for starters. You’d best get 

on with it, you’re sure to spend a couple 

of earth orbits exploring this site. 

CNET: The Computer Network 
http://www.cnet.com/ 

Here’s the consummate site for all that is 

Internet and computers, with product 

reviews, feature articles, personality 

profiles and interviews, a great game 

centre, and software resources. CNET has 

got the lot. CNET also provides up-to-the- 

minute news items through NEWS.COM 

http://www.news.com/ which can be 

searched by subject department. Also make 

sure you catch the daily CNET Radio 

broadcasts using RealAudio streaming. 

Leisure 

FRIDAY’S BEACH ON MSN 
AUSTRALIA 
http://www.msn.com.au/fridaysbeach/ 

If it’s Friday, it’s time for the beach. Drop 

in on the gang at Cockatoo Bay to find out 

the latest with Mia, Julian, Mike, Eliza and 

Jeremy. Missed the story so far? No 

problem. It’s your average everyday 

beachside community. Mike’s on drugs - 

well steroids really. Mia’s a fashion model 

- well no, she isn’t but she spent $600 on 

a portfolio anyway. Jeremy’s poking his 

nose in everywhere and gets done over by 

a steroid thug for his trouble. Eliza is in 

love with Julian who is in love with Mia 

who (I think) is in love with Mike. Once 

we know how Mike feels the whole thing 

should be cleared up. Most of all keep an 

eye out for my favourite resident, Clutch. 

So if you have a hankering for the best 

http://www.nj.com/yucky/roaches/ 

Excuse me, waiter, there is a life-and-death 

struggle occurring in my soup. Depending 

on your latitude in this fine land of ours, 

you will either have your own stories to 

tell about these varmints or you won’t 

know what all the fuss is about. If you 

think you like Christmas just ask a roach 

for its opinion some time. All that leftover 

left-out turkey just waiting to be devoured 

by our six-legged friends. 

Every detail of roach existence is 

covered in Cockroach World. We have the 

‘Inside Story’ (and I do mean insides), we 

have the ‘Day in the Life’ of Rodney 

Roach, we have the ‘How to Get Me’ guide 

and we have the ‘Around the World’ with a 

cockroach game. By far my favourite, 

however, is the multimedia library. Just 

download and listen to the Madagascar 

Hissing Cockroach or take a peep at the 

Smelly Roach Quicktime movie. 

LOONEY TUNES 
http://www.usyd.edu.au/~swishart/looney.html 

I hate to admit it, but when I was growing 

up there weren’t any PCs and there 

definitely wasn’t any Internet. So what do 

CQAMUN1QUEB . 
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you do in a world starved of true 

recreational resources? What else but 

watch the Bugs Bunny Show? Now all the 

old favourites are back and looking better 

than ever, thanks to some anonymous soul 

at the University of Sydney. This site serves 

up a wide range of images, movies and 

sound files for everyone from Bugs to 

M.J.Frog. My favourite is Marvin the 

Martian and his faithful dog K-9. 

Education 

DISCOVERY CHANNEL ONLINE 
http://www.discovery.com/ 

This is the online Site from the premier 

documentary and “everything educational” 

cable TV channel. 

Much of the content is broken down 

into seven themes, one for each day of the 

week. You have History 

(Monday), Nature 

(Tuesday), Science 

(Wednesday), People 

(Thursday), Exploration 

(Friday), Technology 

(Saturday) and Your 

Story (Sunday). Besides 

the rich content of new 

weekly stories, each 

theme also hosts an 

area for posting 

messages on specialised 

subjects. 

The site also hosts 

special events and 

RealAudio interactive 

discussions on a number of subjects, all of 

which can be accessed through the site’s 

audio archives. This would have to be one 

of the best sites on the Web for ease of 

navigation and vibrant multimedia content. 

It is a must-see, even if you think you 

know everything there is to know. 

WANT MORE? 
Well, maybe the Geek Site of the Day at 

http://www.owlnet.rice.edu/~indigo/gsotd/ 

and the Teaching and Learning on the Web 

search engine at 

http://www.mcli.dist.maricopa.edu/tl/ will 

keep you satisfied. For the younger ones 

in the audience, give the Worlds Kids 

Network a spin at http://www.worldkids.net/ 

Make It Work 
Here are a few really useless sites to keep 

you occupied all summer long. 

THE INTERACTIVE MODEL 
RAILROAD 
http://rr-vs.informatik.uni-ulm.de/RR/gui2/ 

We always wanted that model railroad for 

Christmas. You know, the one with the 

bright red loco. 

Maybe next year. 

Next year nothing! 

That model train is 

set up and waiting 

for you to flick the 

switch right now. 

It couldn’t be simpler. Pick your train, 

red or black. Pick your destination: 1, 2 or 

3. Hit the switch. Best of all, your dumb 

dog can’t get at it and chew up all the 

carriages. 

THE MT FUJI SERVER 
http://www.flab.mag.keio.ac.jp/fuji/ 

Hot summer days, long cold drinks and 

melting ice cream. There is nothing like a 

good Aussie summer. Way up north, past 

the equator, it’s a different story. It’s so 

cold they’re probably getting snow. Just to 

make sure, you can check in with the Mt 

Fuji server to see the cover on this most 

sacred of Japanese mountains. This is no 

static, ‘updated once a day’ image; You 

pick the zoom and where you want the 

camera pointing. Before you can say Fuji 

Film you’ve got your image. 

THE TELEGARDEN 
http://www.usc.edu/dept/garden/ 

No need to feel guilty about spending all 

your time online while the garden withers, 

do your gardening from the convenience 

of your keyboard. The little Telegarden 

robot with its 

rotating arm 

can do it all. 

Make sure you 

register to get 

the extra 

privileges of 

planting seeds, 

watering, 

access to other 

members, plant 

maps (see 

where others 

have planted), water maps (see 

where others have watered) and a 

host of extra viewing options 

(zoom control, image size, colour 

depth, lighting, colour saturation 

and contrast). 

Want to put even more of the 

Net to work? Then check out the 

ultimate list of Internet Accessible 

Machines at http://www- 

cse.ucsd.edu/users/bsy/iam.html 
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ONE DRAWING SOLUTION 
FROM CEO TO R&D 

No matter what you want to draw, Yisio has 

a solution for every aspect of your business. 

Yisio 4.0 is the perfect solution for 

creating flow charts, organisation charts, 

maps, timelines, TQM or BPR diagrams - 

you name it. 

Visio 4.0: creating business diagrams, plans and 
schematics is so easy, you’ll want to do it every day. 

While Visio Technical 4.1 has been 

designed especially to make life easier for 

anyone who has to create or work with 

technical drawings and schematics: 

it’s incredibly easy to learn and use, and 

it’ll even let you work with existing CAD 

files and share your drawings with 

your colleagues. 

Both Yisio 4.0 and Visio Technical 4.1 

are based on Visio’s unique SmartShape 

technology and are designed to run with 

Windows, so you can place and edit drawings 

within your other desktop applications. 

Visio Technical 4.1: the most efficient way to create 
and share technical schematics. 

For a free test drive CD of Visio 4.0 or 

Visio Technical 4.1. call Visio International 

Freecall Technical Support 1800 501 642 

Freefax 1800 559 366. PO Box 895, Bondi 

Junction, NSW 2022. 

Microsoft" Designed for 

Compatible Windows'95 

Visualize your business 

© 1996 Visio Corporation. Visio and SmartShapes are registered trademarks of Visio Corporation. 
All other trademarks referenced herein are held by their respective companies. All rights reserved. 



PowerCleaner 
Keeping your PC in top condition is like 

gardening - Weed out old files that choke up 

valuable memory, disk and systems resources 

that slow your Windows 95 PC. 

PowerCleaner, developed in Germany is now 

available in Australia. Independent US tests* 

show that PowerCleaner safely removed more 

than twice the number of unwanted files than its 

nearest competitor - and it is safe - no risk 

of accidentally deleting files that are still needed! 

Moreunwa 

ZipFolders 

Weo„s^,^0„^*U,Dr.R(eRnder) 
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zlPP'ng or unzipping j 

Power Utilities/ 
Crash Proof 
Unleashes your PC's Performance, here 

are just some of the hundreds of features: 

- Fine-tune Windows, cleans disk space, 

optimises Win 95 settings, tunes hardware 

for top speed and performance, makes 

one program faster than another, identifies 

bottlenecks & recommends upgrades. (Crash Proof for 

Windows 5 stops system lockups, automatically conducts 

over 400 scheduled hardware diagnostic tests. Identifies 

problems before they crash your system. 

It's simple - Use these Essential 

Utilities to keep getting the 

most out of your PC investment. 

Suppliers Mil : ‘National Software Testing Laboratory. 
‘^System Requirements: PowerCleaner:Windows 95 with CD ROM, 
ZipFolders & Power Utilities: Windows 95/3.lx, 3.5" Floppy. 



Multimedia Magic 
Buying a PC can be confusing at times, but here at 

Communique we've made it that much easier 

Intel Pentium 
133Mhz CPU 

Price 
$2,245 

\ ffl 

The Moebius 133 Multimedia Personal 
Computer from TODAYTECH 

Computers, gives you the speed, power 

and space to get the most for your 

computing needs. 

TODAYTECH has put together a 
special package available only to 

Communique members for an exclusive 

price of just $2,245 including a bonus 

internal fax/modem. 

Technical Info 
This computer has a powerful 133Mhz 

Pentium processor, in a choice of mini 

tower or desktop case, with 16Mb of 

RAM providing plenty of multimedia 

grunt. There are 1.2 gigabytes of hard 

disk space, a 1Mb S3 video card, a 16-bit 

sound card and a 15” SVGA monitor 
(which supports 1024 x 786). To top it 
all off, it has an 8-speed CD-ROM drive 

and comes with five great, Microsoft 
titles, Windows 95 and Plus pack, 

mouse, mat, and 120 watt multimedia 
speakers. 

Offer valid until January 31,1997. 

For more information, 

call TODAYTECH on 1300 360 022 

PLUS receive FREE 
Netcomm 33.6Kb/Sec Fax 
Modem with 30 hours 
quality Internet access with 
Telstra On Australia. 

COMAUNIQUE M 
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Save 30% on 
Net Nanny With the introduction of 

Net Nanny Version 3, 

a realistic solution has been 

developed to allow parents 

to have control over their 

children’s use of the Internet. 

Net Nanny lets parents and teachers 

screen PC Internet activity, and the beauty 

of this package is that it’s designed for 

parents who know less about their 

computers than their children do! 

Features include the ability to block any 

content, incoming or outgoing, that a 

parent or educator determines is 

inappropriate, through the use of a simple 

directory. Net Nanny can also block 

pornographic pictures or specific Web 

sites. It can screen bulletin board services 

(BBSs) which aren’t part of the Internet 

and can prevent home addresses, phone 

numbers, credit card numbers and other 

private information from being given out. 

With the new version of Net Nanny, 

there’s an ‘allow list’ of approved sites for 

children. Parents can preview sites, and if 

they deem them appropriate viewing for 

their children, they can add these sites to 

the allow list, and only these sites can be 

viewed by the children, 

Fully integrated with DOS, Windows 31 

and Windows 95, Net Nanny can also be 

The estimating professional 

the construction 

need software 

address their 

5 for Excel is 

software 

is versatile 

md specifically 

with the building 

n mind. 

is very fast, 

; Windows 95 

NT platforms, 

be used to 

price 

while items and 

an be moved 

templates 

in your job file, 

have your 

1' 

can be stored in 

and protected 

with security passwords. You 

can analyse estimates into 

sub-components and also 

create libraries for single 

items or whole sections. 

Trade jobs can even be 

converted into elements 

and vice versa. 

Other features 

include print previews 

of your reports, the 

ability to produce 

professional BOQ and 

estimate reports, and 

the capacity to 

control report 

layouts with word¬ 

processing 

functions. 

Normally 

retailing for $650, 

Communique 

members can take advantage Offer valid until February 28, 

of a 20% discount, paying 1997. 

only $520 plus postage and For more information please 

handling. That’s a saving of call 1-800 808 911 

$130. or fax (07) 3870 7078. 
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CYPRESS COLE 
ANALYSER - MARK II 

ll (02) 9957 6970 or 

1-800 504 025 if outside Sydney. You can also fax 

on (02) 9956 8742, or e-mail. 
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1 All Courses 
| Analysis 
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Save / Exit 
Cypress Golf 

"Quality Software at an affordable price" 
Copyright 1995 

Improve Your Golf Game! Are you stumped when it comes to buying a Christmas present for Dad? 

Well, here at Communique we think we’ve found a solution. Pure Golf 

Direct has two great products Dad is bound to fall in love with, and they’re 

both Windows 3-11 and Windows 95 compatible. 

Cypress Golf Analyser Mk II This is a game analyser which has such 

illustrious celebrity users as Craig Parry, Robert Allenby and Stuart Appleby. 

It identifies J 

can display afl 

trends can t) 

printed o 

time and old courses or scores can be deleted. Types of analyses available 

include Hole Analysis, Course Analysis, Putts and Fairway accuracy. 

Cypress Golf Skills Test This is the ideal way to make the most of your 

practice time. It helps to accurately measure your skill level in all areas of the 

game and identifies exactly 

where you need to spend your 

practice time. There’s a 

weighted skills index which 

helps you adjust for the 

important parts of your game 

such as putting and driving. 

Graphs are also available, 

whether on screen or in detailed 

reports, giving you a clear 

picture of your improvement 

Both these products retail for 

$39.95, but a 20% discount is 

available to Communique 

members. They heed pay only 

$31-95. Alternatively, if members 

wish to buy both products, they 

will receive a 25% discount, 

paying only $59-95 for both 

titles. A postage and handling 

charge of $6 applies. 

Offer valid until April 30, 1997. 

For more information, call 

1-800 066311, fax (03) 9521 

2848 or e-mail 

puregolf@golf.com.au 

For more product information 

you can go to 

http://www.golf.com.au 

25% off PowerRite Max UPS 4501 

until December 31, 1996. (02) 9436 

1313 

25% off Janna Contact Personal 

plus free executive overnight bag until 

December 31,1996. (02) 9929 6644 

18% off Peak Interact 

International’s Australia Scenery 

Enhancement for the Microsoft Flight 

Simulator until January 31,1997. 

(060) 43 1991 

20% off a 12-month subscription to 

Visual Basic Programmer's Journal 

until December 20,1996. (02) 9438 

1175 

Selected discounts on Memory 

Banks’ Personal Tutor Maths series 

until January 31, 1997. (02) 9365 

6736 or (03) 9770 1615 

25% off Woody’s Office Power Pack 

until December 31,1996. (02) 9565 

1991 
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BackOffice power 
. :K? ■: S ^30®gh. 

BackOffice Server 2.5 is here and it’s the most powerful, 
secure and complete set of tools to help you set up and 
administer intranets and Web sites on the Internet. 
Here's a rundown of what BackOffice Server 2.5 contains. 

Windows NT Server I, 
feu I t ) 

an hour after )| 

Windows 

operating syst< 

com(*)icationsl 

integrate the Wei 

incred#§®j|peed 

significantly improy^^^ A 

Overall, the comprehensive 

functionality of Windows NT Servf 

you with'the I vst pricj 

any server operating 

Index Server 1. 
Microsoft Index Serve 

Server 4.0 

prver is 

|sl to 
I operating 

systda 
match* "The 

NT demanding" business 

■eels. You’ll be up 

ancigfUnning less than 

|ke it os*>f the box. 

is also the only server 

intranet, and 

, so you can 

.o your business. Its 

-level security will 

jproductivinH^ib 

id -robust 

affirovides 

■mancjp'alue of 

the market. 

idows NT 

2.0 to 

gfaedess to all °f 
intranet or 

Jfcyou a|igsrfarm full-text 

: all types'ol Information I 

i'eb browfcr, tn jufet about any format, 

p click dfa ffloy or button 

: is a free, downloadable component of Windows NT 

i 4.0. It includes sujgpoit for HTML, text, and all 

:e documents, in thenKigmal format. You don’t have 

rt all your documents to 1ITML just to find them. 

f providbsfusers with hit highlighting 

:r postiiljla query, userf can view the contents of each 

returnefpby the query|Lw]th the matching words 

• Windows NT Server 
4.0 

• Index Server 1.1 * 

• Frontpage 1.1* 

• Internet Information 
Server 2.0* 

• Exchange Server 
4.0 (Standard Edition) 

• Exchange Connector 

• SNA Server 3.0 

• SMS 1.2 

• Proxy Server 1.0 

• SQL Server 6.5 

• Internet Explorer 3.0 

• Updated BackOffice 
Client and Server 
Installer 

• Most recent Service 
Packs available for all 
components 

Part of Windows NT Server 4.0 

highlighted. Hit highlighting works on all 

supported document types. You can view text 

hits inside Word, Excel and even PowerPoint 

documents. 

Frontpage 1.1 
Microsoft FrontPage, included with Windows 

NT Server 4.0, is the fastest, easiest, and most 

powerful way to create and manage 

professional-quality Web sites. It’s the first Web¬ 

publishing and site management tool created for 

non-programmers. Yet it is also robust enough 

for experienced Web developers, making it easy 

for large teams to work together. 

Microsoft FrontPage includes everything you 

need to get an attractive and effective Internet 

or intranet site up and running right away. 

There are Wizards and templates to step you 

through the creation of your Web page and 

facilitate automatic generation of Web pages 

and even entire sites. The Front Page Editor 

automatically generates HTML code, so writing 

a Web page is as easy as writing e-mail, and 

FrontPage supports the latest HTML standards, 

enabling you to control every aspect of Web 

page design. 

internet Information Server 2.0 
' Windows NT Server is the 

only server operating system with an 

integrated Web server. You don’t have to 

worry about buying and installing separate 

software - Internet Information Server (IIS) is 

up and running with the system. 

Internet Information Server is the most 

comprehensive Web server platform available. It includes a 

complete set of tools for creating, managing, and finding 



information in any format, and 

directory services. 

Since it’s part of Windows NT Server, Internet Information Server 

is the fastest and most secure Web Server available. 

fully integrated with security and Administrators can then tap into that information to plan the roll¬ 

out of new applications and updates. You can use Systems 

Management Server to automatically install desktop applications 

from a central location. 

Exchange Server 4.0 
Microsoft Exchange Server is the e-mail server 

with integrated groupware that makes it easier 

to communicate. Exchange combines 

electronic mail, group scheduling, electronic 

forms, and groupware applications on a single 

platform that you can manage with a 

centralised administration program. It’s the 

most reliable way to send e-mail and access groupware applications 

over the Internet or any other network. 

Messages are delivered consistently, and they can be signed and 

sealed with digital signatures and encryption to ensure security. 

And the client/server architecture of Microsoft Exchange 

ensures that any volume of e-mail will be routed quickly. 

The Microsoft Exchange Internet Mail Connector provides I 

high-performance SMTP connectivity for fast Internet e-mail. I 

You can also establish a virtual private network using the I 

Internet as a WAN to connect Microsoft Exchange clients and I 

servers. 

Proxy Server 1.0 
The Proxy Server supports all Internet 

protocols, including WWW (HTTP), FTP, 

RealAudio (streaming audio), VDOLive 

Microsoft 
Exchar^e 
Server 

(streaming video), IRC (real-time chat), and 

mail and news protocols. Support for 

Novell’s IPX/SPX transport means that 

deployment of TCP/IP on a private network 

Microsoft _ 
Proxy Server 

SNA Server 3.0 
Microsoft SNA Server makes 

connectivity to IBM mainframes, 

AS400’s and compatibles easy and 

economical. It combines the familiar 

user interface of desktop PCs with the 

SNA 5cncr flexibility of modern LAN systems to 

offer PC users reliable and secure 

access to IBM host computing. 

SNA Server offers advanced tools for easy system setup 

and centralised graphical administration. It supports every | 

important PC and network operating system, LAN type, SNA 

host connection, and host type. You can connect clients and 

manage SNA Servers across LAN and WAN bridges, routers, and 

even over ISDN, X.25, Frame Relay and Dial-up lines. 

SMS 1.2 
Microsoft Systems Management Server is a 

comprehensive solution for centrally 

managing personal computers on a network 

of any size. It enables network administrators 

to detect every machine on the network, 

inventory software and hardware 

configurations, and send key information 

back to a central SQL Server database. 

is unnecessary. Internet sites can be accessed by Web browsers 

running on any operating system, and by all 16-bit and 32-bit 

Windows Sockets applications, with no modifications to the 

applications. 

Microsoft Proxy Server proactively caches frequently 

accessed documents to ensure the immediate availability of 

fresh data, automatically updating cached copies of popular 

Web pages based on usage. The Proxy Server builds upon the 

high performance and scalability of Windows NT Server for 

application services. 

Administrators can grant or deny outbound access by user, 

service, port or IP domain. Access to specific sites can be 

blocked. Microsoft Proxy Server leverages the C2-level 

security features built into Windows NT Server. 

SQL Server 6.5 
The comprehensive distributed management framework in 

SQL Server 6.5 lets you centrally manage all the database 

servers in your organisation. With advanced Windows-based 

management tools and powerful server-based job scheduling 

you have visual control over multiple servers and can 

automate remote operations for “lights out” command of your 

distributed environment. 

Designed with the Internet in mind, Microsoft SQL Server 

also provides high-performance access to information on your 

company’s Web page. Its new Web Assistant enables you to 

populate your Web server with SQL data through a variety of 

methods, allowing distribution of your company’s data on a private 

intranet or worldwide on the Web. 

Also new to SQL Server 6.5, the Distributed Transaction 

Coordinator makes distributed applications easier to create by 

automating the management of transactions across multiple servers, 

saving valuable time previously spent individually coding client 

applications. SQL Server 6.5 also meets the most demanding 

requirements for reliability, data integrity, and security by 

complying with industry standards such as ANSI, FIPS, and NIST. E 
BackOffice Server 2.5 is available now with an ERP of $2009- 
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meet the 
DREAM 
MAKERS 

DreamWorks Interactive, combines technology with the zing of Hollywood 
greats Stephen Spielberg', Jeffrey Katzenberg and David Geffen. Nicole 
Manktelow asked Dan Kaufman, DreamWorks Interactive's chief 
operations officer, about the future of multimedia entertainment. 

Communique: Since DreamWorks Interactive is a joint venture between Microsoft and 

DreamWorks SKG, how does the company see itself? More software or studio oriented? 

Kaufman: We are striving to create a new model that borrows the best from both worlds. 

Microsoft understands the software development process better than any company I have 

ever seen. As the interactive market becomes increasingly competitive, companies will fail 

unless they can consistently produce high quality software both on time and on budget. 

We are working closely with Microsoft to improve in these areas. DreamWorks is 

comprised of a team of people that has the unique capabilities of attracting highly creative 

people and then being able to harmonise those 

individual talents into a cohesive unit, capable of actually 

delivering high quality products. Clearly, the interactive 

customer’s product expectations are continuing to rise, 

and in order for us to compete we are working closely 

with DreamWorks SKG to learn how to more effectively 

attract, retain and manage top talent. 

Communique: The staff of DreamWorks Interactive have 

come from both founding companies. How has the 

transition been? 

Kaufman: Exciting. People from both companies have a 

tremendous amount of experience from their respective 

fields, but they understand that we are in a new industry. 

The challenge for all of us is to determine what past 

skills can be applied or modified to make our business a 

success. Thus, every day becomes a learning experience, 

but that is one of the reasons I look forward to coming 

to work every day. 

Communique: Was there an initial concept or suggestion 

that sparked the creation of DreamWorks Interactive? 

Whose idea was it to combine talents? 

Kaufman: My understanding is that the idea came -— 
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If ile from both companies have a tremendous amount of experience 
their respective fields, but they understand that we are in a new 

industry. The challenge for all of us is to determine what past skills can 
be applied or modified to make our business a success. 1 
simultaneously but independently to both our parent 

companies. Microsoft had already demonstrated its ability to 

succeed in this market, but was looking for ways to expand. 

In particular, they noticed customers were demanding and 

getting more traditional Hollywood entertainment values in 

their interactive entertainment products. Partnering with 

DreamWorks SKG put them immediately into the company of 

three people who understand how to deliver traditional 

entertainment values as well as anyone in the world. 

DreamWorks SKG was interested in the 

interactive arena, and believes it to be a 

burgeoning entertainment industry. 

However, they saw a number of studios 

attempt to enter the market alone with 

poor results. A partnership with 

Microsoft made imminent sense. 

Communique: How hands-on are 

Steven Spielberg, Jeffrey Katzenberg 

and David Geffen in the operation of 

the new company? 

Kaufman: Both Steven and Jeffrey 

are very involved, and David makes 

himself available for help on an as needed 

basis. Steven is a true gamer, and constantly has strong ideas 

for new products or ways to improve products we are 

working on. Two of our first five products are based on his 

ideas. Jeffrey has been instrumental in working with us to 

develop quality characters for our products, as well as how 

to market the products when they are finished. In addition, 

Jeffrey understands how businesses need to operate, how to 

get the right people into the company and, once there, how 

to keep them motivated. It should be noted, however, that 

there is an entire team of amazingly talented people at SKG 

who we rely on as well. 

Communique: There’s a stream of titles due out from 

DreamWorks already. Is it a ferocious workload? 

Kaufman: Yes. We are working very hard, but we hire 

additional people when the load begins to appear 

oppressive. As a company philosophy, we believe that a 

smaller group of really great people will out-perform a larger 

group of mediocre people. 

Communique: A press release said some titles would be 

original and others might be drawn from TV and movie 

projects, are there any of these in the wings? 

Kaufman: Yes. This year we are releasing Goosebumps: 

Escape from Horrorland which is based on the 

enormously successful Scholastic book 

franchise. Goosebumps is already a 

hit on television and there are 

plans for a major motion picture 

release next year. We are also 

developing games based on Jurassic 

Park. The Lost World, for next year. 

Communique: Is there a distinctive 

style or hallmark from the 

DreamWorks titles? 

Kaufman: We hope so. When we 

develop products we start with the 

premise that it must be truely interactive 

and a lot of fun. Once that is assured, 

we focus on delivering a level of production value, character 

and story the consumers have not had before. 

Communique: Are the Goosebumps titles expected to be as 

successful as the Magic School Bus series? 

Kaufman: We certainly hope so. Scholastic is a wonderful 

partner and Goosebumps is a great franchise. Microsoft and 

Scholastic have been tremendously successful with Magic 

School Bus because they have released great products which 

are true to a great property. We are trying to follow the same 

model. 

COMMUNIQUE M 
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Exchange 
Server 
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Say hello to Microsoft 

Exchange Server 4.0. The 

only scaleable mission critical 

e-mail server with built in groupware. 

It’s the most reliable way to share ideas 

in your business. Exchange Server 4.0 

is also an integral part of the 

Microsoft BackOffice" suite of server 

products, so it’s perfectly suited to 

Windows NT‘ Server. The 

program allows you to manage 

hundreds of Exchange servers 

from a single desktop. 

Powerful intranet and SMTP 

Internet connectivity means 

you get all the access and 

control you need while the 

unmatched scaleability 

expand your site quickly and 

easuy. So, whether you’re looking for a 

rock solid e-mail platform running the 

latest host based e-mail products, 

centralised manageability, dependable 

Internet access or simply the flexibility 

to grow at your own pace, you’ll find it 

with Microsoft Exchange Server 4.0. 

Sharing ideas has never 

been so easy#;-; 

FREE OFFER 
BUY WINDOWS NT SERVER 4.0 AND THE NEW 

EXCHANGE SERVER 4.0 BEFORE 31/12/96 

AND RECEIVE A FREE EXCHANGE PLUS PACK 

CONTAINING EXCHANGE INTERNET MAIL 

CONNECTOR, 5 EXCHANGE SERVER CLIENT 

ACCESS LICENSES AND LOTS MORE 

(VALUE OVER $2,500, OFFER REQUIRES 

PROOF OF PURCHASE). FOR DETAILS SEE 

cellular line 

www.microsoft.com/exchange/ 

Microsoft 
where do yOU want to 

go today? 



Goosebumps: 
Escape from 
HorrorLand 

Many parents will be 

familiar with RL Stine’s 

Goosebumps series. They’re 

the spooky, gruesome, 

horror stories for kids 

(which are probably lying 

around on bedroom floors 

and in school bags across 

the country). 

With Goosebumps: 

Escape from HorrorLand, 

kids are trapped with Lizzy, 

Luke and Clay in an ultra 

scary amusement park. 

Before finding a way to 

escape, there are monsters 

to out-run and out-smart, 

clues to find and puzzles to 

solve. 

It’s an easy-to-use point 

and click adventure game 

that combines seven photo¬ 

realistic environments, it 

was created from computer 

HorrorLand (for which there 

have been many requests 

graphics, miniature sets and for a sequel). 

live action video. The 

characters and story 

Talent has also been 

poured into the audio for 

of Escape from the product. Real life stars 

HorrorLand 

have been 

developed from 

the book One 

Day at 

have also been involved in 

the goosebumpy creation, 

including Jeff Goldblum and 

Isabella Rossellini. 

Goosebumps: Escape 

Communique: What is Goosebumps’ most appealing feature? 

Kaufman: In addition to it being Goosebumps, we think the 

graphic look is unique among products currently available. 

The story is fun, but really scary; which is what we think the 

readers want. 

Communique: Is there a Hollywood flavour in the upcoming 

DreamWorks titles? 

Kaufman: Yes. In Goosebumps we have Jeff Goldblum, 

Isabella Rossellini, Judy Tenuta, Robert Lovejoy to name a 

few. For other products we have hired the writers and voice 

talents from Animaniacs, The Larry Sanders Show and Dark 

Skies. 

Communique: How adventurous are the titles coming out? 

Are they going to try new concepts in multimedia 

development? 

Kaufman: For each title we develop, we attempt to push the 

envelope in at least one direction. Goosebumps, for 

example, does some video compositing and camera moves 

we think are truly breakthrough accomplishments. We are 

currendy working on some real time 3D technology that we 

think will be pretty striking when completed. 

Communique: Microsoft titles have a reputation for being 

educational and wholesome. Will we see any DreamWorks 

Interactive tides that offer the blood and guts of Hollywood? 

Kaufman: I think you will see blood and guts where 

appropriate. We are certainly not in to gratuitous violence, 

but where appropriate we will not shy away. O 

If you’re keen to check out one of the first games from the 

DreamWorks Interactive projects, it’s The Neverhood, and it 

can be found on the Web at http://www.neverhood.com/ 

Just the facts... oh, and some other stuff 
DreamWorks SKG was created in October 1994 by Steven 

Speilberg, Jeffrey Katzenberg and David Geffen as a 

multifaceted entertainment studio. Its aim was relatively 

straightforward: to create motion pictures, animated features 

and TV programs (for network, syndications and cable). Also 

included in the grand plan was a record company and an 

interactive entertainment venture. 

The next month DreamWorks SKG announced its first 

joint venture, in the form of a television studio with Capital 

Cities/ABC Inc. to produce a broad range of programming. 

COMMUNIQUE ■ 
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from HorrorLand is targeted 

at those aged 8 years and 

onwards. It’s available now 

with an estimated retail 

price of $59. 

sculptures of course. (In 

fact, creators used three 

tonnes of clay to create the 

40 hours of gameplay for 

this CD-ROM.) 

All good stories need a 

baddie, and in this game 

it’s the evil Klogg who plans 

to overthrow Hoborg. The 

player becomes the hero, 

which in this story is a 

character called Klaymen, 

who, besides searching for 

the meaning of life and 

spoiling the evil Klogg’s 

plans, has to cope with a 

robot which players have to 

contend with, but don't 

worry if you lose your head. 

A fun, if not surprising 

aspect of the game is that 

death is not an option. 

Particularly since clay 

animated figures are 

extraordinarily resilient. 

Lose a limb? 

Just grow 

another one. 

The 
Neverhood 

And now for something 

completely different! The 

Neverhood, another 

DreamWorks Interactive 

title, is an original animated 

clay adventure from creator 

DougTenNapel (renowned 

for previous ‘claymation’ 

work, Earthworm Jim). The 

result is a game that is^^ 

full of slapstick 

comedy and can be \ 

played by users of any « 

Central to the | 

Neverhood is Hoborg, I 

the lonely ruler of a 

magical realm. He 

creates the domain that 

is The Neverhood and its 

creatures, all clay 

In March 1995 DreamWorks SKG completed a 10-year 

exclusive film licensing agreement with Home Box Office. 

In March 1996 DreamWorks Interactive was announced. 

The deal is done when Microsoft’s CEO Bill Gates and 

DreamWorks SKG announce they have signed a joint-venture 

agreement. The aim is to form a new software company 

designed to produce new interactive multimedia 

entertainment titles. 

At the podium were the DreamWorks threesome and 

Microsoft’s CEO, Bill Gates. 

“For me, the merging of storytelling and technology offers 

an incredible opportunity to reach new generations in ways 

that could not have been imagined a mere decade ago,” said 

Speilberg. The Legendary producer continued: “I’m very 

enthusiastic about working with Bill Gates and his creative 

team to dream up new forms of entertainment.” 

Not to be out complimented, Gates also highlighted the 

creative opportunity of the alliance. “The potential for 

combining the incredible stories created by Jeffrey, Steven 

and David - who I believe are three of the most talented, 

creative people working in the entertainment industry - with 

the innovative technology and amazing interactivity that is 

possible today and in the future, is just awesome to me,” he 

said. “Our partnership with DreamWorks will pave the way 

for extraordinary new consumer products.” 

Both companies agreed to split the funding of the new 

venture 50/50. The headquarters of DreamWorks Interactive 

would be in Los Angeles while the sister development and 

production facility would be based in Redmond. 

Since the announcement, DreamWorks Interactive has 

focussed on adventure, interactive stories and multimedia 

products for the family marketplace. However, in true 

Hollywood style, the company will also be looking to 

harness consumer properties and film and television concepts 

as well as its own original ideas. 

DreamWorks interactive will ship its first titles just in time 

for the 1996 holiday season. All products will be distributed 

by Microsoft. 

Independent of DreamWorks Interactive, Microsoft will 

continue to develop its own multimedia information and 

entertainment titles, such as Microsoft Encarta, the Magic 

School Bus series and Microsoft’s games titles. £ 

COAMJN1QUEB 

Dec/Jan 1996/97 



Office®/' 

An enthusiastic Darren Edwards 
takes a spin through this major 
upgrade of the world’s most 
popular suite of applications 

usabiU 

The arrival of Office 97 and its 

accompanying applications 

Word, Excel, PowerPoint, 

Access, and newcomer, Ougpok - is 

the result of some! fairly serious 

development by the Microsoft'team. 

The result is a powerful group of 

applications which brings 

enhancements, and di.1111 a .ilh 

increased usability to all levels of 

users - whether you're hsing Office 

to run your family business, or a 

large corporation. 

New features have been added, old ia|M 

improved, and the core technology behinaeach application 

has been integrated so that individual applications work 

together better than ever before. This means that moving 

between applications is far easier as shared toolbars and 

features are common between the entire suite of Office 97 I 

applications. 

It seems that the 25,000 hours of research which 

contributed to the design of Office 97 have paid off. 1 

installed a pre-release beta (being a brave soul, and with anl 

article to write well before the product officially gets 

released) and had no problems in terms of the 

stability and robustness of the new applications. 
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And now, Word 97 
Word has been with us, it seems, almost as long as the 

personal computer. The 35 million users of Word worldwide 

prove that way back in the distant past, the application’s 

developers got it right. Since then they’ve been making it 

better and Microsoft Word 97 proves no exception. 

If you’re an aficionado you’ll be pleased with the results 

of all those hours of research and development. Not only is 

it more intuitive - with tools such as on-the-fly spell and 

• grammar checking improvingg>ut of site - but its features 

have been refined to increase productivity. 

According to Microsoft in jBjjetralia’s Office 97 evangelist, 

Peter Cray, “Everything that’s been done during the 

development cycle of Word 97 has been designed to take 

animated character and there are a number of characters to 

choose from. The Office Assistant is designed to provide 

useful help while you’re working. As you go along, the 

Office Assistant shows ways you can learn to get the job 

done faster by interactively providing tips, guidance and 

suggestions. 

Grammar Help: Microsoft’s advanced linguistic group has 

developed a new natural language grammar check which 

reduces proofing time by flagging mistakes more accurately 

and providing better suggestions. Much like the Spell It 

feature in Word 95, Grammar Help automatically underlines 

incorrect grammar. You can have your grammar checked on 

the fly or wait until you’ve finished your document and then 

receive assistance. The spell checker in Word 97 has been 

integration 
ease of use to a new level. We’ve done this by automating 

many common tasks and providing users with powerful 

tools to create professional-looking documents quickly and 

easily. 

“In addition, Word 97 takes advantage of Web 

technology to allow users to collaborate and Wrare 

information anywhere from the desktop to the Web. 

However, underlying this development are enhancements 

which will be experienced by any level of user.” 

The developers of Word 97 have put a lot of effort into 

four majof areas of the product’s development. They are: 

Producing tools that make writing and creating 

documents easier 

Creating tools that help users collaborate and edit 

documents online, communicate using e-mail and 

create documents for the Web 

■ Creating tools that help users create professional¬ 

looking documents 

■ increased integration and consistency with the other 

applications in the Office 97 suite of applications. 

Here s an overview of some of the hot new features you’ll 

find in Word 97. 

improved too! 

Letter Wizard: Is designed to save you time and effort 

by simplifying the task of creating letters. It automates 

common letter elements so you can spend more time on the 

content, rather than the structure of the letter. The Auto side 

of things too has improved, with AutoCorrect and 

AutoFormat being enhanced and AutoSummarize, which 

automatically generates a summary of your document, and 

AutoComplete, which suggests how to complete words as 

you type, being introduced. 

Style: You can now see the exact font, size, formatting 

and justification for each style, making it easier to 

differentiate between styles. You can also gain the benefits 

of having styles without creating them yourself as Word 97 

automatically creates styles as you format your document. 

An intelligent mouse: A new Microsoft mouse, 

IntelliMouse, provides a more intuitive way of scrolling 

through your documents. 

Sharing 

Easier writing! 
Office Assistant: The Office Assistant in Word 97 is a small 

Word 97 packs in a whole range of new features designed 

to allow you to get the most out of the application if you 

work in a shared environment. Users can collaborate 

electronically on documents and retrieve and publish 

information online using the familiar Word 97 tools and 

processes. Among the major inclusions in Word 97 are- 
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As well as Improving consistency between existing applications, Office 
97 will incorporate a raft of new features that integrate your favourite 
applications to the online world. 

Microsoft research shows that over 70 per cent of Office users are 
‘connected’, either by an online Internet service or a public or private 
network,” says Peter Cray, Microsoft’s product marketing manager for 
Office. 

This statistic shows that Office is already a leading tool for creating 
content on intranets and the Internet with a further demand for 
Microsoft to expand Office's Internet capabilities. 

Office 97 ensures better information sharing and collaboration on 
the Internet and within intrahets. With Office 97, users will be able to 
use one tool to create content and publish it in a variety of ways, 
whether it is on your screen, on the Web or in old-fashioned paper form. 

It provides users with a familiar environment and a set of tools to 
create, manage and share Internet and intranet information, according 
to Cray. It will integrate Web standards into each application to make 
sharing information over the Internet or a company intranet a normal 
part of users’ everyday work experience. 

“Office 97 will supply tools for finding information, publishing 
documents and collaborating interactively with others, all by combining 
the best of the Web with the best of Office,” says Cray. 

it does this by improving search capabilities, building on the 
FindFast technology introduced in Office 95. FindFast Web Query in 
Office 97 will allow users to conduct full-text searching of both 
Microsoft Office and HTML documents on an entire corporate network 
or individual PC. 

Online layout view: This provides you with a new view that 

is optimised for on-screen reading. 

Document map: This one will let you navigate and organise 

your documents easily, as a split screen displays a hyperlink 

outline of your document on the left pane while the right 

pane contains the text. 

Navigation Tools: You’ll find this clever little feature at the 

bottom of your scroll bar. Click it and it allows you to 

navigate your document, using Find or Go To dialog boxes 

and more (a real bonus for those with large documents to 

navigate through!). 

Document versions: You’ll be able to keep track of all 

previous versions of a document in one file. This means you 

don’t have to save multiple copies of a document to keep 

track of different versions of it! 

In-place comments: This is just like having a bunch of 

yellow stick-it notes to plaster over your document. Instead 

of being instantly visible, these comment markers appear 

when a user hovers their mouse over the commented text. 

Portable documents: In the past documents have looked 

different depending on which PC you laid 

them out on and which printer that 

document was connected to. Say goodbye 

to that headache, as Word 97 lays out your 

document in a virtual machine so it looks 

the same no matter where it’s viewed! 

Hyperlinks: are now visible in Word 97, so 

you can jump straight out onto the Web 

from within a document. And when you 

type a Web URL in Word 97 it’s 

automatically converted into a live 

hyperlink. You’ll also find a host of Web 

tools to help you along your way (see 

breakout box). 

Looking good 
Word has always been good at helping you 

make your documents look better - now 

it’s an expert at doing it. A host of new 

features mean that making your documents 

look like they’ve been professionally 

produced is a simple task. 

Table drawing tool: This is one of those 

“you’ve just got to see it to believe it” 

features. Essentially, you can now draw 

tables using a freehand tool. Just drag the 

‘pencil’ across the screen where you want 

rows and columns and they’re there! 

Linked textboxes: This makes it easier for 

I you to link text boxes across documents. 

This is especially handy if you’re creating 

newsletters that span several pages. 

Text borders, shading and font effects: This allows you 

to add borders, shading and font effects around text within 

paragraphs. 
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If you’re like most Windows users, 
you know how how frustrating it is 
when applications lock up, you can’t 
get the multimedia to work, or you get 
a confusing error message. 

Surprisingly, most problems are not 
caused by hardware failures but by 
software and configuration conflicts - 
like misplaced DLLs, invalid drivers, 
incorrect path settings, bad parameter 
settings, and registry conflicts. 

Forget about spending hours searching 
through manuals or hanging on the 
phone for technical support. First Aid 95 
Deluxe offers a simple, user-friendly 
solution to correct problems fast and 
automatically. Just click on FIX and 
watch your problems disappear. 

Norman 
We’re on the Web!http://www.harvey-norman.com.au HN 14212 
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While Wopd' 

million user? 

’ Excel, Mitrosi >ft" ,f 

spreadsheet application, 

isn’t far behind with 

million. So. it's fitt 

;* surprise to see the updated Excel 97 is packed wit 

® good and new features as its word-processing^ 

According to Microsoft’s Cray, the chalk 

Excel 97 developers was a difficult one. 

million users there's an incredibly diverse 

group of people, he says. They range froth 

novice users managing simple lists, to 

accountants Working on large budgets and 

developers writing mission-critical 

applications Upon which businesses dej 

To produce a product which caters 

those categories is no mean feat, but, says 

Cray, it s been achieved in the bundle we’ll 

all grow to love known as Excel 97. Space 

limitations in this article stop us going into 

great depth about this product, so we’ll 

provide a run down instead, of the hot new 

and improved features of Excel 97. 

“The underlying approach to the development of Excel 

97 was to bring core spreadsheet functionality to the surface 

to make that functionality more accessible to all users,” said 

Cray. As a result, basic operations, formula creation, printing, 

formatting and charting have been simplified to “remove the 

barriers between the user and the power of the 

_ 

nPHpsheet." says Cray. 

jjWhil# Excel 97 contains many of the 

fine fcatu found in Word 97, such 

as Oituc \ istant and IntelliMouse 

Integration, ton’ll also find (at last!) 

multiple level undo instead of single 

undo. This is a real bonus if you 

want to bacl|up two or more steps 

, 0*1 work you’ve already completed, 

is many You’ll also find the following formula creation 

improvements: 

Formula AutoCorrect; This makes it easier lot users t. > 

write equations by automatically correcting is of the most 
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common formula¬ 

building errors, 

including double 

operators, double 

parentheses and 

transposed cell 

references. 

Natural Language 

Formulas: This allows 

you to write equations 

using everyday 

terminology. So, you 

can write formulas using 

your own column and 

row headings, rather than cell references. 

Range Finder: This uses coloured frames to indicate cells 

referenced in a given formula. By simply grabbing and 

moving the frames, users can easily adjust the makeup of 

the formula or a chart. 

Formula Palette: This combines the Function Wizard 

(which helps you build formulas using Excel’s built-in or 

user-defined function) and the Formula bar (which helps 

you edit formulas) into one useful and discoverable tool. 

Visual Printing: This allows you to determine visually the 

precise layout of information on each printed page. So when 

you go to Page Break Preview Mode, you can see a fully 

editable view of the spreadsheet to show what information 

will print on each page. 

Conditional Formatting: This automatically highlights data 

outliers or other key information by applying rules that 

change the formatting of cells and ranges based on the 

values they contain. 

Custom Cells: You can now go “beyond the grid” of the 

typical spreadsheet to make your data look the way you 

want it to look. This includes the power to rotate, indent 

and AutoSize text and merge cells so you can more easily 

create attractive forms and tables. 
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Your Fast guide to some oF the 
new things in Microsoft s Orrice 

9/ Family oF applications 
Internet-ready 
applications 
With Office 97, users will have a variety of built- 

in tools to easily and quickly publish content to 

a company intranet or the Internet. 

Seamlessly publish Office files to the Web: all 

native Office files can be posted to a Web site 

from within the applications. Users can save to 

an FTP site from the ‘files save as’ dialog box. 

Internet e-mail with Outlook: Outlook is a full 

MAPI (Messaging Application Programming 

Interface) client so it works with all MAPI e-mail 

systems including Microsoft Exchange Server, 

Microsoft Mail server, MIME (Multi-purpose 

Internet Mail Extensions), POP3/SMTP (Simple 

Mail Transport Protocol) and MSN, the Microsoft 

Network. Now it’s easy to send e-mail any time, 

anywhere to anyone. 

Microsoft Access Publish to the Web: Up-to- 

the-minute information is now easier to share 

than ever before. With the Publish to the Web 

Wizard in Microsoft Access 97, users can quickly 

and easily publish database information to create 

live, interactive Web pages that let users 

dynamically query, update or add information. 

PowerPoint Animation Player for ActiveX: Users 

can now make their pages come alive. With the 

PowerPoint Animation Player and PowerPoint 97, 

users can publish PowerPoint presentations on 

the web that include full multimedia special 

effects on HTML pages. 

Save as HTML: Office 97 now has the Office 

Internet Assistant technology built into the 

applications - enabling users to quickly and 

easily convert any Microsoft Office document to 

HTML format. 

Office Viewers for Microsoft Excel: Office 97 

viewers for Microsoft Excel, Word and 

PowerPoint allow anybody to view documents 

created in those applications, regardless of 

whether they have the application on their 

desktop. These viewers will be available free at 

http://www.microsoft.com/msoffice/ 

HTML on-the-fly converters: These converters 

enable users to publish in Office format on a 

Web server. When Office 97 users hit the Word 

or Excel page, the page will be viewed in Office 

native file format (Active Document support) 

within the browser window. B 

Office Binder: Stores all your files for a project in one place - you 

can even add common headers and footers so they look and 

print like one document. 

Microsoft Outlook: Provides an integrated desktop where you 

can organise and manage your e-mail, calendar, contacts, tasks, 

and files in one place. 

ActiveWeb: Allows you to author and view documents in their 

native format on your corporate intranet or the Internet. 

Save as HTML in Word, Excel, Access, and PowerPoint: Saves 

your Office documents into HTML format with the click of a 

button for posting to the Internet or corporate intranets. 

Web templates in Word: Provides custom templates to design 

great looking Web pages. 

Web Queries in Microsoft Excel: Pull real-time information from 

Web sites directly into your worksheet. 

Publish To The Web in Microsoft Access: Converts your data or 

reports to HTML so you can create dynamic, interactive database, 

pages and share them across a company intranet or the World 

Wide Web. 

Save to URL in Microsoft Excel: Allows you to save to a Web 

server by simply specifying the URL address. 

PowerPoint Animation Player for ActiveX: Lets you publish 

presentations to the Internet as a Web page with animation and 

narration. 

Document Versioning in Word: Tracks and stores all prevrbus 

versions of your document in one file. 

Office Assistant: Provides interactive advice, help, and tips to 

help you learn as you work and it’s completely customisable so 

you can choose the Assistant and the options that best suit the 

way you work. \ 

OfficeArt: Gives you drawing tools to easily design sophisticated 

3-D effects, shadows, multicoloured fills, textures, and Bezier 

ltirves. '■ 
IntelliMouse support in Office 97 applications: Take$ tage 

olthe IntelliMouse Wheel-for enhanced navigation, close-up 

viewing, and,panning leff and right (hardware sold separately), 

Images and fonts on CD-ROM: Includes approximately 3,000 clip- ‘ 

art images and 150 fonts. * .^/ 

Grammar Check and Spell It in Word: Proof reacfyoui documents i 
for spelling and grammatical errors as you type, arid correct 

errors with one click of the right mouse button \ ; '* 

Enhanced AutoCorrect in Word: Corrects commcp multiple-word 

typographical and grammatical errors, fixes capitalisation 

mistakes, and creates handy shortcuts for frequently used text 

and graphics. 

Natural language formulas in Microsoft Excel: Allow you to use 

your own terminology when building formulas. 

Multiple Undo in Microsoft Excel: Allows you to undo multiple 

commands. 

AutoPreview in Outlook: Lets you view the first three lines of 

each e-mail message. 
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Strap on your digital boots and get 
ready for a games extravaganza. 
Those trusty folk at Microsoft have 
unleashed an arsenal of new 
games for your gaming pleasure. 
Here at Communique, Martin 
Hoegh-Guldberg and David Mitchell, 
forced themselves to take time out 
of their busy schedules to put five 
of the new offerings to the test. 



The holiday season is upon us. Yep... long hours of sitting about 

wishing it would rain so there would be a good excuse to turn on 

the computer and send a few e-mails to your digital mates around 

the world. 

Don’t panic! Forget the story about a sick aunt in Stockholm, the 

thoughtful folk at Microsoft have given you all the reason in the world to get 

the ol’ screen glowing with pride by releasing a rack of CD-ROM interactive 

games just for you. 

With a swag of new titles on offer, Microsoft has propelled itself into tin. 

prestigious club of top six games publishers in the world. 

Here at Communique we decided these new games needed a good and 

proper testing. We selected five titles and slid them into our CD-ROM drives 

to discover they aren’t half bad. In fact, we found ourselves perched on the 

edge of our chairs for hours. 

The five games we choose were Deadly Tide, Hellbender, Monster Truck 

Madness, NBA Full Court Press and Microsoft Soccer. This selection-covered 

the range of the games on offer from Microsoft, from sports and shoot ’em up 

titles through to driving games where you get to pilot trucks with huge 

wheels. 

To produce the new titles, Microsoft teamed with the big guns of game 

development in the US such as Terminal Reality, Atomic Games and Rainbow 

Studios. As a result, Microsoft has created some of the best CD-ROM games 

titles you’ll see on the market. 

The new titles take full advantage of Microsoft’s innovative technologies, 

including DirectX APIs in Windows 95 and DirectPlay API for multiplayer 

games across local area networks or the Web. 

The best part of these games is the network option for playing across 

LANs and the Web. This makes playing the games a really good excuse for 

the holiday season as you can get the whole family involved, or even invite a 

few friends along for the fun. 

Better still, being able to play the games over the network means there 

aren’t any fights about whose turn it is or whose computer it is or even that 

someone has been playing for too long. The peace at Communique was only 

broken by the excited screams and shouts of those behind the Sidewinders. 

Getting started 
The hardware we chose to test these cracking games were a couple of 

Sidewinder 3D Pro GamePads. All we can say about the Sidewinder is, “Get 

one!”. They’re great and add enhanced control to your game play. 

We ran the CD-ROM games on a couple of trusty 486 PCs, with 8 Mb of 

RAM and 240Mb hard drives. While the ol’ 486s did the job beautifully, you 

can add a little more smoothness and action by using a Pentium. 

Setting up the games to run on your PC is easy. All you need to do is slot 

the CD of the chosen game into your PC and away you go. It installs the 

game and brings up the start menu screen automatically. 

To set up the games to run over a LAN or the Web, all you need to do is 

install the game on the machines you wish to use and select the connection 

tool, say WindSock for the Web. 

Then select one of the machines to become the host. Each player then 

selects “Multiple Player” option from the menu panel and logs into the game 

named by the host. Then it’s away you go. You can even send messages to 

each other during a game and you get to shoot, ram and race the others. 

Deadly 
Our first thought: “Wow! Four 

CDs.” 

Our second thought: “Will this movie 

introduction ever end?” 

And finally: “After watching the movie- 

length introduction, Deadly Tide is a 

fast, high-production adventure shoot 

’em up game that'll have you sitting 

tight for hours.” 

The first game we slotted into the 

CD player was Deadly Tide. This is not 

to say it’s the best game, but that our 

eyes popped out with anticipation 

when we saw the four CDs that make 

up the game. 

Disk one of the four provides you 

with the setup files and games you 

need to start playing and there’s hours 

of fun on just that one CD. When 

you’ve finished all the missions on 

disk one the other three 

plenty more missions foryg!4 

progress through. 

The game kicks off with a long 

movie introduction. You need to watch 

this as it sets the scene. The year is 

2445AD and aliens have just broken 

through Earth’s first line of defence on 

a lunar space station 400,000 

kilometres away and landed on Earth. 

CQAMJNIQUEB 
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These strange 

creatures from outer 

space live under water 

and are causing 

dramatic effects to the 

oceans of the world. 

Since they arrived the oceans have 

increased in volume from covering 75 

per cent of the world’s surface to 

covering 88 per cent. This is the 

Deadly Tide and it is slowly but surely 

swallowing the dry land. 

Your role in the game is as a Hydro 

pilot for the EOA (Earth Ocean Alliance) 

aboard the Hastings. You zoom about 

under the sea fighting the aliens that 

are trying to rid the earth of humans. 

They reckon we’re a bunch of pesky 

parasites. 

You can select different missions 

by scrolling across a map of the world 

which shows the various and 

numerous alien encampments. 

However, there is a sequence you 

must follow and can only progress 

from one mission to the next by 

completing them in order. 

Deadly Tide is a high-speed, 

cinematic underwater action shooter in 

which players move from mysterious 

sunken ships to alien mining 

operations to full scale battles on the 

open sea as they attempt to save 

humanity from the enemy. 

The game’s realistic 3D graphics 

were created by the Hollywood 

designers responsible for the eye¬ 

popping effects on “SeaQuest” and 

“Star Trek: The Next Generation”. With 

its CD-quality musical score and 

integrated story line, Deadly Tide will 

fascinate new and experienced gamers 

alike. 

Players will be captivated by the 

pulse-pounding action and the need for 

lightning-fast reflexes. As hydrofighter 

pilots, gamers destroy aquatic-based 

aliens as they venture into numerous 

underwater passageways, adding to 

the game’s replay value and truly 

challenging gamers. 

Hellbender 
Our first thought: “Where’s Gillian 

Armstrong?” 

Our second thought: “Are we wearing 

pink sunglasses?” 

And finally: “Hellbender is an intense 

action shooter that offers hard-core 

gamers an integrated science fiction 

story line." 

Being in the shoot ‘em-up-come- 

science-fiction frame of mind, we 

decided to go for Hellbender next. This 

again has a long introduction that is 

important to watch as it sets the 

scene beautifully in full screen movie 

action. 

The Coalition of Independent 

Planets has finally defeated its most 

fearsome enemy, a race of warriors 

they had created called The Bions. 

With their army in ruins, the few 

remaining Bions have fled to the safety 

of deep space. 

For the first time in more than 300 

years the Coalition Citizens are 

enjoying peace. The destruction of The 

Bion stronghold on the planet Fury 

touched off stockpiles of Red Sheol 

and hyper-explosive Carbinium, giving 

birth to a network of rift wormholes 

spanning the Universe, a mammoth 

superhighway linking the Coalition of 

Independent Planets. 

Recently a bomb of Bion origin 

destroyed the Coalition Attack Fighter 

Academy on Sebek killing all the pilots. 

The Council has ordered a retaliatory 

strike and you guessed it, you’re their 

only hope. 

You then choose your fighter craft 

from a selection of about six craft and 

fly off to the planets to destroy the 

nasty Bions. 

In normal mode, game play is hard 

and enemies are plentiful. We found 

the network mode the most fun 

especially as there was only the two of 

us and we could concentrate on just 

one enemy, chasing, ducking, diving, 

accumulating more ammo and shield 

strength and blowing things up. 

Hellbender features tremendous 

depth of play and replay value, 

including strategic elements, secret 

worlds, numerous weapons and a 

variety of adversaries. 

The game also features some of 

the latest technological advances for 
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Would you rather 
be prolific or great? 

Or both? 
Lots of ideas help you find 

the one great one. 

Speed lets you generate lots 

of ideas. 

Wright Design; radically fast 

integrated package. 

Finally puts PC-based 

graphic designers in front. 

Fast explanation: 

Wright Design Software. Download for demo: www.wright.com.au Fax: (02) 9519 6171. Or phone: (02) 9516 3233 for info. 

First: easily handles huge files. 

Opens 120 mb image in seconds. 

Transforms in near real time. 

Second: truly object-based. 

Once-incompatible worlds of 

Wright Design. 
Searching; for more. 

vectors and bitmaps brought 

together. 

Third: real multi-tasking. 

Import/export take place while 

you get on with the 7g®| 

next task. 

In short, it happens INI ~ 
in real time or near. ^ 

More time to think. 



MOmter Truck 
Modnett 
Our first thought: “We can’t drive!” 

Our second thought: “Who cares, it’s 

only a game.” 

And finally: “For the crunch and grind 

thrill of racing big, huge, chunky 

trucks with even bigger wheels, this 

is as good as it gets.” 

Monster Truck 

Madness is the most 

radical and 

outrageous racing simulation because 

it seats players behind the world’s 

most powerful vehicles as they crush, 

splatter, jump and roll their way to 

victory. 

The title features a radically fun 

and realistic racing experience that 

begins with highly detailed renderings 

of world-famous monster trucks, 

including BigFoot, Snake Bite and 

Gravedigger. (Yep... we love ‘em all - 

Ed) 

The trucks behave just like their 

namesakes, both on the ground and 

when they take to the air, and provide 

true-to-life, bone-jarring movements. 

The gunning motors and cries of 

twisted metal are the real thing, too - 

recorded and digitised from actual 

monster truck races. 

Giving the whole event an authentic 

feel is the narration of Armey 

Armstrong, beloved by millions of 

monster truck racing fans everywhere 

and Communique late night 

viewers. He’s our Monster 

Truck hero. 

In addition to the standalone, 

modem-to-modem, Internet 

and LAN playing options, you 

can also connect to Microsoft’s 

Monster Truck Web Stop on the 

Internet. There, you’ll find up-to-the- 

minute tips and tricks, information on 

monster trucks, and even race results 

from the real races in the US. 

Again, this game was the most fun 

in the network mode where you can 

send messages to your fellow truckies 

(abusive ones if you must) and not only 

race the different circuits but have fun 

ramming each other. 

NBA Full 
Court Preu 
Our first thought: “We need practice.” 

Our second thought: “We need loads 

more practice.” 

And finally: “This is one fast way to 

work up a sweat playing the big boys 

in the NBA and making 3 pointers all 

the way to victory.” 

A bit tired of blowing things up and 

ramming each other, the team at 

Communique decided it was time to 

including full 

graphics, and 

Sidewinder 

course. 

The engaging story line was written 

by acclaimed science fiction film writer 

Geoff Miller (of “DeepStar VI” fame), 

and if you’re still wondering where 

Gillian Anderson of X-Files fame is, 

then listen carefully and you’ll hear her 

dulcet tones throughout the game. 

Sorry, no pictures. 

If you're like us at Communique, 

sitting up late at night to catch the 

latest on the Monster Truck racing 

circuit on US cable TV, then you’ll 

appreciate this interactive driving 

extravaganza. 

Even if you haven’t seen this 

magnificent spectacle but like racing 

around a track, jumping ramps and 

crashing into other drivers, then this is 

the game for you too. 

Microsoft moves the simulation 

experience from air to ground in 

delivering Monster Truck Madness, the 

world’s only PC monster truck racing 

game. 
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pull on the gym shoes and get active 

amongst the hoopsters of the NBA Full 

Court Press. 

Whether you know anything about 

basketball or not, this game is a real 

thriller. You get to play official NBA- 

style action on your PC with all the 

captivating, competitive experience 

you’d expect from being in the Big 

League. 

The first thing you need to do is 

select the team you want to represent. 

This can cause fights among those 

wanting to play so take care and 

remember there’s all 29 NBA teams in 

NBA Full Court Press to choose from. 

There are a variety of ways to play 

this game and you can elevate the 

excitement of the game by competing 

against other players on different PCs 

in real time using the multiple player 

option over a modem or the network. 

This way, you can combine two to four 

players to control a team in full, five- 

on-five basketball play. 

You can also compete in single 

games, play an entire season 

schedule, organise tournament play or 

work on your game in practice 

sessions. Intense, unpredictable 

competition is enhanced by an artificial 

intelligence engine that draws on more 

than 100 actual NBA plays. 

NBA Full Court Press also delivers 

on the striking degree of realism 

demanded by sports gamers. It offers 

dazzling, true-to-life, high-resolution 

graphics and amazingly lifelike player 

action and movements, including more 

than 250 motion-captured player 

animation sequences. 

Crowd noises are recorded and 

digitised to give you the home-court 

advantage. Every dunk, rejection and 

rebound is provided by the emphatic 

play-by-play commentary of Kevin 

Calabro, the voice of the Seattle 

SuperSonics. 

Like most sports games, practice 

is the key and we found the going a 

little tough at the start trying to work 

out how to run, jump, block and throw. 

Nevertheless, you catch on fast and 

will be playing a full round of NBA 

basketball before you can say 

“jammin’ mummal”. 

Microsoft 
Soccer 
Our first thought: “Oh no. We need 

more practice.” 

Our second thought: “Where do they 

get these players’ names from?” 

And finally: “Microsoft Soccer 

captures what it must be like to play 

at Wembly, with smooth player 

movements and enhanced realistic 

sounds and chants, stadiums and 

conditions.” 

With the sporting 

mood firmly settled on 

the team at 

Communique, we turned 

our attention to the last, 

but by no means the 

least, game on our list - 

Microsoft Soccer. 

The first thing we 

realised was that we 

needed to start from 

scratch in our practising 

after getting NBA under 

control. Not to worry. We 

dug our heels in and 

took the bull by the 

horns and started the 

practice sessions. 

What we very quickly realised 

was that the experience of 

Microsoft Soccer is fun and the 

competition is just as you might 

imagine an internationally acclaimed 

sport to be: fast and exciting. 

Artificial-intelligence and 

multiplayer capabilities let you 

experience the thrilling competition 

of the sport. And set up is as simple 

as the other games. You can kick off 

immediately at the sound of the 

whistle. 

Motion capture provides smooth 

player movements, and the entire 

experience is enhanced by realistic 

sounds and chants, stadiums and 

conditions. If you’re a soccer fan or 

just like the sport, this is a great game 

to play with all the options you would 

ever want, including slide tackles, 

scissor kicks and all the heading skills 

of Maradona. 

Just don’t forget, as you move from 

one of these exciting games titles to 

the next, in Microsoft Soccer and NBA 

Full Court Press you don't blow up the 

stadiums. And if you’re going to take 

on the Bions this summer, don’t forget 

to invite us gamers here at 

Communique.E 
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ALVIN SAVES 
A BUNDLE 

With the money Alvin saves shopping at 
www.shop.com.au he can afford a few of lifes little luxuries. 

No middleman, no annoying sales staff, just bargain basement prices - it sounds too good to be true. 

www.shop.com.au represents a new era in commerce. Browse our aisles, search for a particular product 

and purchase the item of your choice without any of the hassles. 

Our support guarantees secure credit card transactions or you may purchase through any number of 

traditional methods, www.shop.com.au provides online shopping unequalled anywhere in the world. 

So if Alvin can save money on his computer equipment, you can too!! 

http ://www. shop. com. an 
Trade and corporate account enquiries welcome. 

Telephone Megatron + 61-2-9437 4544 
25 Atchison St St Leonards NSW 2065. 



V / 

You thought you'd lost that old 

article, the one that solved all 

your problems. Well, breathe 

again because the INDEX will tell 

you where and tell you when. 
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Access Developer’s Toolkit. 

Access for Windows 95 Databases. 

BackOffice 2.0. 

Bookshelf 1996-97. 

Cinemania 96. 

Close Combat. 

Close Combat. 

Complete Gardening. 

Copying is illegal - Play it safe. 

Deadly Tide. 

Encarta 96 World Atlas. 

Exchange Server. 

GEX...I. 

Golf 2.o.W:. 
Golf 3.0. 

Hellbender. 

Internet Assistant for Microsoft Word. 

Internet Explorer 3.0. 

Internet Starter Kit. 

Magic School Bus Explores Inside the Earth... 

Mastering Microsoft Access Programming. 

Mastering Internet Development with 

Microsoft Active X Technologies ....§',. 

Mastering Microsoft Exchange. 

Mastering Microsoft Visual Basic. 

Mastering Microsoft Visual C++. 

Mastering Microsoft Visual FoxPro. 

Microsoft Flight Simulator. 

Monster Truck Madness. 

Movie Maker. 

Music Central 96. 

NBA Full Court Press. 

Office Value Pack for Home and Business. 

Office Value Pack for Home and Business. 

PJ’s Reading Adventures CD-ROM. 

PowerBase CD-ROM. 

Return of Arcade. 

Soccer. 

SQL Server 6.5. 

Systems Management Server 1.2. 

Visual FoxPro. 
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Feb 7 

April 9 

August 7 

May 9 

Dec/Jan 9 

Sept 5 

Oct 7 

June 9 

March 9 

Oct 7 

Dec/Jan 7 

March 8 

Oct 7 

Dec/Jan 7 

Oct 7 

Oct 7 

Feb 6 

July 8 

June 11 

May 9 

May 10 

July 5 

July 5 

Feb 7 

May 10 

Feb 7 

Oct 7 

Oct 7 

Feb 6 

Dec/Jan 8 

Oct 7 

March 8 

April 9 

Sept 4 

Dec/Jan 12 

June 9 

Oct 7 

June 11 

August 8 

Oct 8 

Visual J++. July 5 

Windows NT Server 4.0. July 5 

Windows NT Workstation 4.0. July 5 

MICROSOFT PRESS 

Microsoft Office for Windows 95 Resource Kit. Dec/Jan 8 

Microsoft Word Developer’s Kit, 3rd Edition. Feb 9 

Microsoft Windows 95 Training. Feb 9 

Microsoft Windows 95 Help Developer’s Kit. Feb 9 

Introducing Microsoft Exchange.March 10 

Microsoft Windows 95 Corporate Migration Kit. March 10 

Running Microsoft Office for Windows 95. March 10 

Programming Windows 95. April 11 

The Windows 95 Internet Kit. April 11 

Microsoft Windows 95 Training. April 11 

Running Microsoft Excel for Windows 95. May 11 

Microsoft Access for Windows 95 Step by Step. May 11 

Inside Visual Basic 3rd Edition. June 10 

Learn Visual Basic 4.0 Now. June 10 

Microsoft Press Web Site... July 7 

Client/Server Programming 

with Microsoft Visual Basic..i..August 8 

Microsoft Bookshelf Internet Directory 1996-7. August 8 

Microsoft Office 95 Integration Step by Step. August 8 

Microsoft Windows NT Server Resource Kit.. Sept 5 

Microsoft Windows NT Workstation Resource Kit. Sept 5 

Microsoft Windows NT 4.0 Server Training. Oct 6 

Microsoft Windows NT 4.0 Administrator’s Training... Oct 6 

Microsoft Windows NT Workstation 4.0 Starts Here .. Oct 6 

Microsoft SQL Server Training. Oct 6 

Microsoft Internet Information Server Training. Oct 6 

Microsoft Windows NT Server Resource Kit. Oct 7 

Readings on Microsoft Windows and WOSA. Oct 7 

Microsoft Windows NT Workstation Resource Kit. Oct 7 

Microsoft Windows NT Training Version 3.51 

Plus Version 4.0 Upgrade Training. Oct 7 

Microsoft Windows NT 4.0 Upgrade Training. Oct 7 

Microsoft Windows 95 Training. Oct 7 

Networking Essentials. Oct 7 



FEATURES 

A Magna Carta For The Knowledge Age?. Dec/Jan 14 

If you wish to survive the Information Age, do not listen to experts, 

writes Charles Wright. Surviving the Information Age requires the 

same sort of amiable disbelief that we used to apply to weather 

forecasting. 

Around The World In 80 Minutes. Dec/Jan 19 

Two latter-day toffs set off to retrace the steps of Jules Verne’s 

famous pair Phileas Fogg and Passepartout... this time in 80 

minutes instead of 80 days, and on the Microsoft Network! The 

highly amused Max Anderson reports oh their travels and indeed, 

travails. 

Doors And Windows. Dec/Jan 24 

From an exciting range of tales of fantasy, mystery and adventure 

comes a gripping account of an enticing world that proves 

irresistible. 

Talking Tech On The Web And MSN. Dec/Jan 34 

Leaving the hot-air balloons and Zeppelins, the Cutty Sarks and 

Vickers Vimys at home, we board a probe for serious exploration of 

the online world's offerings and openings on all things technical for 

sworn devotees of tech and tech-plus. 

Not Drowning, Waving... Dec/Jan 38 

Running a small business is anything but easy. The same things a 

big business does - like paying wages and taxes, tracking cashflow, 

being able to respond quickly - are done by small business, but 

with far less resources. Enter a versatile set of tools to help out. 

In The Company Of Collaborators. Dec/Jan 61 

Worried about Windows 95? Concerned about the future of your 

beloved Mac software? Fear not Mac-o-phile, Communique’s Alan 

Shore recently Went for a visit Stateside to discover the truth 

behind Microsoft Mac strategy. 

Click And Enter. Feb 12 

While the Internet has grown rapidly during the past two years, with 

an estimated 30 million people using it worldwide, to many it 

remains a place of uncertainty and mystery. This month Microsoft 

rolls out the first of a range of products that will bring the power of 

the Net into a secure and safe environment for both business and 

home users. 

The Road Ahead. Feb 16 

Bill Gates’s first book, The Road Ahead, is a journey into the future 

as seen through the eyes of Microsoft’s visionary chairman and 

CEO. Published in more than 20 languages, the following excerpt is 

a personal vision of how the information superhighway might affect 

us all. 

All This And Sheep Too. Feb 20 

After months searching for the right piece of agricultural software to 

run her property in country Victoria, Primmy Bright happened upon 

a surprisingly well written piece in Communique about a Dubbo 

farmer. Seconds after reading the magnum opus her bin was full of 

agricultural software brochures, her heart was light and her sights 

were set on developing the perfect farm management system using 

Office 95! 

Getting It Together. March 14 

Teamwork is the vital ingredient in most successful organisations, 

from multinationals to small businesses. But no matter how much 

individuals want to work together, without the right tools it’s an 

uphill battle. In a teamwork effort of their own, Communique’s 

Martin Hoegh-Guldberg and Darren Edwards go in search of two 

organisations that have discovered the right tool to help people 

work together - Microsoft Exchange Server. 

Putting Cash Back In The Employee’s Pocket. March 18 

Combining Windows 95 and Office 95 with electronic forms 

software and scanners has turned Jetform Pacific into a lean, mean 

fighting machine that pays employee expenses fast. 

Speeding Your Way To Support. March 45 

We present the definitive guide on how to make Microsoft's much- 

maligned voice routing unit (VRU) the readily friendly helper it really 

wants to be. 

The Verdict’s In - Migrate Today!.April 14 

Whether your business is big or small, migrating to Windows 95 

and Office 95 means saying farewell to memory crashes and a big 

helloooo to productivity gains. We check out two recent migrations. 

When The Chips Are Down. April 18 

When a small Melbourne firm won the contract to provide project 

planning for the $500 million Crown Casino it was given 10 days to 

identify and plan all the main design and construction activities 

involved in completing the project. To discover how they did it, we 

sent Communique’s construction writer Nicole Manktelow on-site. 

Bringing The Surf To Your Door. April 22 

Since we last wrote about Microsoft's Internet strategy a good deal 

has happened. This month Darren Edwards grabs a surfboard and 

paddles off in search of Bill Gates, Daniel Petre and some cool 

free software. 

Oh , You Beautiful App!. May 14 

Whether you use them to find yourself a partner or to provide you 
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with a way of presenting a more professional image to the world, 

single Microsoft applications such as Word, Excel, Access and 

PowerPoint are becoming the mainstay of many a computer user. 

This month Communique’s Nicole Manktelow and Darren Edwards 

go in search of four users who, it’s fair to say, have an unusual 

fondness for their application of choice. 

Coming Down The Line ■■'■■■■%$.. May 20 

Whether it’s news from the world's war zones, a review of Brad 

Pitt’s new movie or the latest offering from the English band Oasis, 

by using Microsoft’s range of nifty products you can get the latest ; 

information, when you want it - all without moving from your PC. 

Communique launched reporter Linda Hopkins into the online world 

to find out how. 

Your PC Yesterday, Today And Tomorrow. June 11 

The personal computer is going through a period of dramatic 

change and so are you - although you might not know it. To find out 

where we are going and when we’ll get there, the Communique 

team visits a tarot reader, gazes into a crystal ball, throws some 

chicken feet in the sand, then, totally stumped, reverts to Bill 

Gates and Daniel Petre. 

Putting A Smile On The User’s Dial. June 18 

In the world of business the tools of your trade can make or break 

you. More and more these days! companies and individuals within 

those companies would be lost without those sweet computer tools 

we call applications. The Communique team dropped in on a 

company to see how it’s using the power tool, Office 95. 

No Coding Between You And Your Web Site. June 22 

Microsoft’s new Web tool, Frontpage is the easiest and fastest way 

to create and manage Web sites. Get ready, publishing easily on 

the Web is now just a download, a modest payment and a few 

clicks away. 

Web Design With Ease. July 18 

With the Internet continuing to be the buzz word of the 90s, 

hundreds of companies are flocking to get Web pages that work up 

onto the Net. Now a new tool has arrived that will make creating 

and managing Web sites easier than it’s ever been. 

Speeding To Market. July 24 

A migration to Microsoft Office for Windows 95 has put grunt under 

the bonnet for small list services provider Direct Media and is 

helping the company’s success in Australia and overseas. 

Communique finds out what has made the company’s migration 

such a success. 

Industrial Strength Computing. July 28 

If you’re the sort of computer user who has 15 applications open 

at once and has a PC that radiates heat, and you love opening the 

world’s biggest spreadsheet while preparing a mega PowerPoint 

presentation, then your dream is here - a 32-bit operating system 

to take you to Nirvana and back. 

Intranet Explained At Last. August 18 

There is almost as much hype about intranets as there is about the 

Internet. But why is everybody so excited? The Communique 

collective takes a look at a technology that brings disparate 

computers together, allows people to share information and helps 

create workflows that aid youf business. 

View The World With New Eyes. August 25 

In order to navigate your way successfully through the rambling 

network that is the Internet, you need the right tool. A sextant 

won’t do, nor will a compass. Looks like it’s up to the best 

navigation aid around - Microsoft’s Internet Explorer 3.0! 

Aussies First For Microsoft. August 28 

While the expertise of software development lies close to the heart 

of those in Redmond, Washington, the art of story telling has 

Australian developers engineering the cutest of characters for kids. 

Nicole Manktelow checks out who’s wearing the Rabbit Ears crown. 

Power And Strength. Sept 18 

Whether you’re a power user or an everyday user, the release of 

Windows NT Workstation 4.0 means there’s now a 32-bit operating 

system to meet every need. The question is, which one is for you? 

Communique editor Darren Edwards takes a long, hard look at the 

splendid new arrival and then compares it with everyone’s 

favourite, Windows 95. 

Famous Words...... Sept 25 

Last year's launch of Windows 95 was one of the biggest and best 

things to happen to computers since the microchip. This month 

Communique special investigator Helen Mitchell continues her life’s 

work of finding people who have fallen head over heels in love With 

Windows 95 and various power-packed applications. 

Beyond The Firewall. . Sept 28 

Microsoft's latest Internet product, Catapult, takes security to a 

new level. Communique’s hacker extraordinaire, Helen Mitchell, 

ycomm^MMu 
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tries to fight her way past its defences but fails in this stirring tale 

of bulletproof corporate technology. 

Big Bad Fun... Oct 18 

Nine new games have been developed by Microsoft, and we are 

convinced that it's finally appropriate to wheel out that old cliche - 

“there's something here for everyone”. The Communique team 

road-tests each and every one of them to give you the full run 

A New World For Everyone.1. Oct 25 

The launch late: last:month of the Microsoft Network on the Internet; 

ushers in a new era of entertainment and information on the Net 

With major investment in its content around the world:, suddenly the 

Internet is shaping up as a serious competitor to other forms of 

media. 

Office 97 On Its Way.. Oct 28 

The eagerly awaited release of Office 97 is just around the corner, 

meaning more spectacular goodies for fans of quality software 

everywhere. Communique’s Helen Mitchell takes a sneak peek at 

what we can expect from Microsoft with this brand new offering. 

KIDS’ COMMUNIQUE 

Oceans Stuff. Dec/Jan 41 

Take in some wild holiday action. What a choice! Your very own 

spaceship, an underwater volcano (not however to be used as a 

launching pad), a spy adventure to take you across the world, and 

if the weather just won't play along, then there’s a word search and 

a few clowns to be dressed up. 

Travel The World. Feb 25 

Time to pack your bags and see some sights as Kids’ Communique 

goes travelling. Join us on a trip around the world with Microsoft 

Encarta World Atlas. 

Who's Making News?. March 25 

You can’t believe everything you read, but you can have a pile of 

fun creating your own newspaper - it’s easy to do, and Kids’ 

Communique shows you how! 

Sloppin’ And Scratchin’l. April 25 

The school hols, Easter and Mum’s Day all get wrapped up together 

this month in a super Kids’ Communique extravaganza. It’s time for 

a paint slopping, pen scratching, creative juices flowing time with 

those two most fine products, Creative Writer and Fine Artist! 

Berrrlaast Orffff!. May 25 

Space is a big, black, dark place with lots of stars and comets and 

gas and, uhhhh, aliens, yeah, aliens!...uh, and spaceships and 

intergalactic wars and ...well, it’s a cool place! 

Creepy And Spooky..... June 27 

Get out the sheets and rattle the chains, and watch out for bugs 

and bats, here’s the creepiest, spookiest, eeriest, gooiest Kids’ 

Communique yet - and it’s coming to get you! 

Inside The Earth... July 33 

Our own planet i& adventure-land this month. Come for a rollicking 

ride On the Magic School Bus, visiting caves and volcanoes, and 

finding creatures and crystals, and rocks arid fossils - find the 

weirdest or wildest and you could be this month’s winner. 

See Yourself In A Comic...,. August 33 

Come along to Comic Chat, Microsoft’s innovative approach to 

chatting online. Join in the fun and become part of a comic strip. 

Hey, New Rabbit Ears!.JjjL. Sept 33 

With our old friend PJ Rabbit as your guide, come along on a fun 

trip into the deepest, darkest heart of Africa in the company of Koi, 

the youngest son of a chief. Then meet the giant-sized, heroic 

lumberjack, Paul Bunyan, in the snow-covered forests of America’s 

mid-west. 

Friday’s Beach. Oct 33 

Whether you’re a youngster, a teenager or even someone on the 

other side of 20, it’s time to start checking out some great Net 

content. We take you through Australia's first Internet soap opera, 

Friday’s Beach, produced by Microsoft in Australia. 
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COMMUNIQATE 16 

Amanda Keller.. Dec/Jan 58 

Amanda Keller and two more invited guests let us in on their close 

relationships with their PCs - places where only the brave dare 

venture. 

Ian Kiernan.,gi. Feb 33 

The 1994 Australian of the Year, and ‘Clean Up the World’ king, 

describes all the valuables to be found in the bilges of his yacht, 

and introduces his very clever (biography-writing?) dog, Max! 

Agro Charms For A Change. March 24 

Star of Channel Seven’s The Cartoon Connection, and Brisbane’s 

B105 breakfast radio show, Agro, has attitude and a wicked sense 

of humour. Communique caught up with Australia’s busiest puppet 

host and his alter ego, Jamie Dunn, between gigs, to chat about 

technology, red cordial and surfing the Net. 

Dr Feelgood. April 33 

Sex consultant to the everyman (and everywoman), Dr Sally 

Feelgood is a star of radio, TV and now cyberspace. When she’s 

not surfing the Internet, she’s busy answering life’s big questions. 

Shirley Purvis.. May 33 

The popular comedienne recounts, true to her Internet alias, 

cranking up the garden computer in the old toolshed only to have to 

switch to more orthodox equipment for most of her more urgent 

tasks. 

Darren Bennett... June 37 

An excellent adventure with former Eagle and present Charger, 

Darren Bennett, who surfs the Net when he’s not involved in 

kicking, punting and being a superstar Stateside. 

Dr Harry Cooper.. July 16 

Dr Harry Cooper is famous for his work on Network 7’s Talk to the 

Animals but there’s a lesser known side to the bloke. Communique 

digs deep to discover Dr Harry, the tech-head. 

Paul McDermott. August 16 

Paul McDermott, the ABC's new-found guru on current affairs, 

waxes lyrical about life, love and computers. 

John Wood. Sept 16 

Australia’s favourite Blue Heeler, John Wood, takes a break from 

chasing crims to chat about how technology has changed the way 

he works. 

Glenn A. Baker... Oct 

Glenn A. Baker, the walking, talking, music encyclopaedia 

extraordinaire, also has a few other talents up his sleeve, such as 

writing, media presenting and consulting. And Communique recently 

discovered Glenn A. Baker is an avid Internet junkie as well. 

PRODUCT TUTORIAL 

Personalising MSN - Make yourself at home. Dec/Jan 65 

Working the way you want to doesn’t have to stop at the desktop. 

Users of the Microsoft Network continue to have the ability to 

customise and add that personal touch. This tutorial has been 

adapted from the MS Press book "The Australian MSN Book” by 

Rose Vines. 

Map Mania in Excel 95.. Feb 35 

Communique’s resident techo-meisters, Sue Dyson and Roger 

McShane, plot a course around Australia in this month’s tutorial. 

By using Excel 95 the pair will teach you how to display, colour and 

add data symbols to maps using the Mapping module option. 

Creating a Home Inventory Database. March 34 

In addition to showing you how to create a home Inventory 

Database within Microsoft’s Works 95, you’ll also discover how you 

can customise a database, use Works’ extensive online help and 

even create a serialised field that will automatically insert an ID 

number for each record. 

Small Business Focus. April 34 

Resident Communique techos, Sue Dyson and Roger McShane, go 

on a joyous journey of discovery in this month’s tutorial on 

Microsoft’s Small Business Pack. Along the way they discover 

some power-packed tools and templates that make running a small 

business a snap. 

Creating Databases. May 34 

Here’s help on experiencing some of the new features of Access 

95, and hints on making your databases look more professional. 

Internet Explorer. June 38 

Continue on the road to discovery as you download Microsoft’s 

Internet Explorer, learn how to customise your Search Page and 

MSN Start Page, and add further sites to your list of favourites. 

WBm 
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Web Publishing Made Easy.July 49 

It’s de rigeur to have your own home page: this month, our trusty 

techo team put together a ripsnorter of a tutorial on using 

Microsoft’s Internet Assistant for Word to get your own page up and 

running. 

Mail Merging in Word 95 using data 

from Microsoft Access.August 49 

Learn how to incorporate information (or a subset of data) that’s 

stored in an Access database on a shared network into mail 

merged documents produced on your own word processer. 

Creating and Working with a Web. Sept 49 

Here’s your guide to using Microsoft Frontpage. In this tutorial 

you’ll learn how to create a Web page, edit and link Web pages and 

How to Excel with Frequent Flyer points. Oct 49 

As usual, Roger McShane and Sue Dyson produce a splendid new 

tutorial to help you discover the finer points of Excel. 

ASK THE WIZ AND HOT TIPS 

Access 2.0 - Creating a field to display 

the current financial year. April 44 

Access 2.0 - Displaying read-only data. Feb 43 

Access 2.0 - General Protection Faults. Feb 38 

Access 2.0 - Piled-up pictures on a form. Feb 43 

Access 2.0 - Sorting on a memo field. Dec/Jan 84 

Access 95 - Calendar Controls.July 45 

Access 95 and Access 2.0 - Deleting records.June 47 

Excel - Adding one column of figures to another. Dec/Jan 84 

Excel 5.0 - ‘Thermometer’ graphs. March 42 

Excel 5.0 - A tool to solve the Communique 

crossword puzzle!.April 44 

Excel 5.0 - Changing PivotTables.August 43 

Excel 5.0 - Checking dependent cells. March 44 

Excel 5.0 - Excel is stealing zeros.April 39 

Excel 5.0 - Renaming sheets. May 45 

Excel 5.0 & 95 - Data extraction. Oct 45 

Excel 5.0 & 95 - Page Setup with a single click. Oct 44 

Excel 5.0 and 7.0 - Filling a series. August 

Excel 5.0 and Excel 95 - Formatting charts.June 

Excel 5.0 and Excel 95 - Pagebreaks in spreadsheets April 

Excel 5.0 and Excel for Windows 95 - 

Changing default footers. Feb 

Excel 5.0 or 95 - Formulas and file names in cells.... Oct 

Excel 5.0 or 95 and Word 6.0 or 95 - full path 

names in footers..... Oct 

. March 

. Sept 

. August 

. Sept 

,. Feb 

Microsoft ClipArt - ClipArt images.. 

Office - Customising the office toolbar. 

Office 95 - Launching Microsoft ClipArt from a 

Toolbar and faxing with MS Exchange.. 

PowerPoint 7.0 - Building Equations. 

Project 4.0 - Assistance with Project. 

Project 4.0 - Elapsed durations. 

Project 4.0 - Paying contractors. 

Project 4.0 - Resource availability. 

Project 4.0 - Setting a default directory. 

Project 4.0 - Summary Information. 

Project 4.0 - Updating Task Status. 

Project 4.0 and 4.1 - Interactive filters. August 

Project for Windows 95 - Recurring problems.July 

43 

40 

August 44 

Dec/Jan 82 

August 41 

April 39 

Dec/Jan 82 

42 

41 

Publisher - Printer memory. March 43 

Publisher 2.0 - Printing outline text. May 45 

Publisher for Windows 95 - Save formats.July 42 

Schedule+. August 43 

Schedulen- 95 - Setting Alarms. July 42 

Shortcuts for cutting, copying and pasting. July 45 

Transferring files from a Macintosh.June 43 

Using Access data in Word 6.0. Sept 42 

Windows 3.1 - Changing the start-up logo.April 45 

Windows 95 - Accessing the Desktop. May 44 

Windows 95 - Access to the Desktop. Feb 41 

Windows 95 - Access to the Desktop. May 44 

Windows 95 - Adding a new item to the send menu .. Feb 42 

Windows 95 - Changing the time format. Sept 45 

Windows 95 - Deleting Temporary Files. Dec/Jan 83 

Windows 95 - Dial-Up Networking. April 41 

Windows 95 - Disabling the Logon dialog box.April 38 
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Windows 95 - Downloading latest version 

of Internet Explorer. May 

Windows 95 - Faxing using Microsoft Exchange. May 

Windows 95 - including support for CD-ROMs 

on the startup disk..June 

Windows 95 - its mysterious vertical Taskbar. March 

Windows 95 - Password dialog.August 

Windows 95 - Using Internet Assistant. May 

Windows 95 - WindowsiFius! Screen saver. March 

Word - Printing bold labels. Feb 

Word - Word and page numbering. March 

Word - Working with sections. Feb 

Word 6.0 - Automatic Numbering. May 

Word 6.0 - Calculating. Dec/Jan 

Word 6.0 - Continuing automatic numbering 

after inserting a table . Dec/Jan 

Word 6.0 - Converting a WordArt object. March 

Word 6.0 - Creating HTML files. July 

Word 6.0 - Drawing graphical summaries. Sept ; 

Word 6.0 - Forms. August 

Word 6.0 - Full screen mode. May 

Word 6.0 - Mail Merge. June 

Word 6.0 - Mastering Word 6.0. March 

Word 6.0 - Page numbering. March 

Word 6.0 - Printing multiple files. June 

Word 6.0 - Scroll Bars in full screen mode. Dec/Jan 

Word 6.0 - Spaces Between lines with bullets. June 

Word 6.0 - Tables and other things.April 

Word 6.0 - When is a heading not a heading?. Dec/Jan 

Word 6.0 & 95 - Re-starting automatic numbering. Oct 

Word 6.0 and 7.0 - Using sequence numbers. August 

Word 6.0 and Excel 5.0 - Creating forms. March 

Word 6.0 and Word 7.0 - Paragraph Numbering.June 

Word 6.0 and Word 95 - Interactive kerning.July 

Word 6.0 and Word 95 - Path name in 

Word documents. April 

Word 6.0 and Word 95 - Printing pages 

in reverse order... Sept 

Word 6.0 or Word 95 - Shortcuts for 

opening directories or different drives. Sept 

40 

40 

49 

42 

42 
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42 

41 

41 

38 

41 
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44 
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45 

45 

47 
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43 

84 

47 

37 

82 

44 

42 

42 

44 

44 

44 

Word 6.0 or Word 95 - Using text boxes. Sept 44 

Word 7.0 - Default directory. June 43 

Word 7.0 - Setting Defaults. August 41 

Word 95 - Installing the Grammar module. July 42 

Word for Windows 95 and Word 6.0 - 

Moving items in a list. Feb 42 

Works for Windows - Converting databases 

to Access. August 42 

Works for Windows 3.0 - Missing Fonts. Oct 41 

ONLINE WORLD 

Small Business Guide.July 12 

No matter what your interest, the Online World has heaps of great 

information to help you keep informed. This month the 

Communique cybersurfers go in search of some great small- 

business advice. 

Touch base with Microsoft on the Net. August 12 

Microsoft’s own sites cater to all tastes and interests - and they’re 

compelling viewing. There's news, support, hints and tips. 

Site Builder Workshop.. Sept 12 

It's well-known now that Microsoft’s own sites cater to all tastes 

and interests. We take a look at one designed to tickle the fancy of 

Web page builders and enthusiasts alike. 

What you never knew about Internet Explorer 3.0... Oct 12 

The final version of Internet Explorer 3.0 was released in August. 

However, it doesn’t end there. There are great plug-ins available to 

enhance your browser, and they're all free! 
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Unbelievable! 
Introducing Proximo Lightbook 

the first truly portable multimedia projector. 

a tel Hi ateUNiatel HH ^ saliBUlLSl jiMJ 
cj Blinds Vertical 3 : Fl/ From Left ——j jTJ 

4 5 6 

1 Slide Sorter Presentation.pot New Slide... 1 Slide Layout... I 

ijjjfi Start | [jy Microsoft Word-Do. | Q CorelDRAW! - UNITI... ||[gj| Microsoft Power... |jg Paint Shop Pro | 

The Proximo Lightbook™ Projector is the first true 

multimedia notebook projector for on-the-road 

presentations. It's rugged enough to withstand the 

rigours of travelling, weighs just 5.2kg and easily 

fits beneath an airplane seat. 

Seeing is believing. Call B&H Australia 

on 1800 226 436 to schedule your 

demonstration or fax or post the 

coupon below for more information. 

PROXIMA 

B&H Australia - offices Australia wide - 1800 226 436 

Complete the following and return to: 

-jSk B&H Australia, Reply Paid 22, PO Box 558, St Ives NSW 2075 or Fax (02) 9878 0611 

I would like O A Demonstration [I] Product Information 

Title.First Name...Last Name. 

Position.Company. 

Address.Suburb. 

State.Postcode.Tel.Fax. 

Microsoft Pawerpoint is a product of Microsoft Corporation. Proximo is c _ ....... , _ ....  ____ _,_ _, _.... t. 
Under Government Contracts. Quality Assured to AS/NZIS09002:1994. B&H Australia is the exdusive distributor for Proximo Corporation in Australia and New Zealand. B&H Australia Ply Ltd ACN 003 376 145. 

www.bhauslralia.cx3m.au/~bho 



Most people would be horrified at the thought of robbing 

a bank, however\ many people don’t even think twice 

about using pirated software. Communique’s 

Helen Mitchell examines what piracy means, what it 

costs, and how it affects the ordinary end-user. 

softwa! 

realise 

[’ingay the illegal copy! 

count^^^^vof computer software. It 

We stealing - many people use 

jftware as a way of saving some 

Pbut the reality is that using pirated 

^are is breaking the law. 

One of the reasons many people don’t 

really consider piracy as theft is that the 

results of piracy often aren’t tangible. 

Piracy deals with intellectual property and 

copyright laws and as a result it is very 

difficult to place a monetary value on it. 

“Basically, software theft is often a 

result of a lack of understanding as to what 

intellectual property is and the fact that it 

has a significant monetary value,” says 

Tracey Maroc, Microsoft’s anti-piracy 

marketing manager. 

Who are the thieves? 
According to Maroc, there are three main 

types of consumers who pirate products. 

Firstly, there’s a large proportion of the 

population in Australia in the home, 

education and small-business market who 

unknowingly pirate software because they 

don’t understand the responsibilities of the 

end-user licence agreement. That is, they 

don’t realise they are not supposed to copy 

the software, or that when they buy a PC 

they should ask for the licence agreement 

to ensure the accompanying software has 

illegally loadec the 

s mainly of . 

re knc Wn as the^^ 

id group i 
and they’l 

fenders. They* 

the product, a 

lally au fait with intellectual 

and copyright laws, but for whatever 

reason they haven’t paid for all the licences 

they are using. 

“Those reasons can include a lack of 

management procedures, or that software 

metering and monitoring tools aren’t in 

place,” says Maroc. “What we find is that 

they’re using more software than they have 

actually paid for. So, the purchase intention 

was there to begin with, but they hadn’t 

actually paid for all of their software due to 

lack of management control.” 

Right at the other end of the spectrum 

are the outright thieves. These people 

understand there is a copyright law and 

blatantly infringe upon it. According to 

Maroc, these people are involved in hard¬ 

disk loading and counterfeit 

manufacturing, production, distribution or 

retailing, and are benefiting commercially 

from the distribution of this illegal 

software. 

How is software stolen? 
There are five basic forms of software theft 

which are against the law. 

• Counterfeiting - the illegal duplication 

and sale of software. 

• End-user copying - extra copies of an 

application made without a licence, 
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Looking For SIQPIS 
Now that you know what software piracy is, the question remains: 

How can I tell if my software has been pirated? Microsoft suggests 

that any of the following signs should arouse your suspicion. 

* The price seems ‘too good to be true’. 
* No End-User Licence Agreement (EULA) product registration 

card, Certificate of Authenticity (COA), backup disks or manuals 

are supplied. 
* You have no means of requesting back-up disks or manuals if the 

software is installed. 

* Back-up disks are of poor quality. 

* You receive no instruction manuals with your installed software, 

or you receive manuals which are photocopied or of poor quality. 

* Your installed software does not have a 20-digit Product 

Identification Number (PID). 

If you suspect that the software you 

are using is pirated, or suspect 

someone else of using or selling 

pirated software, please call the BSAA 

hotline on 1-800 021143. 

While people may be aware 
that legal action can be 
taken against those who 
steal software, they are 
often unaware of the 
following complications: 

whether within an organisation or 

amongst friends. 

• Hard-disk loading - unauthorised 

copies of software are loaded onto a 

computer before sale. 

• Bulletin board piracy (BBS) - 

copyrighted software is downloaded 

by modem from electronic bulletin 

boards without permission. 

• Software rental - software is 

illegally rented to users who then 

copy the software onto their hard 

disks. 

In Australia, the most common 

form of software theft is end-user 

copying by home-users, small 

businesses and corporations. In fact, 

it is estimated that of all the software 

used in the home market, 51 per 

cent has been pirated. Figures for 

software theft in the small business 

arena are estimated at around 55 per 

cent, while the figure for pirated 

software in the corporate sector remains t about 30 per o 

How can software theft be stopped? 
Microsoft is currently involved in educational campaigns in 

the fight against software theft. The primary aim of these 

campaigns is to help those people who aren’t aware of the 

copyright laws to equate piracy with theft. 

“There are countless talented programmers and 

developers who are having their intellectual 

property stolen,” says Maroc. It is this idea of 

intellectual property which is probably the most 

difficult to grasp. People’s ideas are valuable and 

important, whether they are creative or work- 

related. When you consider a virus on copied 

software can delete your valuable and 

irreplaceable work in the blink of an eye, it’s 

worth committing that work and ideas to original 

software. 

To combat software theft amongst business, 

Microsoft has put in place a number of initiatives. 

Microsoft has recognised that many companies 

need assistance in managing 

software and software 

compliance. Seminars on the 

issue are very popular, and 

Microsoft has also visited clients 

and looked at their software 

management procedures and 

compliance programs. 

Microsoft is also a member 

of the BSAA (Business Software 

Association of Australia). The 

BSAA is made up of member 

and associate member 

companies which represent 

more than 80 per cent of the PC 

and Macintosh software market, 

and is affiliated with the 

worldwide organisation, the 

BSA (Business Software 

Alliance). It acts as the 

watchdog for piracy, and its 

role is to decrease software 

theft in Australia through 

education, enforcement 

procedures and litigation. They 

will also pay rewards for 

information leading to the 

conviction of software thieves. 

Random Software audits are 

often conducted amongst 

companies by MIS or 

accounting staff. Tools such as 

Microsoft Systems Management Server make this process 

simple with automatic remote inventories of both hardware 

and software run from the network administrator’s desk. 

“The intellectual property of businesses in Australia is 

extremely valuable, and of course must be respected. We ask 

that, in turn, they respect our intellectual property,” says 

Maroc. S 

lem-solving 

consuming, and the cost of this soon 

outweighs the cost of the original 

software. 

• No support - if you are unable to quote 

a serial number, you will not receive 

support, if the serial number quoted has 

a duplicate, both parties will be 

investigated. 

• Viruses - Copiers rarely have any 

quality control. 

• Software companies - Like the BSAA, 

companies frequently prosecute offenders 

directly. These eases are often publicised, 

resulting in large fines and discreditation. 

• Cost - While many justify copying 

software as allaying costs, the fact is 

legitimate buyers pay for the lost sales 

through the scaling of production costs, 

which in software manufacture is 

significant. 
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Sell Smart 
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j Try Maximizer j 
risk-free! 

| Call now and get Maximizer 3.0/s | 
■ at a special price of only $295. Try ■ 
1 it for 30 days. If you don’t see * 
| bottom-line results, just return it | 
■ directly to us for a hassle-free ■ 
1 refund. To order call: _ * 

1-800 629 577 
(Fax 02 9878 6600) 

L — — — — — — — — — — J 

Gel organized, 
get customers, 
and get rich! 
Introducing Maximizer 3.0/s, the 
world’s fastest, most flexible, and 
most powerful contact management 
software. There has never been a bet¬ 
ter way to organize, simplify, auto¬ 
mate, and jump-start your entire sales 
process. Maximizer’s list-based data¬ 
base lets you search, store, share, and 
retrieve information about unlimited 
contacts faster and easier than any 
other product on the market. Built-in 
scheduling, word-processing, and ac¬ 
tion-planning features simplify your 
job. It even dials and logs calls and faxes 
automatically. 

The systematic way 
to sell, sell, sell! 

Maximizer makes the most ofyour other pro¬ 
grams by offering full support of DDE and 
OLE 2.0. Link a client record to any Windows 
object—including documents, spreadsheets, 
graphs—even photos and multimedia files. 
You never have to exit Maximizer to search 
and access a client-related file on your PC or 
network. 

Make your entire sales network 
more productive! 

Instantly networkable, 
W I Maximizer brings superior pro- 
" ^ ductivity to everyone in your 

group. Unlimited users can access 
the same data concur- 

|u pUCt rentfy—even the same 
SaVVV record and any docu- 

" ments attached to the 
record. Maximizer automatically logs the 
date, time, and user ID of every action taken. 
It even makes scheduling group meetings as 
easy as clicking a button, automatically find¬ 
ing the next free time on everyone’s calendar 

Find new prospects! 

Maximizer 3.0fc is also the world's first 
“Internet-sawy" contact manager You get 
instant access to a current, detailed, on¬ 
line database of 11 million businesses in 
North America—ideal for prospecting and 
database marketing. Plus, you can e-mail 
over the Internet and broadcast fax to 
thousands simultaneously. 

Switch today to the top rated 
contact manager hassle free! 

Maximizer 
■ ■■■>■ ft Maximizer beats ACT! 
■IMI III ^ and others in 
H)f | performance ratings. 

GOO© Maximizer 

GGG( Goldmine 

©GO ACT! 

GO Janna Contact 

■ Switch to Maximizer easily from programs 
like ACT!, Goldmine, and Lotus Organizer 
with the MaxFort import utility which comes 
free with your purchase of Maximizer 

With Maximizer, you will close more sales 
than ever before. Pile up prospects. Get twice 
as much done in a day. Dramatically improve 
customer service. Never miss another oppor¬ 
tunity. Call today! 

Maximizer 3.0 a The Secret Weapon of Today’s Sales Superstars 
Maximizer is also available at Harvey Norman, 
Software Express and other leading computer 
retailers. 

! ■■ ■ -v■ '■■■■"■■ f : \ ., : .'■» 
c. 1995 Maximizer Tfechnologies Inc. All trademarks mentioned herein are the property of their respective owners. Microsoft, Windows, and 
the Windows logo are registered trademarks of Microsoft Corporation. Novell makes no warranties with respect to this product. 





use iF 
want to surF the Net or set up 

shop on line? Jeremy Florey 
investigates the killer applications 
oF the inFormation age. 

We are entering a new age of discovery. In previous 

centuries men climbed aboard small wooden boats 

and set off across uncharted oceans to explore the 

world. They found the Americas and Australia, opening up 

new lands for settlement. 

Today we sit down in our chairs in front of a computer 

and set off to explore the new world that we have made 

ourselves: the Internet. 

The explorers like Columbus and Cook did not always 

understand what they found. Columbus was so wrong about 

the size of the world that he called the small islands he 

found in the Caribbean the West Indies. What happened to 

the Americas let alone the Pacific? 

Today we are making many of the same mistakes about 

the Internet. Even though it is man-made, we can easily 

misinterpret what the Internet does, how it works and what 

we should do with it. 

But there are guides. There are gurus who can help us. 

“The Internet is a revolution in communications that will 

change the world significantly. The Internet opens a whole 

new way to communicate with your friends and find and 

share information,” says Microsoft founder and CEO Bill 

Gates. 

“Internet usage will grow every year... I think people are 

overestimating where the Internet will be in two years but 

underestimating where it will be in 10 years,” adds Gates. 

“Microsoft is betting that the Internet will continue to 

grow in popularity until it is as mainstream as the telephone 

is today,” he said. 

The telephone is used by both individuals and 

businesses. It is a key communications tool for both. The 

phone is used to communicate between businesses and 

between individuals. 

The Internet is the same. The Internet connects business 

to business, business to customers, customers to business 

and person to person. 

Also, like the telephone the Internet works inside 

organisations. The Internets inside organisations are called 

intranets. They use the same technology as the Internet but 

restrict access to people inside the organisation.. 

This means that they can deliver all the communications 

benefits of the Internet but still be secure from outsiders. So 
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Microsoft 

an intranet can carry information that people inside 

an organisation need to know, but that they don’t 

want outsiders have any access to. 

Pulling it apart 
For the end-user the Internet is simple. End-users 

connect through their office network or through 

their service provider. Then they can browse the 

World Wide Web or send and receive e-mail or 

read newsgroups or use the Internet as a telephone 

service or use Internet Relay Chat. 

But behind this ease of use, there is some 

complex technology that makes it all work. All the 

services on the Internet are supported by 

computers known as servers. These computer 

systems store and transmit data. This data may be 

text, graphics, animations, sound or video. 

On any server, the software that services the end-users’ 

requests is called an Internet server. (We know this is 

confusing but you need to keep the distinction between the 

hardware server and the software server clear in your mind.) 

The server may keep the data in the ordinary file system of 

the computer that it is running on. 

However, increasingly, leading-edge sites are storing 

information in database management systems. An Internet 

server with a database sitting behind it can deliver 

Microsoft 
Internet Explorer 

Microsoft Explorer has all the 

features offered by any other 

Web browser available today. 

However, it also has some 

unique features that make it 

stand out in the crowd. 

Customisation: You can 

customise Internet Explorer far 

more than any other competing 

Web browser. You can change 

the options in the toolbar to suit 

your browsing needs. 

Ratings: Internet Explorer 

supports the new PICS content 

rating system. This means that 

you know the sort of page you 

are downloading even before 

you can see it. 

Conferencing: Internet Explorer 

comes with NetMeeting, a tool 

that provides for conferencing 

over the Internet. Users can talk 

to each other and at the same 

time share applications and 

graphics over the Internet. 

Security: Internet Explorer is the 

first browser to support the new 

SSL 2.0 security standards. This 

allows you to send data such as 

your credit card details over the 

Internet and be confident that 

that data is safe. 

ActiveX: .Microsoft Internet 

Explorer supports Java but also 

has its own more powerful and 

easier-to-use ActiveX. Building 

on the base of Microsoft’s 

popular Visual Basic, ActiveX 

can handle any program tasks 

from simple animation to 

complex interactive applications. 

customised data to the 

end-user. It produces 

what are called dynamic 

pages. 

For example, most of 

the search engines on 

the World Wide Web use 

databases. When you 

type in a search term, 

the system looks for all 

the relevant items and 

then sends back a 

customised Web page 

that lists those items. 

There is another 

component too. While 

you can create a Web 

page using a simple text 

editor like NotePad, 

complex Web pages are 

very difficult to create in 

such a tool. So there is 

more and more complex 

Web-page-creation 

software coming on the 

market. 

Finally of course we 

should mention the tools 

that the end-user has to 

access the Internet. 

There is the basic 

connection method - 

either a LAN or a dial-in 

- connection. There is 

also the Web browser 

(like Internet Explorer) 

that lets the user see the 

pages on the Web or 

create and send 

e-mail or read 

newsgroups. 

There are at least four 

different sorts of software that make up the Internet or an 

intranet. All these pieces need to interact smoothly for the 

whole to work properly. 

Microsoft is the only company that can offer all the 

components. As well, Microsoft can supply all the operating 

systems to run all sorts of Internet servers and databases. It 

also provides the operating systems for the end-users 

whether they are just browsing the Web or creating Web 

pages themselves. 
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ixlaPhoto is tlie ultimate 

presentation tool for your 

photos - at work or at home. 

Mlleu it comes 
to presentation, 

ixlaPhotkos 

Wall Pages 
ixlaPhoto’s 

easy-to-use, 

drag-and-drop 

techniques means there s no 

HTML programming to learn! 

It’s that simple to build 

spectacular WYSIWYG Internet 

Web Pages. 

Presentations 
Includes 

photos, audio 

commentary, 

music, slideshow effects and 

more. Distribution to others 

is easy with our exclusive 

royalty-free ixlaPhoto 

Player software. 

Photo Albums 
Create 

stunning photo 

albums using 

ixlaPhoto with 

camera, scanner or printer. 

Choose from 40+ templates, 

1000+ clip art images and 

100+ audio tracks. 

your digital 

Special Offer 
ixlaPhoto is fast, friendly 

and easy to use. It’s also 

available at a special 

introductory price of only 

$99.00 until Jan ‘97* 

Don’t delay, contact us 

now for further information. 

Also available at; 

Pacific Mierolab Computer Centres, 

City Software, Software Express. 

got; the lot. 



Microsoft Frontpage 

Putting it together 
So that we can understand 

how the Internet works 

and how Microsoft’s 

products fit with the 

Internet, let’s consider how 

a new Internet Web site is 

put together. As you will 

find, for each component 

Microsoft has a piece of 

software for the task. And 

because all these pieces 

come from the same 

source, they all work 

smoothly together to 

create an easy-to- 

implement solution. 

We will look at the 

operating system, the 

Internet server, the 

creation of Web pages and 

the linking of those Web 

pages to a database. 

However, before we 

look at all that, let’s 

consider the end-user, the 

consumer of the Web site. 

Microsoft makes both an 

operating system and a 

browser for PCs. This 

means that the browser 

works more effectively 

with Windows than any 

other browser. 

If you are already using Windows 95 or Windows NT 

Workstation 4.0 you will know that the software to make the 

connection between your PC and the Internet is built in. You 

may also know that Microsoft makes the Microsoft Internet 

Explorer browser. If you don’t have the latest version of 

Internet Explorer, you can download it free from the 

Microsoft Web site http://www.microsoft.com/ie/ 

If you are still using Windows 3.x then you won’t have 

the advantage of having a built-in software solution for 

connecting to the Internet. However, you can download a 

copy of Internet Explorer from the Microsoft site. This 

version of Explorer will work very well with Windows 3.x. 

If you are connected to the Internet through a network 

then you are probably already using Windows networking 

capabilities to make that connection. Windows 95 and 

Windows NT Workstation 4.0 have a built-in TCP/IP stack (a 

piece of software that links you to the 

Internet). You will also note that 

Microsoft Internet Explorer works over 

this network connection just as well as 

over a dial-up connection. 

Microsoft Internet Explorer 3-0 

supports all the popular extensions for 

the World Wide Web. It also has some 

unique built-in capabilities that make it 

stand out over other Web browsers. In 

addition, Internet Explorer can access 

older Internet content. It can access 

Gopher sites or download files stored 

on FTP sites. It also has its own e-mail 

and newsreader programs. 

As we go through the creation of a 

Web site we will find out more about 

why Internet Explorer is the best Web 

browser to use on the Internet. 

Building Web site 
There are lots of things that go into 

creating a Web site. It is like a jigsaw. 

All the pieces need to fit together to 

make the whole. 

Of course the first thing that you 

will need is a computer to run your 

server. All the Microsoft Internet server 

products run on Windows NT Server. 

This means that you can use any of the 

many computer systems that run 

Windows NT Server as your server. It 

also means that as your site grows you 

can add extra processing power to the 

server side without changing anything else. For example, if 

you start off with a PC that has a Pentium processor and you 

find that isn’t fast enough you can upgrade to a machine 

with two Pentium Pro processors without changing the 

software. 

If you are building an Internet site, after you have set up 

your hardware with Windows NT, you will need to provide 

a connection to the Internet. You will find that Windows NT 

gives you several options. If you need fast access, you can 

put in an ISDN connection. If you are only building a test 

server or you don’t need to support lots of users, then you 

can set up a modem connection. If a single modem is not 

enough then Windows NT will allow you to connect two 

modems and aggregate bandwidth from both modems. 

Windows NT does all this for you. You don’t have to deal 

with any of the complexities. 

The next thing you will need is an Internet server. This is 

Frontpage can handle all the tasks any 

other Web-page-creation tool can handle, 

but it also has many unique features that 

make it more powerful. 

Graphics: FrontPage imports graphics in all 

the standard formats and then converts 

them to the GIF or JPEG formats used on 

the Web. This means that you don’t need a 

separate graphics program to handle 

graphics files. FrontPage can also simply 

create image maps in all the standard 

formats. 

Forms: FrontPage comes with an easy-to- 

use forms editor. This makes it easy to 

create forms that let the user interact with 

your Web site. 

Help: And speaking of easy-to-use 

software, FrontPage comes with all sorts of 

help features built in. There are wizards to 

tutor you through unfamiliar procedures. 

There are templates that will help you 

create great-looking pages. 

WebBots: These are handy little programs 

that can do lots of useful tasks for you. For 

example, one WebBot lets you include 

users’ comments in your pages as the users 

send them to you. 

Web site management: FrontPage comes 

with a suite of tools for managing Web 

sites. These tools let you do things like 

check that all the links in your pages 

actually go somewhere. 

"At the time of writing FrontPage 97 had 

been released in beta form. 

Check out Microsoft's Web site 

(http://www.microsoftcom/)for the latest 

information. 
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the piece of software 

that actually delivers 

the data from your 

server to the 

Internet or intranet. 

Microsoft has a 

whole range of 

Internet servers. 

When you buy a copy 

of Windows NT Server 

4.0 you will get the 

Internet Information Server 

(IIS) free with the operating 

system. This server is suitable for 

on intranets or on the Internet. IIS makes use of the 

security built into Windows NT so it is secure for most 

situations. 

If you need to provide secure Internet connectivity to 

employees then you need Microsoft’s Proxy Server 

(previously code-named Catapult). This sits between the 

Internet and your corporate network and ensures that there 

is no unauthorised access to the corporate network. It also 

provides caching on Internet pages to increase 

performance. Like IIS, Proxy Server integrates with 

Windows NT. Proxy Server acts as a proxy Server to protect 

the material inside your network from hackers and any 

other unauthorised access. 

Proxy Server can also be used to allow users on an 

office LAN to access the Internet in a secure way. So for 

example you can set up Proxy Server as a secure gateway 

from your LAN to the Internet. 

Microsoft Internet Explorer is optimised to work with IIS 

and Proxy Server. These servers do of course work with 

other Web browsers, but with Internet Explorer they work 

even better. In addition, these servers support all the special 

features that you find exclusively in Internet Explorer. 

The final piece of the puzzle on the server side is the 

connection to a database management system. Microsoft has 

its own robust high-powered database management system, 

Microsoft SQL Server 6.5. SQL Server is suitable for storing 

all kinds of corporate data. It also runs on Windows NT 

Server making it easy to link up with IIS. 

You link SQL Server to your Internet server using the 

Internet Database Connector. This is built into the IIS server. 

It can take data stored in SQL Server and deliver to the Web 

server so that it can be sent out to users either on an 

intranet or over the Internet as dynamic Web pages created 

on the fly to meet users’ needs. 

This database management system also has connections 

to most other database management systems so even if you 

are currently using another database, you can use SQL 

Server to bring that data to your Web site. 

The final ingredients you need for a successful 

Web site are the Web pages themselves. These 

come from two sources: there is the material that 

you already have that is re-used from other 

sources and then there are the new pages that are 

created specifically for the Web site. 

As we have already noted you can use any data 

stored anywhere in a database to create dynamic 

pages using SQL Server and IIS. You can also use any 

of the Microsoft range of Internet Assistants to take data 

from your productivity applications and publish it on the 

Web site. What is more, these are all available free from 

Microsoft’s Web site http://www.microsoft.com/msdownload/ 

On the site you will find Internet Assistants for Microsoft 

Word, Microsoft Excel, Microsoft PowerPoint, Microsoft 

Access, and Microsoft Schedule+. All these work within the 

programs to republish their data into HTML (the format that 

Web browsers use to display Web pages). 

But if you are going to create good-looking Web pages 

that include graphics and are interactive, you will need more 

than an Internet Assistant. This is where Microsoft Frontpage 

97 comes in. This program is a full Web-publishing tool. It 

lets you lay out Web pages and see how they will look. It 

has features that make it simple to build the complex Web 

page structures like tables and frames. 

FrontPage also comes with WebBots. These provide the 

sort of functionality for your Web pages that would normally 

require an experienced programmer. They make it easy to 

develop pages that are interactive, receiving comments from 

users and publishing those comments within minutes. 

FrontPage produces Web pages for any sort of browser 

to use. However, it also has features that make it ideal as a 

tool to create Web pages for Microsoft Internet Explorer. It 

can, for example, simply embed ActiveX controls in Web 

Pages. (ActiveX is Microsoft’s programming technology that 

draws on the power of Visual Basic to make Web pages 

even more interactive.) 

A complete Solution 
Microsoft produces a complete set of applications that do 

everything you need to create complete Web sites whether 

these are running on a corporate intranet or on the Internet. 

While all the products meet the open standards for Internet 

software and so work with all the other products available 

for the Internet, they all have unique characteristics that 

make them work even better with each other. I 

Jeremy Horey is editor of the Australian Net Guide 

http://netguide.aust.com/ and managing director of Internet 

content producers, Tech Talk Australia 
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An important message 
for customers who purchased a copy of 
Windows 95 or Windows 95 Upgrade from a shop 
because of the "Free Internet Access" promotion 
V___J 

The Australian Competition and Consumer Commission 
(ACCC) has advised Microsoft of concerns that Microsoft's 
recent "Free Internet Access" promotion may have misled 
customers in breach of the Trade Practices Act 1974. 
Microsoft apologises to any consumers who may have been 
misled. 

You would know that your Windows 95 or Windows 95 
Upgrade was part of the promotion if there was a yellow 
sticker on the outside of the box containing the words 
"Free Internet Access" like the one displayed on this page. 

One of the conditions was that the product had to be 
purchased before 30 September 1996 to qualify for the free 
offer. Another condition was that a current Visa or 
MasterCard was required. 

The ACCC has pointed out that because of the design of 
the label you may not have been aware of these conditions. 
Microsoft is therefore willing to permit any purchaser of 

Windows 95 or Windows 95 Upgrade which displayed the 
"Free Internet Access" sticker to register for the 20 hours 
free access provided the product was purchased prior to 31 
December 1996: 

• Irrespective of whether or not purchasers hold a current 
Visa or MasterCard; and 
• Irrespective of the purchase date. 

If you see any shops selling Windows 95 with the 
stickers still on them, please let us know as these 
should have been removed at the end of September. 

How do I claim my 20 hours free? 
• You must have purchased Windows 95 or 
Windows 95 upgrade. 
• It must have the yellow sticker attached. 

You must follow the instructions on the yellow sticker to 
register before 31 December 1996. If you do not want to use 
a Visa or MasterCard you should contact On Australia direct 
on 
1 800 804 282. 

Once you have completed the instructions you are 
automatically connected and your 20 hours begins. 

If you have any questions please call Carrie Mayhew on 
1 800 247 756. 

Free 
Internet 
Access 

20 hours of free 
Internet access when 
you buy this copy of 
Windows® 95* 
* Conditions apply, telephone 
charges not included. 

Microsoft 
| WHERE DO YOU WANT TO SO T0DAY?~~ 
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Ooowooloo 
This is the second year we’ve 

run the Communique Science- 

Fiction competition and, tike 

last year, it attracted dozens 

of quality entries. Our judging 

panel was put to the test, but 

in the end Simon Haynes’ 

story won. Simon wins nine 

Microsoft games for Windows 

95 - including Close Combat, 

Golf, Flight Simulator, NBA Full 

Court Press, Hell Bender and 

many more - worth more than 

$700. 

inhabitants. Then we would be able to disintegrate your planet and extract the sand.” 

“What?” shouted the ambassador. “You expect to buy the whole planet, then cart it 

away in...in... galactic dump-trucks!” 

The alien looked surprised. “I thought that was how this civilisation worked - you pay 

people to leave their homes so you can dig up the ground they lived on and sell it for 

profit. We’re offering you the same deal, but on a larger scale.” 

“You don’t understand,” spluttered the ambassador, “there’s nothing you could offer the 

people on this planet that would entice them to leave their homes.” 

“What about a cure for every known disease?” said the alien. 

The ambassador stared. 

“What about an extra fifty or hundred years on your average lifespan?” asked the alien. 

“I -1 stuttered the ambassador. 

“How many years have you got left?" asked the alien. “Ten? Five? Two? We can give 

“ you another fifty,” he said firmly. “Now, how long do you need to talk to your people?” 

j The first ever global referendum took place on October 2nd, 2002. The Yes and No 

£ votes from every country would be added into a global tally, and the result would 

o determine the history of mankind. The choice was simple: you could vote to stay on Earth, 

J or you could be transported to an Earth-like planet and be given another 100 years of 

m disease-free life. 

| Results were to be made public by 8am on the 3rd of October. There were delays as 

i the final counts from several European countries were uploaded to the wrong FTP site, but 

" after a hurried search of two or three million computers the missing figures were unearthed 

I and added to the global tally computer. 

m After 48 hours of solid media hype the moment arrived. A group of computer 

1 programmers parted to allow the President of the World Council access to the workstation 

g which had been set up in the auditorium. He walked to the desk, and spoke briefly to the 

head programmer, a confident-looking young man in a white lab coat. The programmer 

d demonstrated with a few swift movements how the mouse moved the pointer around the 

By Simon Haynes 

Ambassador Richards stared at the alien in disbelief. “Sand?” 

“But yes, ooowooloo, or ‘sand’, is most precious to us,” said the alien, 

via its translator. “We need it most desperately, and your planet has 

such an abundance.” 

“Well, this is most irregular,” said the ambassador, who was not used to 

acting as a salesman. “How much, er, ooowooloo do you need?” he asked. 

The alien giggled. “Not ooowooloo, ooowooloo,” it said. “Ooowooloo is 

what you use on your roses. We have as much of that to spare on our planet 

as you do on yours.” 

The ambassador reddened. “How much sand do you require?” he asked. 

The alien looked around. “Well, first we would have to discuss the 

relocation of your plant and animal species. And of course, the human 
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screen. He pointed to the left mouse button, then to a large, 

blue box drawn on the screen. Around the world, viewers 

saw an inset of the computer screen appear in the lower 

half of their TV picture. Everyone could read the writing on 

the box: “CALCULATE RESULT”. 

The cameras zoomed in tight as the President of the 

World Council guided the mouse pointer towards the button, 

there was a long-drawn-out second before the mouse-click 

echoed through every loudspeaker on the planet. 

There was a delay of around three seconds during which 

eight billion people held their breath, then the computer 

buzzed and a dialog box popped up on the screen, with the 

message “Runtime Error 11 - Division by zero”. 

Hundreds of anchors around the world hurriedly threw 

to commercial breaks while computer experts 

analysed the error log on the tally 

computer. After a moment or two, the 

cameras zoomed in on an embarrassed- 

looking head programmer. He cleared 

his throat, and addressed eight billion 

people. 

“Uh, sorry about this. Our program 

halted while attempting to calculate the 

percentage of Yes and No votes. I, er, have 

announce that the total of the Yes vote is exactly 

the same as the, er, No vote. It’s, er, a draw. 

“Surely there must be a way of resolving the deadlock?” 

asked the alien. 

“We could hold another vote,” said the ambassador. 

“No, no we don’t have time. In fact, we’ve got another 

planet to look at just two parsecs from here. Our survey of 

‘01 showed promising data,” said the alien. “Not as good as 

your planet, though,” he added with a sigh. 

The ambassador looked at the floor. 

The alien cleared his throat. “On my planet, when we 

have to reach a decision, we commonly use a disc of metal 

which has a different design on each side. We assign a true 

value to one side and a false value to the other, then throw 

it into the air. The face which is uppermost when the disc 

comes to rest then gives us a true or false result.” 

The ambassador looked up and stared at the alien. “If 

you think I’m going to toss a coin to decide the fate of 

mankind, you’ve got another thought coming,” he said 

firmly. 

The phone on the ambassador’s desk purred gently. He 

reached over and lifted the receiver. After listening for a 

moment, he hung up. 

“What’s happening?” asked the alien. 

“They’ve found a deciding vote. Come along,” said the 

ambassador, and he whisked the alien out of the office. 

At the hospital a cordon of soldiers parted to allow the 

ambassador and the alien through the main doors, then 

quickly closed ranks against the throng of press and 

television people. Once inside, the human and the alien 

were rushed along the deserted corridors by a sergeant- 

major in combat fatigues. 

“Where is everybody?” asked the alien. 

“They’ve all been moved into another ward,” said the 

ambassador shortly. 

The alien raised all three eyebrows, but said nothing. 

Still at the same pace, the trio rushed down one corridor 

after another. The sergeant-major stopped suddenly in front 

of a plain door, and knocked. There was a response from 

inside, and the sergeant-major opened the door then stood 

aside to let the other two in. 

As the pair entered the room two people looked up. The 

first was a priest, dressed in a black cassock. He frowned at 

the intruders, and set aside his Bible. The other was a lady 

of around thirty. She was also dressed in black, and was 

clasping a damp-looking handkerchief in her hands. 

“Is this really necessary?” began the priest. 

“You know it is,” said the ambassador. He 

looked at the young lady. “I’m sorry, my 

dear, but you must realise how important 

this is. Now that you grandfather is 

conscious he must be allowed to vote.” 

The young lady nodded, her eyes 

bright with tears. There was a wheezing 

noise from the bed and everyone turned to 

look. All that was visible of the man in the bed 

was a pale wrinkled face, most of which was 

covered with an oxygen mask. The man’s eyes were closed, 

and his blue-veined hands were lying motionless on top of 

the sheets. 

“Grandad,” said the girl softly. She leaned forwards and 

squeezed one of his hands. The old man’s eyelids flickered, 

then opened. His eyes turned slowly until they focussed on 

the young lady, and the ambassador hears a wheezing 

croak. 

“Grandad, these people want you to vote. You know, I 

told you earlier. Whether we should stay here or move and 

live for another hundred years with no sickness or disease,” 

she said. 

The old man’s eyes moved back slowly to look at the 

ambassador, then at the alien standing beside him. Then he 

turned his head slowly so that he was looking out of the 

window into the hospital garden. All eyes followed. 

There was nothing much to see through the window, 

except a bush which was planted just outside. Everyone 

turned to look at the old man again. He lifted one shaking 

hand and pointed a crooked finger at the window. The 

ambassador looked at the bush again, and was just about to 

turn away when a movement caught his eye. He realised he 

was looking at a tiny bird which was perched on a frail¬ 

looking collection of twigs and scraps of fluff. As he 

watched, it moved its head again and blinked. 

The ambassador heard a noise, and glanced at the bed. 

There was a smile on the old man’s face, just visible under 

the oxygen mask, and his rheumy eyes were moist. His 

mouth moved, but all the ambassador heard was a murmur. 

Leaning closer, he just heard the old man whisper, “This is 

our home”. M 
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The challenge is 

on again! Be in 

the running for 

some great prizes 

by having a go at 

our Christmas 

Comps. 

Send your entries to Microsoft 
Communique 
115 Alexander St, Crows Nest 
NSW 2065, by January 24, 
1997, clearly marking which 
competition you are entering. 
You may of course enter as 
many competitions and as 
many times as you like. 

For a copy of Cinemania 97 for Windows 95, Monster Truck 

Madness for Windows 95 and a Sidewinder Game Pad. 

Now that the personal computer is a fully matured member 

of the family, it's only right that it should be allowed to have 

a say in household matters. In no more than 150 words put 

a list of requests, a 

catalogue of demands, a log 

of claims even, from your PC 

to its masters/mistresses. 

Address this letter or e-mail 

“Dear Family Council...” 

There may be complaints 

that far too many games are 

being played, or perhaps 

even not enough. And what 

about that same old screen 

saver when everyone else is 

watching Tarantino? 

Jnnn 
For a copy of Encarta 97 for Windows 95, 

Encarta 97 World Atlas for Windows 95 and a 

Natural Keyboard. 

With the world of computers turning up something 

new every day, future predictions have become a 

popular pastime and a serious business. Crystal 

balls, ducks' entrails, unnatural natural 

phenomena, all tried and true methods of 

divination are back in service. Whether it be in 

the international sphere or in the 

humble confines of your own 

linen cupboard, we invite you to 

contribute your prediction for the 

future. The quaintest or the most 

colourful suggestion will earn the 

title of The Communique Oracle. 

For a copy of Publisher 97 for Windows 95, Money 

97 for Windows 95 and a Natural Keyboard. 

News in brief columns often have pithy little tales 

of extraordinary, uncanny incidents frequently in 

sleepy little places. Provide a brief (up to 150 

words) newspaper account with one of the 

For a copy of Flight Simulator for following headlines: "Computer Chaos", 

Windows 95, NBA Full Court “Computer Conman”, or “Computer Confession”. 
Press for Windows 95 and a 

Sidewinder Game Pad. An “abecedary” is a fun alphabet tale with each of its 

lines beginning with successive letters of the alphabet. Addressing any subject 

of your choice, and rhyming or not as the case may be, pen an abecedary that 

includes five names of Microsoft products . It may be heroic and conclude with 

Zeus..., homely and finish with Zucchini..., or a lullaby ending with, of course, 

77777777. X may be represented by a word starting with ‘Ex’. 

For a copy of Deadly Tide for Windows 95, Hellbender for Windows 95 and a 

Sidewinder Game Pad. 

With the second Annual Communique Science Fiction Competition having just 

drawn to a successful close, and everyone's engines operating in fantasy 

mode, we think the time is ripe to turn all minds to the subject of murder. 

In no more than 150 words, follow on from the following sentence, naming 

the case after a Microsoft product. 

“This strange case was named the “XXXX XXXX” affair. The corpse 

lay....’’Don’t forget to include a computer in your hair-raising scenario. 
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What was your first encounter with 
technology? 

A heated toilet seat - it was the middle 
of winter in Japan and I remember 

having to get up to go to the loo. I was 
bracing myself for that cold shock on 

my bare bottom - to my surprise, it was 

quite the opposite! I could have stayed 
perched on the toilet all night. 

Who do you let use your PC? 

No-one! As a child, I never really 
grasped the concept of sharing. 

How, if at all, has using technology 

changed the way you work? 

My boss no longer riddicools me for my 
dislexeea - he just says, “Bad computa, 
bad computa”. 

our, 
Kim Watkins, the Nine 

Network’s roving reporter on 

the show, Money, takes time 

out this month to reflect on 

money 
tra 

or your 

PC 

If you had an Internet alias what would 

it be? 

“bill_gates_alias//kim_watkins@money.ni 

nenet//bank_accounts_details. com .au ” - 
and maybe, just 

maybe some of his 
billions would be 

transferred into my bank 
account! 

Been surfing lately? 
Yes, I love the home page on how to be 

a terrorist - I’m sure the A-Z guide of 
bombs, semi-automatic machine guns 
and chemical weapons will come in 
handy when I renegotiate my contract. 

What is your most treasured possession? 

My battery operated cat! It purrs, 
miaows, and sits quietly on my lap. It’s 
perfect for when my real cat Basil has 

an attitude. 

*Money can be seen on the Nine Network on 

Describe your happiest techo moment. 

When I bought my first remote control 
(or “wands of power” - as I prefer to 
call them). It gives me a great sense of 

control when I can sit back on the 

lounge and give orders to my 
appliances. 

What was your most miserable moment 
with your PC? 

Discovering that ‘RAMS’ weren’t no-frills 

home loans. 

Does your PC have a name? 

You rotten bastard - “bast” for short. 
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Corporate 
pun 
Elliot Goblet, veteran of well over 

500 live corporate presentations, 

comic and now author, has written 

his first humorous business book. 

Called Business According to Goblet, 

new creation contains good business 

sense heavily coated with good 

business non-sense, much like his 

relationship with his PC... 

What was your first encounter with 

technology? 

My cot was made entirely out of silicon 
chips. It was a very advanced prototype 
cot, but as we all know now the silicon 

chip never did take off. 

Who do you let use your PC? 

When it comes to using my PC, 

everyone is welcome to it. I strongly 
believe in sharing, especially with those 
less fortunate souls who just don’t have 

any data of their own. 

How, if at all, has using technology 
changed the way you work? 
When I do my accounts it now takes 
longer, because I believe in checking 
everything manually. 

Describe your happiest techo moment. 

Discovering a gold nugget at the back of 
my PC. 

What was your most miserable moment 
with your PC? 

Realising the above gold nugget was the 
product of some back-of-the-computer 
gold-nuggets-counterfeiting racket. 

Does your PC 
have a name? 

What is it? 

Yes, my PC is called 
“The Prince of Wales 

Hotel”. I wanted a name 
that hadn’t been used for a 
PC before. 

If you had an Internet alias what 
would it be? 

One song. 

Been surfing lately? 

No, but now that I’ve finished my book I 
can make up for lost time. And thinking 
about the Internet makes me go 
internally berserk. 

What is your most treasured possession? 

Apart from my 1928 mint condition ball 
of string, I’ve just installed a reverse- 
cycle spa because I like the thrill of 
being sucked into the jets. 

*Elliot Goblet’s book, Business According to 

Goblet, is available now and is published by 

HarperBusiness, an imprint of HarperCollins 

Publishers Australia. 
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At Studied lip 
Maximum 
Infotainment 
with Max Walker 
CD ROM “Get a gj%> on your bat handle and take block on the all new 

techno-wicket. There is a very real possibility you’ll be 
“All Stitched Up” by my interactive, infotainment CD ROM. 

“Very different... it contains many hours of entertainment 
based on hilarious anecdotes, my engaging board game 
and indepth insights into the fascinating history of cricket. 
Load it up and you will find at your fingertips a high level of 
interactivity, memorable video, stats, personal photographs, 
animation, audio, trivia, dilemmas, and hidden surprises. 
Created with a sense of fun... you’ll find yourself coming 
back time after timer * 1 

Excerpts and outtakes from some of Max’s funniest video 
nts. 

A revealing interview with David Hookes. 
Over 48 minutes of video including famous archival footage 
of greats such as the Don. 
Complete stats on over 2000 cricketers. 
The electronic version of the bestselling “Take It To The 
Max” board game. 
And much morel Over 600Mb of info and entertainment! 

Max Walker’s 
“All Stitched Up” 
Interactive CD ROM 

We’re on the Web! 

http://www.harvey- 

norman.com.au 
Harvey Norman 
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kicls. The 

Nickelodeon 

channel has 

some really cool 

shows like ‘The Ren and 

Stimpy Show’ and ‘Aaahh!!! Real Monsters’, 

as well as ‘Rugrats’ and the ‘Curiosity 

Show’. You can catch all these shows and 

more on Nickelodeon through Galaxy’s 

satellite service and Foxtel’s cable TV 

service. 

Everything you need to make a 3D 

movie has been included in Nickelodeon 

3D Movie Maker, and you have complete 

artistic control. You’ll have 12 movie 

locations to choose from, with sets 

featuring 10 camera angles each that are 

easily selected with the click of a mouse. 

You can cast any of the 12 characters 

(among whom are the cast of ‘The Ren 

and Stimpy Show’, ‘Aaahh!!! Real Monsters’ 

and ‘Rocko’s Modern Life) who have more 

than five different motions each, and 

whose facial expressions can be changed. 

Controlling the movements of each of the 

characters is a snap. All you need to do 

drag the characters with your mouse. This 

is the same type of technology used to 

create the special effects for Hollywood 

films such as The Mask, Jurassic Park and 

Jumanji. 

You can make the characters shrink, 

stretch and, in some cases, dance (this was 

a favourite with the crew here at Kids’ 

Communique). Making movies has never 

been so much fun! 

Cool sound effects and music and 

dialogue are provided, but you can also 

record your own voice, if you really want 

to get extra-creative with sound effects and 

dialogue. In addition, there are some pretty 

powerful special effects that really add 

Here’s your 

chance to make 

your own 3D movie 

with Microsoft’s nifty 

masterpiece maker, 

Nickelodeon 3D Movie Maker. 

You get your own actors, studio 

and special effects! If you’ve 

ever yearned to say the magic 

words, “Lights, camera, 

action!”, then this is for you. 

| ickelodeon 3D Movie Maker is 

I Ml the second product in the 

J Microsoft 3D Movie Maker 

^ line-up. It enables you to 

create your own 3D animated movies using 

characters from the line-up of kids cable. 

TV channel Nickelodeon. 

Nickelodeon is the only cable and 

satellite channel exclusively dedicated to 
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Goosebumps: Escape from Horrorland and Neverhood 
SM; 

some oomph to the movie and make it 

come alive. And to help you perfect your 

movie, Stick Stickley, your Nickelodeon 

3D Movie Maker host, is always on hand 

to help. 

Nickelodeon 3D Movie Maker is 

available now with an ERP of $59. 

http://nickoz.com 

Nickelodeon now has its very own 

space on the Internet, the Nickelodeon 

Online Trcehouse. Designed by 

Nickelodeon Australia, its been created 

exclusively for kids and features a 

collection of interactive activities and 

games guaranteed-#) keep you glued 

to your PC. do some 

exploring, connect with other kids 

and, of course, check out what’s 

happening on Nickelodeon. 

When you get to the site you’ll find a 

collection of cubby.hduses in a gum 

tree including ‘The Kids Only 

Clubhouse’, where'you can sound off 

about different topics on the 

switchboard, vote and see who’s been 

sending pictures to the Art Wall. ‘The 

I-tmhou.se’ is where you can download 

a comic and a computer game or two, 

'Nick Central’ is the place to go to 

check out a monthly list of all the 

shows on Nickelodeon or download 

short clips of Nick shows, and 'The 

Winged Thing’ is where to go when 

you want to fly off and travel the 

world. 

To check out the Nickelodeon Online , 

TreehcJuse, go to http://nickoz.com 
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Creepy, Kooky 
sius Mts off ffm 
Check out these hot new titles that 
take CD-Rom games to the next level 

park 

oosebumps: Escape 

•V^ from Horrorland and 

The Neverhood are two 

brand new CD-ROM titles 

which have been released by 

Microsoft. Goosebumps is a deliciously 

scary game where you have to escape 

from Horrorland, and The Neverhood is 

an amazing, original animated clay 

adventure. 

Both^l these titles Jaave been 

developed by Dream^^kg Interactive, 

The st 

of all In the Goosebumps adventure, you are 

trapped in the Horrorland theme park, 

with Lizzy, Luke and Clay. You have to 

figure out how to escape! But don’t 

worry, we ll give you a few pointers. 

To move through the park and 

explore each location, point and click 

with your mouse. The cursor tells you 

where you can walk or look. Some 

objects are collectible so click on them 

to pick them up. If you want to take the 

object with you, move the cursor to the 

bottom of the screen and store it in your 

little pack. 

It’s really important to keep tabs on 

Lizzy. She’s a little uncontrollable and 

excitable, but she has clues to help 

guide you through Horrorland and 

escape the monsters of the park (who 

are pretty frightening). If you get stuck 

at all, the Riddle Wall may 

: h i \ v a due to help \ t m 

That’s you in the big fape' 

the wall just off the centre of 

Werewolf Village (you’ll see 

eyes glow when you move the cursor 

over them). 

Now it's really important that 

explore all the areas and take noticg 

anything interesting - it may be <1 

later. The Werewolf Vill^e shops 

t where you first 

” " H 

l game made 

entirely 1 n >m i Lt\ so vou <. an 111st 

imagine how cool it looks. In fact, it 

took three tons of day to make! That’s 

roughly as : 11e.i\ \ a s t w < >; n u. dtu m m/eii 
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Kid* 
extraordinary 

machines and mysterious artifacts. Long ago. 

the king of this world was betrayed by his 

trusted (but apparently evil) assistant. 

It’s now up to you to save the The 

Neverhood by guiding Klaymen past pitfalls 

and through twisting hallways and trapdoors 

'to defeat the evil monster Klogg. You can 

explore the secret places and hidden objects, 

and follow all sorts of obscure (and not so 

obscure) clues to help you answer the 

puzzles on your way to solving the quest. 

If you get stuck, Willie Trombone may 

have a clue to help you in one of his letters. 

For example, you could descend the ladder 

Wdeo woven seamlessly I! 

the game. This means the actions are 

smooth as you watch and play the game. 

To play the game, all you need to do is 

point and click the mouse on the screen, so 

you don’t need to worry about learning any 

keyboard commands. ■ 
Goosebumps: Escape from Horrorland, 

and The Neverhood are available now with 

an ERP of $59 for Goosebumps and $79 for 

the Neverhood. 
Lisa Bonfanti 

We have come to the conclusion that there are some pretty 

talented artists-in-the-making here at Kids’ Communique. 

In our September issue of Communique, we asked you to 

colour in a scene from Koi and the Kola Nuts! The entries were 

so overwhelming we decided we had to have two winners. 

Lisa Bonfanti (6) of Wakeley NSW, impressed us with her bright 

fluorescent sky and colourful trees. 

Angela Ferraro (9) of Mill Park Vic, sent in a meticulously 

coloured entry with a particularly groovy purple and orange 

colour scheme happening here. 
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We a[s<> asked you to mite us 

atjfit'PPm8 ta,e- 0ur Winner of 
this competition is Sravan 
Chunduru, who wrote about a 
particularly engaging ^ * 

investigative story. 
Here ,s the winning story: 

Tk:£ z/ldVtfitvrts ©/ 

Tt©tn«©n: and ill© tflf #©!$•• 

t>ht tvrifi &€t$GtiY€S, 

One day, the Thompson’s went to the 

Old Street Market to buy a dew 

walking stick after they fell down the 

stairs in their apartment. They saw Tintin 

at the antique stall. 

“Hello there Tintin,” they both said. 

“Hello! "What are you doing here?” 

replied Tintin. 

“We are here to buy a walking stick,” 

said Thompson. 

“To be precise, we are here to walking 

a buy stick,” said Thomson. They went 

over to another stall and bought eight 

walking sticks! 

“Seven pounds,” said the stall keeper. 

Mr Thomson’s wallet was stolen! “Great 

Scodand Yard, my wallet is stolen!” 

“Mine’s stolen too,” said Thompson. 

“Here, let me pay for them,” said Tintin. 

“Thanks,” said both of them. 

The Thompson’s went back to their 

apartment immediately. They were 

listening to the radio and heard, “Europe’s 

largest and most expensive diamond was 

stolen from the Museum of London”. 

“This looks like a case for the 

Thompsons!” they both said and set out 

for the museum. They interviewed the 

director of the museum who said, “I went 

down to see if the diamond was still there 

but it was gone,” and then burst into tears. 

Meanwhile, the Thompsons looked for 

clues. They used some talcum powder to 

see if there were any fingerprints. They 

saw a fingerprint. “I say, my dear 

Thomson, we are in luck.” They went to 

the records office and looked in the 

fingerprint record books. “Aristides Silk, 

eh? His address is three Eucalyptus 

Avenue. Let’s go!” 

They rushed to his flat, but he was not 

in. The landlady said, “He has gone to 

Cairo in Egypt. He went by ship.” The 

land lady gave them a photo of Aristides 

Silk, and they booked a plane for Cairo 

the next day. 

When they landed at Cairo International 

Airport, Thompson said, “I say, Thomson, 

let’s start looking for him in the hotels.” 

First, they started with the Hotel Silk. 

“We are looking for Aristides Silk,” the 

Thompsons said. 

“Aristides Silk is out at the moment. He 

will be back in a few hours. There is a 

room vacant next to his. Would you like 

to stay in it?” said the clerk? 

The Thompsons said yes, went into their 

room, unpacked their things and went to 

the police station. “We are police officers 

who are from Europe and we want a 

warrant to arrest a dangerous criminal 

who is staying in the Hotel Silk,” they said 

to the general. The general gave them a 

warrant for Aristides Silk. 

When they went back, they saw a 

person enter the room. The looked at the 

photos of Aristides Silk. “That’s him all 

right! Let’s arrest him,” they said. 

They knocked on the door of Aristides’ 

room and said, We arrest you in the name 

of the law!” the Thompsons said. Then 

they looked in his luggage and found the 

stolen diamond and their wallets. “Can 

you explain this?” Thomson asked. The 

next day they look Aristides back to 

Marlinshire and the diamond was restored 

in the museum.■ 
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Word 6.0 - Using columns 

DEAR WIZARD 

When you create a 

document with two 

columns, how can you get straight 

across to the right column without 

filling up the left column with text or 

Return characters? 

We know that if you type the text 

first and then separate it into 

columns you can use the mouse to 

click into either the left or right 

column. 

The Wizard Replies: 

A simple workaround is to use an 

AutoText entry (with one special 

enhancement) rather than typing the 

name of the town. 

To do this follow the steps below: 

tricky - But not 

when the Wlz 

shows you how 

® Type the name Kurri Kurri. 

0 Highlight it, then from the Tools 

menu choose Language, as shown in 

Figure 1. 

© Select the (no proofing) option 

from the top of the list, then choose 

OK. 

Belinda Church, 

Townsville, Qld. 

The Wizard replies: 

The reason you can’t click in the 

right column when you first create 

two columns in a blank document is 

that Word doesn’t know where the 

first column should end and the next 

column start. 

If you don’t want to type any text in 

the first column, simply hold down 

CTRL + SHIFT + ENTER (COMMAND A 

+ SHIFT +RETURN on the Mac) and 

the cursor will immediately he mured 

to the top of the right-hand column. 

Word 95 - Problems with 
repeated words 

DEAR WIZARD 

I regularly use Word 95 to 

™ type out lists of people from 

various suburbs/towns in the Hunter 

Valley. One town that causes 

probtems is Kurri Kurri. 

Clicking the right mouse button 

reveals only Delete Repeated Word, 

Ignore and Spelling, but not ADD 

word. 

Is there any way that I can remedy 

this problem. Here in Australia there 

are other towns with the same 

problem, such as Wagga Wagga. 

Lindsay Paterson, 

Rankin Park, NSW. 

O From the Edit menu choose 

AutoText, type kk as the shortcut, 

then choose OK. 

Now, whenever you need to type 

Kurri Kurri simply type kk, then press 

F3- You can also create AutoText 

entries for other towns mch as 

Wagga Wagga and Woy Woy. 

Access - Drop-down lists 

DEAR WIZARD 

On a form in a Microsoft 

Access database I want to 

have two drop-down boxes. The 

first would contain seven options. 

The second drop box would offer a 

range of options which would be 

different for each of the seven 

options in the first drop box. 

For instance, selecting the first 

option in the first drop box would 

mean that I was given ‘option range 

1’ in the second drop box. But if I 

chose the second option in the first 

drop box then I would be presented 

Figure O 

with ‘option range 2’ in the second 

drop box. 

Can this be done? If so how? 

Adam Furphy, 

Melbourne, Vic. 

The Wizard Replies: 

A number of people have written in 

with similar queries lately, and there 

are one or two tricks that you need 

to know about if you want to 

implement this professionally. 

What you’re going to do is create a 

small database that contains some 

towns and their States. You’re going 

to select a State from one drop-down 

list and then, depending on which 

State you’ve selected, select from a 

list of towns. 

Follow these steps: 

O Start Access 7.0 for Windows 95 

and create a blank database with 

the name Test. 

© Select the Tables tab, choose New, 

then choose Design View and then 

OK. 

© Create two Text fields called State 

and Town, then close the Table 

Design view. 

You’ll be asked if you want to save 

this table. 

© Choose Yes, then enter the name 

Trial Data for the table name, then 

choose OK. 

You’ll be asked if you want to create 

a primary key. 

© Choose No. 

© Select the Open button, then 
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enter the following data. 

NSW Sydney 

Vic Melbourne 

Tas Hobart 

NSW Bathurst 

NSW Lithgow 

Vic Bendigo 

Tas Swansea 

© Close the table. 

You ’re now going to create a form 

with two combo boxes. The first drop 

down list will display a list of States 

and the second will display a list of 

towns in the selected State. 

© Select the Forms tab and then 

select New. 

The New Form dialog is displayed, 

o Choose Design View, then choose 

OK. 

A blank form is displayed. Make sure 

that the Toolbox is also displayed. 

© Click on the Combo Box button 

and drag a control on the form. 

The Combo Box Wizard is displayed, 

as in Figure 2. 

© Choose the first option on this 

screen since you want to look up the 

values in a table. 

© Choose Next. 

© Select the Trial Data table and 

then choose Next. Figure © 

The next Wizard screen is 

displayed and the two fields in the 

table are listed. 

© Transfer the State field to the 

Selected Fields column and then 

choose Next. 

© Choose Next for a second time 

and then choose Finish. 

A drop-down list appears on your 

form. You are now going to test 

this. 

© From the View menu choose 

Form. 

© Click on the drop-down arrow 

next to the field. 

A list of States should be displayed. 

If the list does not appear repeat the 

steps above. You’re now going to 

put a second combo box control on 

your form. 

© From the View menu choose 

Form Design. 

© Click on the Combo Box control, 

then drag a control under the 

existing one. 

The Combo Box Wizard is displayed 

again. 

© Choose the first option on this 

screen as you want to look up the 

values in a table. 

© Choose Next. 

© Select the Trial Data table and 

then choose Next. 

The next Wizard screen is displayed 

and the two fields in the table are 

listed. 

© Transfer the Town field to the 

Selected Fields column and then 

choose Next. 

© Choose Next for a second time 

and then choose Finish. 

A second drop-down list appears on 

your form. 

© From the View menu choose 

Form. 

© Select Tas from the State drop¬ 

down list. Now click on the Town 

drop-down. 

You’ll see all the towns displayed, 

not just those from Tasmania. 

© Close the form and give it the 

name List Test. 

Modifying the query 
Obviously, the values in the second 

list need to be based on the State 

selected from the first list. To do this 

you’re going to modify the query 

that was created by the Wizard that 

created the drop-down list. 

© Select the Forms tab, then choose 

Design. 

0 Right-click on the first drop-down 

list, choose Properties then change the 

Name field to State. 

You’ve done this because you need to 

refer to this list in your query. 

0 Right-click on the second drop¬ 

down list. Change the Name field to 

Town. 

The Properties window is still 

displayed. Notice that there is an ‘SQL’ 

query in the Row Source field. This 

was created by the Wizard. 

© Click in this field, then click on 

the Build button (the one with three 

dots). 

You’re taken to the SQL Query Builder 

window as in Figure 3- 

© Drag the State field into the 

second column. 

0 Click in the Criteria field for the 

State column and type the following: 

[Forms]![List Test]![State] 

© Close the window. 

You’re asked if you want to save the 

changes. 

O Choose Yes. 

0 From the View menu choose Form. 

You can now select a State from the 

first list and only the towns for that 

State will be displayed in the second 

list. 

Tidying up 

There are two main problems here. 

The first is that the values in the town 

list don’t change when you select a 

new State from the first list. The 

second is that the former choice 

of your software. 

Don’t be afraid to 
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remains in the second combo box. 

You ’re going to use some Visual Basic Uake sure t0 tidy up 

code to fix the problem. those ,0Qse emfe 

O Prom the View menu choose Form 

Design. 

0 Right -click on the State control 

and then choose Properties. 

0 Scroll down until you find the 

After Update property, then click in 

this field and then click on the Build 

button. 

A dialog box is displayed with three 

choices. 

© Choose Code Builder, then choose 

OK. 

© Type the following code: 

Me![Town].Requery 

Me![Town] = Null 

The first line says that after you 

change the State (i.e. after you update 

the first list) you want to force a 

requery on the Town list. The second 

line asks for the value being displayed 

in the Town field to be set to Null. The 

reason you need to do this is that 

otherwise you could select a new State 

but the old town would still be 

displayed in the second field. 

The screen should look like Figure 4. 

© Close this window and then from 

the View menu choose Form. 

Now when you choose a State the 

second list only displays the towns in 

the selected State. 

Further tidying up 
Finally, you are going to tidy up a 

couple of other loose ends such as the 

repeated towns in the list and the 

order the towns appear. 

© From the View menu choose Form 

Design. 

© Click on the State combo box, 

then right click on it and choose 

Properties. 

© Click in the Row Source field, 

then click on the Build button (the 

button with three dots). 

The Query by Example grid appears. 

© In the Sort field for State choose 

Ascending. 

© Choose the Properties for the grid, 

then set Unique Values to Yes. 

© Close the grid, then choose Yes to 

save the changes. 

Now view the Form and notice the 

list appears in alphabetical order of 

State and each State only appears 

once. 

Project 4.0 & 95 - 
Changing Gantt Chart 
appearance 
DEAR WIZARD ♦ A I have been using 

^ Project 4.0 for 

three months now and I’m very 

happy with the product except for 

one thing. I don’t want to display my 

baseline graphically, however I do 

want to be able to see if an 

unstarted task is slipping relative to 

the baseline. 

Is there any way I can show this as 

a line on the Gantt Chart? 

Verity Charles, 

Doncaster, Vic. 

The Wizard Replies: 

You can display this provided that 

you have set your baseline. To do 

this you need to edit the Bar Styles. 

Remember that if you choose Bar it 

only changes the style for the bar or 

bars that you currently have selected. 

O From the Format menu choose 

Bar Styles. 

0 Click on Milestone, say, and click 

on Insert Row. 

A blank row is displayed. 

© Type Slipping in the first column. 

© Click in the Appearance column 

and then from the Middle Bar 

group, select the last thin line 

option from the Shape drop¬ 

down list. 

© Select a suitable colour. 

© In the Show For... Tasks 

column choose Normal. 

© In the From column choose 

Baseline Start and in the To 

column choose Start. 

Remember that there’s a drop¬ 

down list to the right of the Entry 

Bar where you can choose these. 

Your dialog box should look like 

the one shown in Figure 5. 

Choose OK. 

Now all tasks that are 

slipping will display a thin line 

at the start of the task. 

Ask our very 
own code 
sourcerer to 
wave the wand 
and bring light where there is darkness. 
If you’re bothered by Basic, exasperated 
by Excel or wound up by Word, Ask the 
Wiz. Send your problems to: 

The Wiz, P.0. Box 1793 Hobart, TAS 7001 
e-mail cmq_ed@msn.com. 
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^Keys to making you a power user ^ 

Internet Explorer 3.0 - 
Logging on to an FTP 
Server 

^ I have recently started using 

Internet Explorer 3.0 and 

think that it has added a new 

dimension to using the Internet. 

Unfortunately, I often need to log on 

to an FTP server which the Internet 

Explorer does not directly support. 

My Hot Tip relates to the way in 

which you can log on to FTP 

without generating that annoying 

error message. 

Normally, when you try to log on to 

an FTP site using a URL of the form 

ftp://<username>@<ftp server 

name>/<url pathname> 

you will probably receive the 

following error message: 

The attempt to open 

"ftp://<user>@<ftp 

server>/<url-path>" failed 

or was cancelled. 

The reason is that Internet Explorer 

does not support password 

prompting for FTP connections. 

The hint that I have come up with 

(with a bit of help from a Microsoft 

site on the Internet) to log on to an 

FTP site that needs a password is to 

enter the URL in the following form: 

ftp://<username>:<password>@ 

<ftp server name>/<url 

pathname> 

Tyrone Hilder, 

Watley Creek, Tas. 

Editors’ Note 

This is correct, you do need to embed 

the password. You need to be aware, 

however, that this will not be encoded 

when it is sent over the Internet, 

therefore anyone with access to the 

message will be able to read your 

password. 

It’s interesting to remember that there 

is an FTP application supplied with 

Windows 95- Simply run the program 
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FTP.EXE which you will find in the 

Windows95 directory. 

Project 4.0 - Saving in 
Access format 

Have you ever been 

Nr Njr annoyed when trying to 

save a project in Access format and 

you were not given the chance to 

change the name of the file to which 

you saved it. 

This is because once you have saved 

a Project file in Access format the 

filename that you choose is stored 

and used every time that you save it 

in the future. 

If you want to be able to save it 

with a different name there is a 

deceptively simple method available. 

All you have to know is where 

Project stores the name. 

O From the Tools menu choose 

Options. 

© Click on the View tab and then 

select the Project Summary Task 

option. 

© Choose OK. 

A summary task for the entire project 

is displayed. 

© Click on the Summary Task and 

then double-click on the header of a 

column that you do not need 

displayed. 

© Choose Text2 from the drop-down 

list, then choose OK. 

Notice that this field is displayed and 

that the field contains all the data 

about where the file is stored. 

If you want to store that file 

somewhere else or give it a different 

name then you must delete the field 

name. 

© Click in the Text2 field for the 

Project Summary task, then hold 

down the CTRL key and press Delete. 

You can now save the file and the 

ability to change the name is 

restored. 

Ben Grillion, 

Toowong, Qld. 

Editors’ Note 

This Hot Tip assumes you understand 

the way in which Project data is created 

and how this is translated into Access 

format. You should not try this Hot Tip 

unless you are familiar with these 

principles. 

This problem does not exist in Project for 

Windows 95 because there is a “Save to 

Database As” option you can choose if 

you want to save it to a different 

database. 

Word 6.0 - Revision Marks 
We had a problem showing revision 

marks in our documents on 

a large screen for an 

"v v audience and then being 

able to print showing the revisions. We 

also wanted to be able to print the final 

document without revisions. 

The problem was easily solved by 

recording the following macros. 

Sub Main 

ToolsRevisions .MarkRevisions 

=0, .ViewRevisions = 0, 

.PrintRevisions = 0 

End Sub 

Sub Main 

ToolsOptionsRevisions 

.InsertedTextMark = 0, 

. InsertedTextColor = 7, 

.DeletedTextMark = 1, 

.DeletedTextColor = 17, 

.RevisedLinesMark = 2, 

.RevisedLinesColor = 16 

ToolsRevision 

.MarkRevisions=l,.ViewRevision 

s=l, .PrintRevisions=l 

End Sub 

These macros were assigned to icon 

buttons. The first macro allows printing 

of the final document without any 

revisions. The second macro shows 

revisions on the large screen and allows 

printing of a ‘revision’ document. 

Sue O’Connor, 

Clifton Springs, Vic. 



Editors’ Note 

To assign the macros to a toolbar, 

choose Customize from the Tools 

menu. Select the Toolbars tab and 

then in the Categories list select 

Macros. A list of macros is now 

displayed and you can drag your 

macros to an appropriate toolbar. 

Word 6.0 for Windows - 
Drawing defaults 
My Hot Tip is very simple but I 

have found it saves me 

( hours of time. Do you 

it get frustrated 

when you draw a rectangle or circle 

using Microsoft Draw and then you 

have to change the border style and 

the fill colour every time? 

Well my hint explains how to set the 

defaults for these things so they will 

be what you want. 

O First, make sure there are no 

drawing objects selected. 

PowerPoint 7.0 - 
Organising pictures 

■sq I use PowerPoint to prepare 

the many talks I am asked to 

present to various organisations. I 

am involved in advising people 

about the application of high 

technology for the general business 

community as well as those in the 

travel and human resources sectors. 

I often use clipart to enhance my 

presentations and need to be able to 

locate the pictures I want quickly. 

I discovered a wonderful feature of 

PowerPoint that allows me to 

categorise both the existing clipart 

pictures and new pictures that I 

discover. 

Try the following to see how this 

feature works. 

O Start PowerPoint 7.0, then 

choose Tools, then choose 
AutoClipArt. 

The AutoClipArt dialog is displayed 

as shown in Figure 2. 

Here you can view the pictures by 

category such as cartoons, food and 

© Click on the Cartoons category, 

then choose the light bulb by clicking 
on it once. 

© Click on Organize. 

The Organize ClipArt dialog is 

displayed as shown in Figure 4. 

Figure © 

© Choose Picture Properties. 

Figure © 

© In the Description field change 

the description to Great Idea then 
click on the New Category button. 
The New Category dialog is 

displayed. 

© Type Business Presentations, then 

choose OK. 
Notice now that the picture is in 

two categories. 

© Choose OK, then choose Close. 

© Click on the Business 

Presentations category and notice 
that the picture is displayed. 

You can obviously create as many 

categories as you like and also 

remove as many as you like. The 

other feature Ifind useful is to be 

able to use the Find option to search 

the descriptions for particular words. 
Robert McBain, 

Hobart, Tas. 

COAMJNIQUEl 79 
Dec/Jan 1996/97 



Publisher 97 has 
some great new 
features, including a 
Wizard to help you 
design your Web Site, 
and a very easy mail 
merge facility. This 
tutorial introduces 
mail merge, helping 
you to create a 
postcard advertising 
a summer film 
festival, and a data¬ 
base of people to 
send it to. 

Note: Each time you choose a tool 

for the first time in Publisher 97, 

you will be given the option of 

having an overview of working with 

that tool. You can run this later if you wish. 

In the meantime, click on Continue. 

Q> Creating a postcard 

O Start Publisher 97. 

0 When the Page Wizard tab is 

displayed, choose Postcard. 

Your screen should look like Figure 1. 

© Click on OK. 

Create a postcard 

Set up and format a table 

Create a publisher address list 

Merge data from Publisher address list 

“Wisher 97 
PageWizard | Blank Page | Existing Publication | 

Select the type ol ptfcfcation you wart to create, and then dick OK. 

♦ 
Newsletter Flyer 

-- 
is 1 w 

Postcard Label 

4-gfc. £ 
Sign Business Card 

8 ■a 
Specialty Envelope 

m 
1 OK | Cancel 

© When the Wizard asks, ‘What’s the postcard 

for?’ choose Business, then click on Next. 

© For the type of postcard choose Event 

Announcement, then click on Next. 

© For the style choose Modern, then click 

on Next. 

O For the size choose 1/4 page, then click 

on Next. 

© Type your return address, then click on Next. 

© Choose ‘One in the center’, then click on 

Next. 

© When you have read the note about double¬ 

siding, click on Next. 

© Click on Create It! 

© When the Wizard tells you it is finished, 

choose No so you don’t have step-by-step help 

while you add your own text and pictures, 

then click on OK. The first page of the 

postcard is displayed. 

© To delete the graphic at the top left, click on 

it and then press CTRL + DELETE. 

© To move your name and address to the top 

left corner, hold down SHIFT and then click 

on each line of your address. 

© Click on the Group Objects tool at the bottom 

of the address to group the lines. Drag them 

across to the top left corner. 
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COMAUNIQUE 
Timesavers 
Six issues every year of the Tips & Techniques 
supplement for either Windows or Macintosh. This 
free publication is crammed with hints, short 
cuts, tutorials and program information to help 
you get more out of your software. 

Microsoft TechNet, a reference guide designed for 
technical professionals, is the leading resource for 
fast, complete answers to the toughest 
problems on the Microsoft desktop and system 
products. As a Communique member your year’s 
TechNet subscription is only $395, (plus $48 
postage & handling) - or you can buy a single issue 
of TechNet for $40 (plus $9.95 postage & handling) 
instead of the normal non-member price of $60. 

The Microsoft Developer Network (MSDN), a 
membership program for the serious software 
developer or corporate development group: 

Level 1 entitles you to a quarterly 
Development Library on CD-ROM plus 
bi-monthly Developer Network News. 
Communique members pay only $395 (plus 
$48 postage & handling) - a saving of 10%. 

Level 2 offers members all the benefits of 
Level 1 plus the latest releases of Microsoft 
Software Development Kits and Device Driver 
Kits. Communique members pay only $765 
(plus $48 per year postage & handling) - 
a saving of 15%. 

The new Level 3 delivers all the above plus 
the BackOffice Test Platform - a set of CD- 
ROMS providing BackOffice Server for testing 
and developing purposes. Communique 
members pay only $1,995 (plus $48 postage 
& handling) instead of $2,095. 

Information 
11 great monthly issues of Communique 
magazine (including the bumper double issue 
in December) with 56 pages packed with 
hints, features, news, interviews, letters, tips 
and user stories. 

Communique magazine binders protect 
Communique copies and Tips and Techniques. 
Easy access to your information. Binders cost 
only $15 each plus postage and handling. 

Self-help with 10% off all Microsoft Press® 
books at Dymocks, Uni Co-Op book shops and 
selected book resellers. 

Discounts 
Keep up to date with the latest software 
and receive exclusive discounts (up to $50) 
on Microsoft upgrades. 

Master your software with a 20% discount 
on training from Drake, Citidata, Citisoft 
and ACCS. 

Use Microsoft connections to receive 
exclusive discounts on other products such 
as hardware and software that complement 
our own. Offers are announced every month 
in Communique magazine. 

Receive an exclusive $100 discount on a 
subscription to Microsoft TechNet - an invaluable 
reference guide for technical professionals. 

Communique members enjoy exclusive 
discounts (up to 15%) on all three levels 
of the MSDN membership program. 

10% off MSTV training videos. 

Help 
Communique members can call an exclusive 
1800 toll free number for help with your 
software problems. 

Standard Support comes free. It’s what you 
ask for if you’ve registered your software and 
you’re having problems installing- or you 
think you’ve encountered a product bug. 

Priority Support is what we’ll ask you to pay 
for but relax because Communique 
membership entitles you to great savings. 
Just get on the phone and get talking. We’ll 
try to solve your problem before putting down 
the receiver. 

Choose the support payment option of your 
choice: 

Support as you need it If you’re a 
Communique member you can buy Desktop 
Support at $30 per problem solved. 

The convenience of pre-bought support. 
If you’re using Desktop Support regularly, 
save time and money by getting a Pack of 6 
Support Calls. Call 1800 817 328 or 
Sydney (02) 9870 2111 for more information 
on support savings. 

Professional Support All Communique 
members have access to Professional 
Support at $225 per problem solved. 

Plus, your personalised membership card 
identifies you as a member of Microsoft 
Communique, and gives you access to your 
exclusive Communique benefits. 

For more information on the Communique 
Program and benefits call 1800 257 253 or 
in Sydney call (02) 9870 2111. 

Tips & Techniques 

enjoying the biggest and best 
value in computing. 

Q Eleven issue: 

a year of 

Communique 
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December issut 

0 Six issues a 

year of Tips & 

Techniques, 

the toolbox that 

lets you use 
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your PC best 

O Your 

personalised 

Communique 

advantages wherever you are 

DISCOUNTS 

software, support 

services, online 

forums, reference 

books, tutorial 

disk(s), training 

and much more. 

Communique 

membership is 

the way to be 

sure you get 

the very best 

Microsoft has 
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Refining the content 
The first page presented is the side of 

the postcard for your return address 

and the mailing address, 

O Click on the Next Page button at 

the bottom of the screen: 

Figure 2 shows you where to find the 

Next Page button. 

First you will replace the graphic, 

then the text. 

© Click on the picture of the tools to 

select it. 

© From the Insert menu choose Clip 

Art. 

© When the Microsoft Clip Gallery 

window appears, select the Clip 

Art tab. 

© From the list of categories on the 

left choose Entertainment, then 

from the previews choose the reel 

of film in the top row. 

Your screen should look like 

Figure 3- 

| [*|0P« |®B<JUCK |fN Videos | 

I1 1b ."T 

© Click on Insert. 

© When the Import Picture window 

appears, choose ‘Change The 

Picture To Fit The Frame’, then 

click on OK. 

Your picture now appears on the 

postcard. 

The main heading is a Word Art 

object, so you need to double¬ 

click on it to edit it. 

© Double-click on ‘Trade Show’. 

Replace this text with Film Feast 

and then close the window. 

© Click on the text that says ‘Type 

tag line here’. Replace it with 

Summer Festival starts 26 

December. 

© Click on the text that says ‘Place 

map or directions here’. Replace 

it with All films screen at 11.00 

and 21.00. 

Your postcard should now look 

like Figure 4 (right): 

© This is a good time to save your 

publication. From the File menu 

choose Save. In the ‘Save in’ box 

choose the folder in which you 

want to save the file. 

© In the ‘File Name’ box type Feast 

and then click on Save. 

Adding a table 

Now you are going to create a table 

with the details of the films to be 

screened. 

© Click on the text box with the 

green ‘Lorem ipsum’ text. Press 

CTRL + DELETE to remove the 

text box. 

0 Click on the Table button. 

© Draw a rectangle to fill the space 

between ‘Summer Festival’ and 

the bottom border. 

The Create Table window 

appears. 

© In ‘Number of Rows’ type 6 and 

in 'Number of Columns’ type 4. 

In ‘Table Format’ choose ‘List 1 ’. 

Click on OK. 

A message tells you that your 

table won’t fit in the rectangle. 

To create a larger table, click on 

‘Yes’. The table is then added to 

your document. See figure 4. 

© Enter the following details in the 

table below. Don’t worry if the 

text doesn’t fit nicely. You will 

fix up the column widths next. 

Title Starts 

Casablanca 26 Dec 

Singing in the Rain 27 Dec 

Prizzi's Honour 27 Dec 

Four Weddings 28 Dec 

Get Shorty 28 Dec 

Ends 

3 Jan 

4 Jan 

4 Jan 

5 Jan 

5 Jan 

Venue 

Avalon 

Regent 

Orient 

State 

Princess 

aii films Summer festival starts 26 December 
strata at 1111 

and 21.00 ♦torem igsnm dolor si! amet 
♦Consectetner adlniscing elft 

♦Tincldunt utlacreetdolore masna 
♦Aliguam eratvolutgat 
♦Otwisiseniinafl minim 

© To adjust the column widths 

move the pointer to the top of a 

column where it changes to the 

Adjust tool. Click and drag the 

column width to change it. 

© Click anywhere on the green 

border to select it. 

© Move the pointer over the middle 

‘handle’ on the border’s bottom 

line until it changes to the Resize 

tool. 

© Click and drag the border down 

below the table. 

© From the Edit menu choose 

‘Select All’. Drag all the items up 

the page until they are nicely 

centred on it. 

© Save your postcard again. 

Next you will create a data 

source for the names and 

addresses. 

COMMUNIQUE 1 
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First Name Last Name- Address Line 1 Address Line 2 Postcode 

Paul 'Forsyth' 117 Waimea Road Campbell 3555 

Michelle Jones 120 Winston Place- Marshall . |jjj|flgjjg| 
Diane Handel 15 Eden Street Paradise 3777 

Bill Austen . 34 Muse Avenue Bamford 3666 

Tip: To resize one column without 

affecting the others, hold down SHIFT 

while you drag the column. 

Your postcard should now look 

similar to Figure 5: 

O Creating a Publishing 
address list 

An address list is the data source of 

the information you want to merge. 

It doesn’t have to be a list of names 

and addresses, it can be any kind of 

information. For example, you could 

create a list of books and their prices 

for a catalogue, or a list of training 

courses and the dates on which they 

are offered. 

You are going to create a short 

list of names and addresses. 

O From the Mail Merge menu 

choose ‘Create Publisher Address 

List’. 

© Click on the Customize button. 

You are going to use the 

Customize Address List window 

to refine the fields that your 

database will contain. 

© Click on ‘Title’, then click on 

Delete Field. 

© When you are asked if you’re 

sure you want to delete the field, 

click on Yes. 

© Now delete ‘Company Name, 

City, State, Country, Home 

Phone, Work Phone and E-mail 

Address’. 

Tip: If you accidentally delete Address 

Line 2 or ZIP Code you can replace 

them by clicking on the Add New 

Field button. 

© Click on ‘ZIP Code’ then click on 

the Rename Field button. 

Change the field’s name to 

Postcode’ then click on OK. 

Your list of fields should now 

look like Figure 6: 

© Click on OK. 

You are taken back to the New 

Address List window. 

Entering the data 

The New Address List window is a 

form that you can fill in over and 

over again, to enter the names and 

addresses for your little database. 

© In the First Name field type Beth’ 

and then press ‘ENTER’. 

© In the Last Name field type 

Nguyen and then press ‘ENTER’. 

© In the Street Address field type 19 

Courage Drive and then press 

‘ENTER’. 

© In the Suburb field type Weston’ 

and then press ‘ENTER’. 

© In the Postcode field type 3999’ 

and then press ‘ENTER’. 

Now you have a clean form for 

entering data for another 

address. 

© Use steps 1 to 4 to enter the 

following details for the 

remaining people: 

see panel above. 

© When you have finished, click on 

Close. 

The Save As dialog box is 

displayed. 

© At the ‘Save in’ box, choose the 

folder in which you want to save 

your data source. 

© In the ‘File name’ box type Films 

and then click on Save. 

You are returned to your 

postcard. 

®i Merging the names 
and addresses 

© To go back to page 1, click on the 

Previous Page button at the 

bottom of the screen. 

© Now click on the text box that 

says ‘The mailing address goes 

here'. 

© From the Mail Merge menu 

choose Open Data Source. 

© At the Open Data Source window 

choose ‘Merge information from 

a file I already have’. 

© In the ‘Look in’ box, locate the 

folder in which you saved your 

‘Film list’ database or the file 

name Films.mdb. 

© When you have found it, click on 

‘Films.mdb’, then click on Open. 

The Insert Fields window is 

displayed: 

© Make sure ‘First Name’ is 

selected, then click on ‘Insert’. 

© Click on ‘Last Name’, then click 

on Insert. 

© Click on ‘Address Line 1 ’, then 

COAMJNIQUE^ 
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Insert Fields to move it to see the mm 

Choose Insert to add the 
selected fields to your 
publication. 

Fields: 

click on ‘Insert’. 

© Click on ‘Address Line 2\ then 

click on ‘Insert’. 

© Click on ‘Postcode’, then click on 

‘Insert’ and then click on ‘Close’. 

All your database fields are now 

inserted in the text box but you will 

need to put line breaks and spaces 

between some of the fields. 

© Click between the ‘Last Name’ 

and ‘Address’fields, being 

careful to click between the 

closing and opening brackets. 

Press ‘ENTER’. 

© Add another break between 

‘Address Line 1 ‘ and ‘Address 

Line 2’. 

© Add a space between ‘First 

Name’ and ‘Last Name’, and a 

couple of spaces between 

‘Address Line 2’ and ‘Postcode’. 

© Highlight all the text. Change the 

font to Arial, make it Bold, and 

change the type size to 10 pt. 

The address area should look 

like Figure 8: 

You may 

address. 

© To preview the other entries, click 

on the ‘Next’ button. When you 

have finished previewing, click 

on ‘Close’. 

© Save your postcard again. 

Printing the postcards 

0 From the File menu choose Print 

Merge’. 

© At the Print Merge window make 

sure that ‘Use Print 

Troubleshooter’ and Print Crop 

Marks’ boxes are both checked. 

© Click on OK. 

Your five postcards will be 

printed with the individuals’ 

names and addresses. 

Tip: You can sort your database, for 

example, into postcode order. From the 

Mail Merge menu choose ‘Edit Publisher 

Address List’. Open your address list. 

When it is displayed click on ‘Filter’ or 

‘Sort’. Choose the Sort tab. At ‘Sort by 

this field’ choose Postcode, then choose 

‘Ascending’, then choose ‘Close’. 

Choose ‘Close’ again. Next time the 

postcards will be printed in postcode 

Tip: Experiment with the new Design 

Gallery tool, which helps you to highlight 

headlines and other attention-grabbing 

text.l 

«FIRST NAME» «LAST NAME* 
«ADDRESS LINE 1 
«ADDRESS LINE 2* ^POSTCODE) 

© From the Mail Merge menu 

choose Merge. 

The first entry from your database is 

displayed in the address area, and 

the Preview Data window appears. 

Data sources 2 

A data source is a database 

that contains the information 

you want to merge into your 

main document. Often it's a 

list of names and addresses. 

You can create a data 

source in Publisher, or you 

can use data created in any 

of the following applications: 

•Microsoft Access (all 

versions) 

•Microsoft Excel (versions 

3.0, 4.0, 5.0, or 7.0) 

•Microsoft FoxPro (versions 

2.0, 2.5 or Visual FoxPro 5.0) 

•Microsoft Word tables or 

merge data documents 

•Microsoft Works for MS-DOS 

(version 3.0) 

•Microsoft Works for 

Windows (versions 2.0, 3.0 

and 4.0) 

•dBase (versions 3.0, 4.0 or 

5.0, provided that Excel 7.0 

or Access 7.0 is installed on 

your PC) 

•ASCII text files (except fixed 

field-width files) 

•Paradox (versions 3.0, 4.0 

or 5.0, provided that Excel 

7.0 or Access 7.0 is installed 

on your PC) 

Publisher 97's excellent 

online Help will assist you, or 

The Publisher Companion. 
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By Sue Dyson and 

Roger McShane. 

Microsoft Works 95* 
comes with many 
sample database 
structures that, if 
they nearly match 
what you want, can 
save you a great 
deal of time. In this 
tutorial, you’ll learn 
how to create a new 
database based on 
one of Microsoft’s 
standard templates 
and then learn 
techniques for 
customising it so it 
meets your specific 
needs. 

Creating a database 

O Start Microsoft Works 95 by 

double-clicking on its icon on 

the Desktop or selecting it from 

the Start menu. 

You ’ll see the Works Task 

Launcher, as shown in Figure 

1 (bottom left). 

The Task Wizard tab shows you 

groups of common tasks, each of 

which contains a set of Works 

templates. You can see that 

Common Tasks is highlighted and there 

are six available templates. 

0 Scroll down the list until you see 

Students and Teachers, then click or 

it. You’ll see the list of templates 

which will look similar to Figure 2 

(bottom right). 

© Double-click on ‘Student and 

Membership Information ’ (or click 

Create a database using the Works 

Task Wizard 

^ Delete some fields from the database 

Re-position the fields on a form 

^ Add a new field to the database 

^ Change the names of existing fields 

and labels 

once on it, then choose OK) to start the 

TaskWizard. 

O If you see the dialog box shown in Figure 3 

(next page), click Yes, run the TaskWizard. 

You’ll see the screen shown in Figure 4 

(next page). 

At this point, you can select the type of 

database you want to create. You can 

choose Student information, ‘Club Roster’ or 
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‘Team Roster’. 

© We want Student Information, 

which is already selected, so you 

can click on ‘Create It!’. 

After a few moments, the 

database is created. It looks 

similar to Figure 5. 

As you can see, Works has done 

most of the work for you. It’s 

created all the fields and put 

them on a professional-looking 

form. It’s even designed some 

reports for you. 

© To see what reports are available, 

from the ‘View’ menu choose 

‘Report’. 

You’ll see the dialog box in 

Figure 6. 

© For the moment, click on 

‘Cancel’. 

Deleting some fields 

When you use one of Works’ 

purpose-designed templates, you’ll 

often find it’s very close to what you 

want but not exactly right. 

In this database, we want to 

remove some fields, add a new field 

and then change the names of some 

of the existing fields. 

First, we’ll remove the ‘Current 

Scholastic Standards’fields we don’t 

need. 

© Click on the ‘Maximize’ button 

on the Unsaved Database 

window so that you can see all 

the Current Scholastic Standards 

fields. 

© From the View menu, choose 

‘Form Design’ or click on the 

Form Design button on the 

toolbar. 

In ‘Form Design’ view you can 

make changes to the database 

design. 

© To select the fields, labels and 

grey rectangle you want to 

delete, click just above the text 

‘Current Scholastic Standards’ 

but to the left of the grey 

A 

rectangle. Then, with the mouse 

button still held down, drag across 

and down. 

As you drag, you’ll see a rectangle 

that shows what you have enclosed. 

© When the rectangle has enclosed 

all of the fields and the grey 

shaded rectangle, let go of the 

mouse. Once you let go, the screen 

should look like Figure 7. Notice 

the objects you selected include the 

heading, each field, the labels and 

the grey rectangle behind the fields. 

Don’t worry if you didn’t select 

everything. You can either click 

somewhere else to de-select the 

objects you’ve already selected then 

try again, or you can proceed to 

the next step and delete what 

you’ve already selected. Then select 

what’s left later and delete them. 

© Press the Delete key on your 

keyboard, or from the Edit menu 

choose Delete Selection. 

You’ll see the dialog box shown in 

Figure 8. 

© Choose OK. 

SH Moving fields 
on the form 

Now there’s some extra space, we can 

move the fields up a little. The easiest 

way to do that is to move them as a 

group and the easiest way to select 

them as a group is to change the Zoom 

level so that you can see the whole 

form. 

© From the View menu, choose 

‘Zoom'. 

© In Custom, type 40’ (which is the 

smallest zoom level you can select) 

then choose OK. 

© Now, click and drag to select all the 

fields below the ones you just 

deleted. The screen should look like 

Figure 9. 

© Move the mouse pointer into the 

middle of the selected area and 

click once. The pointer name 

should change to show Drag. (Note 
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that if the pointer name is not 

displayed it’s because in the 

Tools Options menu, the Show 

pointer names option, which is 

in the View tab, has been turned 

off) 
© Now, drag the selection upwards. 

(You need to leave some space 

because we will be inserting 

another field just below the 

‘Birthday ’field.) 

As you drag, you’ll see the 

position of the first object in the 

selection shown in the left comer 

of the Entry bar. Assuming you 

are working in centimetres, drag 

until it shows 2.8cm and 7cm. 

O When the selected objects are in 

the correct position, click 

somewhere outside the selection. 

© Now, click on the Zoom button at 

the bottom of the Works window. 

Then from the list that pops up, 

select 100%. Your view of the 

form is now returned to its 

actual size. 

C3 Adding a new field 

to the database 

We want to insert a new field in the 

database called ‘Gender’. We’ll put it 

just below ‘Birthday’. 

© Click just below the Birthday 

field. (That’s the white area 

where you enter the date, not the 

label.) 

© Using the arrow keys, position the 

pointer until it is 6.0cm across 

and 6.2cm down. 

The screen should looks like 

Figure 10 if you are using Works 

for Windows 95 version 4.0 and 

slightly different if you are using 

version 4.0a. 

Tip: If you are not using centimetres 

and you want to change your unit of 

measurement to centimetres, from the 

Tools menu choose Options then choose 

General. Choose Centimetres, then 

choose OK. 

© From the insert menu, choose 

Field. 

© In Field Name, type the name for 

the field, which is Gender. There 

is no need to change the default 

field type (General), so choose 

OK. 

The field is inserted into the 

database. You can see the field 

itself and its title. 

Notice, though, that the other 

fields are not showing the field 

title. Instead, they have a label 

which is positioned well to the 

left of the field itself. 

© To hide the field name choose the 

‘Format’ menu, then choose 

‘Show Field Name’ to turn off the 

check mark next to it. 

© Now, with the field still selected, 

from the ‘Format menu’ choose 

‘Field Size’. 

© Type 4, then press Enter. 

By making the field size small, 

you provide a hint to the user 

that you only want them to type 

‘F for Females or ‘M’ for Males. 

We can make it more obvious by 

putting a message on the form. 

© Click just to the right of the field, 

making sure that the second 

value representing the vertical 

cursor position is still 6.2 cms, so 

that you know what you’re 

about to type will line up with 

COMMUNIQUES 

the field. 

© Press Ctrl +1 or click on the 

Italics button on the toolbar to 

choose Italics, change the font 

size to 8 point then type: 

Type ‘F’for Female or ‘M’ for 

Male 

© Click somewhere away from the 

text you’ve just typed to de-select 

it. Now, we want the field itself to 

look like the fields above it. We 

need to shade it white and put a 

grey rectangle behind it. 

© Right-click on the field, then 

choose Shading. 

© In Foreground Color, choose 

White. 

© In ‘ShadingPattern’, choose 

‘100%’. The dialog box should 

look like Figure 11. 

© Choose OK. 

We now need a grey border. 

Because you can’t be sure 

exactly what the shading settings 

are, you need to select an 

existing one, check its settings 

and then reproduce them on the 

new rectangle. 

© Right-click on one of the grey 

rectangles you can see 

protruding to the right of one of 

the other fields. Then choose 

Shading. 

Notice the color is light grey and 

the shading is 50%. 

© Choose Cancel. 

© From the Insert menu, choose 

Rectangle to insert a new 

rectangle. 

© Right-click on the new rectangle, 
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then choose Shading. 

© Choose a Foreground of Light 

Grey and a Shading of 50%. 

© Click on the 'Border’ tab. 

© In ‘Line Style’, choose the first 

option (which is no border) then 

choose OK. 

© Click and drag on the bottom 

middle selection handle until the 

grey rectangle is narrow enough 

to fit nicely behind the new field. 

© Click and drag on the right 

middle selection handle until it 

is roughly the same size as the 

field. 

© Drag it down so that it’s 

positioned on top of, but to the 

left of, the field (so that it lines 

up with the left edge of the 

rectangle above it and overlaps 

it). 

© From the ‘Format’ menu, choose 

‘Send to Back’. 

© So that you can position it 

exactly, click on the + button 

near the Zoom button to change 

the Zoom level to 150%. Then 

make any adjustments required. 

Figure 12, which has the Zoom 

level set to 400%, shows you 

where it should be positioned. 

© Now, zoom back to 100%, ready 

to add a label for this field. 

© Click just below the label 

‘Birthday’ (at 3.0cm) then type: 

‘Gender’. 

© Click on the Italics button to turn 

it off and select a font size pt of 

9. 

© Click somewhere else to de-select 

the text. 

Unprotecting a field 

© To check that all is well, from the 

View menu choose Form. 

© Click in one of the fields above 

the new field, then press Tab two 

or three times to move from one 

field to another. Notice that 

Gender is missed out. That’s 

because the field is protected, 

which is not what you want. 

You normally use Protected 

fields when the data in the field 

is calculated automatically by 

Works and you don’t want a 

user to type information into the 

field. 

© From the View menu, choose 

‘Form Design’ again. 

© Click on the ‘Gender’field (not 

the label) to select it, then choose 

‘Protection’from the Format 

menu. 

© To unprotect the field, click on 

‘Protect Field’ to turn off the 

check mark, then choose OK. 

© Now, switch back to Form view 

again and check that you can 

enter data in the field. 

© When you are satisfied 

everything is correct, from the 

File menu choose ‘Save’. Type the 

name Students, then choose OK. 

© Once you’ve checked, click on 

the ‘Form Design’ button on the 

toolbar to return to Form Design 

view. 

O Renaming fields 

and labels 

Finally, we need to change the 

labels and field names of some of the 

labels and fields. We’ll change the 

County or Province labels to ‘State’ 

and we'll change the underlying 

field names as well. Remember, there 

are two things here, the label and 

the field. We could just change the 

label and a user would be unaware 

of the underlying field name. 

However, because you sometimes use 

the field names in report and filter 

definitions, you can avoid confusion 

by changing the field name itself as 

well. 

© Click on the first Country or 

Province label (State or Province 

if you are using version 4.0a). 

© In the ‘Entry’ Bar at the top of 

the screen, highlight the text 

that’s there, then type State’ to 

replace it. Press Enter. 

© Now right-click on the 

corresponding field, then choose 

Format Field. 

Notice that it’s name is G1 

Prov/County (or G1 Prov/State 

in version 4.0a). 

© Delete the Prov/County (not the 

G1 and the space after it) then 

type State’. 

Notice in this same dialog box 

you can type a default value. 

Given that the majority of 

students in any one school are 

likely to live in the same state, 

you could make that state the 

default value. Then, someone 

entering data would only have 

to type the state if it was 

different from the default. 

© Click on ‘Automatically enter a 

default value’ then, in the box 

below, type the state, in this case 

‘Tasmania ’. 

The dialog box should look like 

Figure 13- 

© Choose OK. 

© You could now follow the same 

steps to change other references 

to provinces and counties, store 

default values for each reference 

to State and change the label 

and field name for ‘Postal code’ 

to ‘Post Code’. 

You now have a database that, 

although based on one supplied by 

Microsoft, has been customised. The 

techniques introduced here can be 

applied to any of the databases 

supplied by Microsoft Works 95. 
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Frontpage and 

Frontpage 97 for 

Windows 95 

Internet Explorer 
3.0 has the ability to 
interpret information 
stored in ‘tables’. 
Tables add enormous 
flexibility to your Web 
pages and allow for 
eye-catching presen¬ 
tation of information. 
They also allow you 
to control the place¬ 
ment of information 
on your Web pages to 
make sure text is not 
displayed at full 
screen width, as this 
makes your pages 
very hard to read. 

Frontpage allows you 
to create and main¬ 
tain information in 
tables. This tutorial 
has been written for 
both FrontPage 1.1 
and FrontPage 97. 
The screens have 
been captured using 
FrontPage 1.1. 

Exploring 

C9 Creating a table 

O From the File menu 

choose New. 

The ‘New Page’ dialog is 

displayed as shown in V-I 

Figure 1. 

0 Choose ‘Normal Page’, then choose OK. 

You are now going to insert the table. 

© From the Table menu choose ‘Insert Table’. 

The ‘Insert Table’ dialog box is displayed as 

shown in Figure 2. 

You are now going to set each of the 

parameters you need for your table. This is 

important, as your choices will control 

where information is displayed on the 

screen. 

O Set the number of Rows to 2 and the 

number of Columns to 2. 

0 In the Layout group, set the Alignment to 

Centre, the Border Size to 2 and the Cell 

Padding to 3■ The Cell Spacing should be set 

to 2. 

The Border Size is the width of the border 

that appears around the cells. The Cell 

Padding is the distance between the 

contents of the cell and the border. This is 

an important parameter because it can be 

very off-putting to read text that is too close 

to the border of a cell. The Cell Spacing is 

I Revise using FrontPage Editor 

) Navigate around tables 

) Revise creating and linking Web pages 

the distance between the right hand 

border of one cell and the left hand 

border of the next cell. You can use this 

attribute to space cells out on the page. 

You are now going to set the size of 

your table. Browsers usually 

automatically resize your tables so they 

fill the screen depending on the 

resolution of the screen. This can lead 

to very wide tracts of text which are 

unpleasant to read. Our eyes are not 

used to ‘tracking’ across a 15 or 17 

inch screen full of text. 

Some of the best Web sites only present 

very narrow bands of text on the 

screen. This can be achieved by using 

a table that is set to be a fixed width. 

You do this by nominating the number 

of pixels you want the width of the 

table to be. 

0 In the Width group choose Specify 

Width, choose the in Pixels option and 

then set the value to 500. 

© Choose OK. 

A table is displayed and it is centered 

on the screen. There is the all- 

important ‘white space’ down both 

sides of the table 

C9 Editing a table 

Notice the cursor is in the first cell. You are 

now going to make a change to the table. 
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O From the Table menu choose 

Select Row. 

The first row is selected. You can 

also select a row by moving the 

mouse pointer to the left edge of 

the row and, when the pointer 

changes to a right facing arrow, 

clicking once. 

Because we are going to put a 

heading in the first row you are 

going to merge the two cells into 

0 From the Table menu choose 

Merge Cells. 

The table now looks like the two 

cells are merged into one. 

0 In this cell type Jobs Unlimited 

and then choose the Heading 1 

style from the Style drop down 

list on the Format toolbar. 

Notice the text has increased in 

size. The cursor is currently at 

the end of the line. 

© Hold down the SHIFT key and 

press HOME. 

The text is selected. 

0 Click on the Text Color button on 

the Formatting Toolbar. 

The Color dialog is displayed as 

shown in Figure 3- 

© Click on a suitable colour for the 

text, then choose OK. 

The heading is now coloured. 

SB Saving the page 

You are now going to save the page 

you have created. 

O From the File menu choose Save. 

The Save As dialog box is 

displayed as shown in Figure 5. 

0 In the ‘Page Title’field type Jobs 

Home Page’. 

The Page URL value changes to 

Jobshome.htm’. 

© Choose ‘As File’, then change to 

the folder you want to save it in. 

Then click on the Save button. 

SB Viewing the page 

Now you are going to view the page 

you have created (remember, we are 

assuming you have downloaded 

Internet Explorer 3-Q). 

O In Windows 95 Explorer, switch 

to the folder you stored the page 

in and then double-click on the 

file you just saved. 

The page is displayed in the 

browser. Notice you can see the 

borders. You are now going to 

see what the display looks like 

without the borders. 

SB Creating a link 

You are now going to revise creating 

a link to another page (we covered 

this in a tutorial in the September 

1996 edition of Communique). 

O Highlight the text ‘Technical 

Writer’, then from the ‘Edit' 

menu choose ‘Link’. (Hyperlink 

in Frontpage 97.) 

The ‘Create Link (Hyperlink)’ 

dialog box shown in Figure 7 is 

displayed. 

0 Click on the New Page tab, then 

in the Page URL field type 

‘tech.htm’. Select the ‘Edit New 

Page Immediately’ option, then 

choose OK. 

The 'New Page’ dialog is 

displayed. 

0 Choose ‘Normal Page’, then 

choose OK. 

© From the Table menu choose 

Insert Table’ or click on the 

Insert table button on the 

Standard Toolbar. 

© Set the following values: 

Rows 2 

Columns 1 

Alignment Centre 

Border Size 0 

Cell Padding 1 

Cell Spacing 2 

Specify Width 500 In Pixels then 

choose OK. 

A two row table is displayed. 

© In the first row type ‘Technical 

Writer’. With the cursor still in 

the first row choose the ‘Heading 

1 ’ style from the Style list. 

© In the second row type the 

following: 

‘We have need of a skilled technical 

writer who has expertise in 

Microsoft Word and Microsoft 

Frontpage. Experience with large- 

scale Web page development an 

advantage’. 

© Highlight ‘Jobs Unlimited Home 

Page’, then from the Edit menu 

choose ‘Link’ (or Hyperlink). 

The ‘Create Link’ dialog is 

displayed. Notice that ‘Jobs 

Home Page’ is listed. 

0 Click on Jobs Home Page’, then 

choose OK. 

You have now created a link 

back to the home page. 

© Choose ‘Save’from the File 

menu, click on ‘As File’, choose 

a folder and then click on ‘Save’. 

© Now switch back to Internet 

Explorer and click on the 

Technical Writer link. 

You are taken to the ‘Technical 

Writer’ page. 

© Click on Jobs Unlimited Home 

Page’. You are taken back to the 

home page. 

You can now create and link 

other pages in the same way. 

You now have the skills to create 

pages that do not overwhelm the 

reader with large amounts of 

text. 
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(^The latest is the greatest) 

WINDOWS FAMILY Save up to $50 

Microsoft Windows 95 Win 95 050-031-950A 
050-052-950A || 

Any version of Windows 3.x $159 $139 

Microsoft Windows NT Workstation 4.0 Win. NT 236-00023 Any previous version of Windows NT $229 $199 

Part numbers relate to 3.5" disks unless otherwise shown as: CD-ROM 

DESKTOP & PRODUCTIVITY APPLICATIONS Save up to $50 

Product Platform Part. From Upgrade Communique 

Microsoft Access for Windows 95 
(CCP)6 

Win 95 077-054-004A Any version of Access for Windows $169 $149 

Microsoft Access Developer’s 
Toolkit for Windows 95 

Win 95 077-754-700A 
077-756700A 7 

Any previous version Access Developer’s Toolkit $599 ' $549 

Microsoft Access 2.0 (CCP)6 Windows 077-051-208A Access 1.0 or 1.1 $169 \ $149 

Microsoft Access Developers Toolkit 2.0 Windows 077-751-200A Access Distribution Kit 1.1 $499. ; | $449 

Microsoft Access 2.0 Upgrade for Office 
for Windows (CCP)7 

Windows 077-051-208A Office for Windows 4.2 Standard Edition $169 | $149 

Microsoft Excel for Windows 95 (CCP)7 Win 95 065-054-701A Any version of Excel for Windows $169 $149 . 

Microsoft Excel 5.0 (CCP)2 Windows 
Macintosh 

066151-500A 
065O96688A 

1.0 - 4.0 $169 $149 

Microsoft Money for Windows 95 Win 95 105054-400Z 
105056400Z 

Any version of Money for Windows $15 $15 

Microsoft Money 3.0 Windows 105051-300AA 1.0 - 2.0 $19 $19 

Microsoft Mouse Intellipoint 11 Driver Windows 136099-389BL 1.0 -10.0 $14.75 $14.75 

Microsoft Office Value Pack Win 95 52800023 Any version of Office for Windows,or one of its 
applications, or qualifying competitive products. 

$599’" : ! $549- 

Microsoft Office for Windows 95 
Professional Edition (CCP)7 

Win 95 
Win 95 

2697054-701Z 
2697056701Z 

Any version of Office for Windows 
or one of its applications 

$499 $449 

Microsoft Office for Windows 95 
Standard Edition (CCP)7 

Win 95 
Win 95 

021054-701Z 
021-056701Z 4 

Any version of Office for Windows 
or one of its applications 

$399 "$349 

Microsoft Office 4.2 (CCP)'7 

Microsoft Office 4.21 (CCP)'7 

Windows 

Macintosh 

021-051-462AAl'al 
021-051-463AAH” 
021-00123 

Office 1.0 - 3.0, Word, Excel, PowerPoint or 
Access (see ~a), or any version of Works (~b) 

$399 $349 

Microsoft Office Professional 4.3 
for Windows (CCP)7 

Windows 269-051-436AA1'*’ 
269-051-437AA1'6’ 

Office 1.0 - 3.0, Word, Excel, PowerPoint or 
Access (see ~a), or any version of Works (~b) ] 

$499 $449: : 

Microsoft PowerPoint 
for Windows 95 (CCP)4 

Win 95 079-054-701A Any version of PowerPoint for Windows $169 $149 : 

Microsoft PowerPoint 4.0 (CCP)'4 Windows 
Macintosh 

079O51-427A 
079O96405A 

2.0 - 3.0 $169 :1 $149 

Microsoft Project for Windows 95 (CCP) ■5 Win 95 076054-701A Any version of Project for Windows or MS-DOS $229 $199 

Microsoft Project 4.0 (CCP)'5 Windows 
Macintosh 

076051-120A 
076096040A 

1.0 - 3.0 $229 $199 

Microsoft Publisher 
for Windows 95 (CCP)9 

Win 95 164O54-301Z 
164O56301Z . 

Any version of Publisher for Windows $89 $79 

Microsoft Publisher 2.0 Windows 164-051-200Z 1.x $129: $109 

Microsoft Publisher for Windows 
Licence Pack" 

Windows 1644056200AMU’ 1.x $109 $89 

Microsoft Schedule-H for Windows 95 Win 95 061-054-700A Schedule+ 1.0 for Windows $99 1 $79 

Microsoft Word for Windows 95 (CCP) 1 Win 95 059-054-701Z Any version of Word for Windows or MS-DOS $169 $149 

Microsoft Word 6.0 for MS-DOS MS-DOS 034096600AA Word 1.65.5 for M6D0S $169 $149 >X777 

Microsoft Word 6.0 (CCP)1 Windows 
Macintosh 

059-151-112AA 
034-196109AA 

Word 1.0 -2.0 for Windows, 1.0 - 6.0 for M6D0S 
Word 1.0 - 5.1 for Macintosh 

$169 $149 

Part numbers relate to 3.5" disks unless otherwise shown as: ; CD-ROM 
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DESKTOP & PRODUCTIVITY APPLICATIONS Save up to $50 

Microsoft Works for Windows 95 (CCP)3 Win 95 070-054-425AA 

Version 

Any version of Works for Windows or MS-DOS 

pSfeade 

$69 

^omrnumque 

$59 

Microsoft Works for Windows 95 
& Bookshelf 95 (CCP)3 

Win 95 070-056-425M Any version of Works for Windows or MS-DOS $99 $79 

Microsoft Works 3.0 (CCP) 3 Windows 070-051-303AA 
070-052-300A ' 

Works for MS-DOS 1.0 - 3.0 
Works for Windows 2.0 

$69 $49 

Microsoft Works 4.0 
for Macintosh (CCP) 3 

Macintosh 070-096-400M Works for Mac 1.0 - 3.0 $69 $49 

Microsoft Works 4.0 & Bookshelf 95 Macintosh 0701-088-400Z 7 Works for Mac 1.0 - 3.0 $99 $79 

Microsoft Works Licence Pack " X-platform 0704055-400AMlp Works for MS-DOS 1.0-3.0, 
Works for Windows 2.0 
Works for Mac 1.0-3.0, 

$59 $49 

Microsoft Works 3.0 for MS-DOS MS-DOS 070-295-300Z 1.0 - 2.0 for MS-DOS $69 $49 

REFERENCE, ENTERTAINMENT & KIDS c iave up to $50 

Microsoft Bookshelf 1996-97 Windows 
Macintosh 

Part 

086-056-096A J 
086-088-096A 

From 

1991, 92, 93, 94, 95 

Upgrade Communique 

$59 $49 

Microsoft Cinemania 96 Win 95 194-056-096A : 1992 or later $39 $29 

Microsoft Creative Writer 11 
disk to CD-ROM conversion 

Windows 
Macintosh 

265-056-100Z : Creative Writer for Windows or Macintosh 
version 1.0 

$25 $2 

Microsoft Encarta 96 Windows 
Macintosh 

196-056-010A 
196-088-010A 

1992 or later 
1992 or later 

$69 $59 

Microsoft Fine Artist 11 
disk to CD-ROM conversion 

Windows 
Macintosh 

266-056-100Z Fine Artist for Windows or Macintosh 
version 1.0 

$25 $25 : 

BACKOFFICE & DEVELOPER Save up to $50 

Product Platform Number Version ssr 
Communique 

Microsoft BackOffice 2.0 Windows NT 321-00019 BackOffice 1.5 $1099 $1049 

Microsoft BackOffice 2.0 
Competitive / Product Upgrade 

Windows NT 321-00017 : Windows NT Server, Microsoft Mail Server, 
Microsoft Exchange Server, SNA Server, 
SQL Server and SMS or their respective eligible 
competitive products. 

$2,639 $2,589 

Microsoft Fortran 5.1 MS-DOS 005-045-510A 1.0 $119 $99 

Microsoft Fortran Powerstation 4.0 
Standard Edition 

Windows 95 
Windows NT 

250-056-325A Any Fortran $449 $399 ^ / 

Microsoft Fortran Powerstation 4.0 
Professional Edition 

Windows 95 
Windows NT 

2501056-325A Any Fortran $739 $689 

Microsoft FoxPro 2.6 Standard Edition MS-DOS 215-895-020 FoxPro 2.5 $49 $49 

Microsoft FoxPro 2.6 MS-DOS 2151095-260A Any Standard Edition of FoxPro $499 S499 

Microsoft FoxPro 2.5 Professional 
to 2.6 Distribution Kit upgrade 

MS-DOS 215-695-020 FoxPro Distribution Kit 2.5 $49 $49 . 3 

Microsoft Macro Assembler 6.1 MS-DOS 016-051-611A 1.0 $129 $109 

Microsoft SQL Server 6.5 for Windows NT Win NT 228-00054 4.2x or 6.0 $999 $949 

Microsoft SQL Workstation 6.5 
for Windows NT 

Win NT 360-00002 -- 4.2x or 6.0 $359 $309 

Microsoft Visual Basic 1.0 for MS-DOS 
Professional Edition 

MS-DOS 203-095-100A Quick Basic 1.x, Basic PDS l.x-7.1 $299 $269 

Microsoft Visual Basic 1.0 for MS-DOS 
Standard Edition 

MS-DOS 046-095-100A Quick Basic 1.x, Basic PDS l.x-7.1 $159 $139 

Microsoft Visual Basic 4.0 for 
Windows 95 & Windows NT Std Edition 

Windows 95 
Windows NT 

046-051-400A Visual Basic for Windows 2.0, 3.0 Standard Edition $89 $79 

Part numbers relate to 3.5" disks unless otherwise shown as: (;; CD-ROM 
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BACKOFFICE & DEVELOPER [continued] Save up to $50 

Microsoft Visual Basic 4.0 for 
Windows 95 & Windows NT Pro Edition 

Platform 

Windows 95 
Windows 95 

203-054-205A 
203-056-205A 

N°mbe 

Visual Basic for Windows 2.0, 
3.0 Professional Edition $149 

Communique 
Price 

$129 

203-054-205A 
203-056-205A 

Visual Basic for Windows 2.0, 3.0, 4.0 
Standard Edition $449 $419 

Microsoft Visual Basic 4.0 for Windows 95 
& Windows NT Enterprise Edition 

Windows 95 
Windows NT 

2031056-400A JH| Visual Basic for Windows 3.0, 4.0 
Professional Edition $739 $689 

Microsoft Visual C++ 4.0 Subscription Windows 95 
Windows NT 

0482056-060A ■. Microsoft Visual C++ 1.x, 2.x $519 $469 . 

Microsoft Visual C++ 4.0 Windows 95 
Windows NT 

0482156-060A . Microsoft Visual C++ 1.x, 2.x $379 $329 

Microsoft Visual SourceSafe Windows 95 
Windows NT 

324-056-110A SourceSafe 1.0-3.X or Delta 1.0 $159 

_ 
$139 

Microsoft Visual FoxPro 3.0 
for Macintosh 

Macintosh CD FoxPro for Macintosh 2.5 or 2.6 S339 $289 

Microsoft Visual FoxPro 5.0 Windows 95 
Windows NT 

“ 

Visual FoxPro 3.0 $358 $308 

Who says only people with Microsoft products can upgrade? 
Move up from your non-Microsoft product thanks to competitive Trade-Ups. Find if your current product qualifies and note the price. 

Then fill in the upgrade order form and send it with all of 

your original disks from your current product. 

Swap and Save up to s50 
Product Platform Number SSL S'16 Communique 

Microsoft Excel 5.0 Macintosh 065-096-690A Upgrade from any competitive spreadsheet 
with an RRP greater than $400. 

$169 $149 

Microsoft Office 4.21 Macintosh 021-00126 Upgrade from any competitive word-processing, 
business graphics, spreadsheet package with an RRP 
greater than $400, or any version of ClarisWorks. 

$399 ~ $349 

Microsoft PowerPoint 4.0 Macintosh 079-096-400A Upgrade from any business graphics package 
with RRP greater than $400. 

_ 
$169 $149 

Microsoft Project 4.0 Macintosh 076-096-400A Upgrade from any competitive project management 
package with an RRP greater than $400. 

$229 $1 

Microsoft Publisher 2.0 Windows 164-051-200Z Upgrade from any competitive desktop publishing 
package with an RRP greater than $100. 

$89 ~ $79 

Microsoft Word 6.0 Macintosh 
MS-DOS 

034-196-110AA 
034-095-600AA 

Upgrade from any competitive word-processing 
package with an RRP greater than $400. 

$169 $149 

Microsoft Works 4.0 Macintosh 070-096-400AA 

. 

Upgrade from any competitive Macintosh integrated 
package with an RRP greater than $100. 

$69 $5<r 

Microsoft Access (CCP) Win 95 077-054-004A Upgrade from any database package. $169 $149 

Win 95 065-054-701A Upgrade from any spreadsheet package. $169 $149 

Microsoft Office 
Professional Edition (CCP)8 

Win 95 269-054-701Z 
269-056-701Z 

Upgrade from any spreadsheet, word-processor, 
database or business graphics package. 

$499 $449 

Microsoft Office 
Standard Edition (CCP)8 

Win 95 021-054-701Z 
02T-056-701Z '% 

Upgrade from any spreadsheet, word-processor, 
database or business graphics package. 

$399 $349 

Microsoft PowerPoint (CCP) 8 Win 95 079-054 701A . Upgrade from any business graphics package. “$169 $149 

Microsoft Word (CCP)8 Win 95 059-054-701Z Upgrade from any word-processing package. $169 $149 

Microsoft Works (CCP)8 Win 95 070-054-425AA Upgrade from any integrated package. $69 $49 | 
Prices subject to change without notice. 

Compliance checking: requires previous version c 

3S previous version c 
Compliance checking: requires previous version c 
Compliance checking: requires previous version c 

Compliance checking: requires an; 
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The info on these pages changes each month. If you 
't find something please check your back issues 

Microsoft Services Sales 
Information Centre 

The following numbers are for Communique 
members only. 

9.00am - 5.00pm (EST)Call (02) 9870 2111 
Or for those outside Sydney 1-800 257 253 

Others can call (02) 9870 2100 
The Sales Information Centre provides pre-sales 
product information, upgrade order services, and 
answers Communique enquiries and general 
enquiries. 

luct Support 

Product Support Services provides post-sales 
technical help in two categories. Please have your 
Communique number and PIN ready when you call. 

Standard Support - no charge_ 

8.00am - 8.00pm Monday - Friday (EST) 
Sydney area (02) 9870 2113 
outside Sydney 1-800 817 328 

If you have trouble installing Microsoft software 
(this does not apply to Business Systems 
products), or if you believe you've encountered a 
fault, then Standard Support is what you need. As 
a Communique member, you get direct access to 
our Support Analysts, who will do their best to 
solve your problem. This service is free of charge 
(except for the cost of the call). 

Priority Support 

8.00am - 8.00pm Monday - Friday (EST) 
Sydney area (02) 9870 2133 
outside Sydney 1-800 808 532 

If you would like assistance with how to use 
specific features of Microsoft software, then 
Priority Support can help. As a Communique 
member, you get priority access to our Support 
Analysts, who will do their best to assist you. This 
service is chargeable. Rates vary according to 
your Communique membership level and the 
category of the product for which you want help 
(see the description of Desktop and Professional 
products categories below). You must possess a 
valid Priority Support contract before a Support 
Analyst can handle your problem. 

Desktop & Professional Support 
Which support is right for you? 

Microsoft products attract different support 
charges depending on their category. 

The Desktop category includes all applications, 
non-server operating systems, and hardware - 
products typically used by individuals for their own 
purposes. Desktop products include Word, Excel, 
Office, PowerPoint, Publisher, Project, Access, all 
Mail client products, all Home products (including 
Works, Money, Kids, Flight Simulator, all 
Multimedia titles, and all games), Windows, 
Windows for Workgroups, MS-DOS, the non-server 
components of all versions of Windows NT, and all 
hardware products (including the Microsoft Mouse 
and Windows Sound System). 

The Professional category includes all software 
development tools, networking, and systems 
products - products typically used by application 
developers and/or computing professionals to 
create software solutions. Professional products 
include all programming languages, all Microsoft 
SDKs and APIs, all other development tools 
(including Delta and the Microsoft Source Profiler), 
all Fox products (including FoxPro and FoxBase), 
SQL Server, Lan Manager, all non-client 
Messaging products, all Gateways, and the server 
components of Windows NT Advanced 
Server/Windows NT Server. 

Call 24 hours, 7 days a week 
(03) 9414 5214 or 1-800 654 100 
if outside Melbourne. 

The Microsoft Feedback Line is a recorded 
message service that allows you to leave 
comments and feedback on the Communique 
program and services. The service is available 24 
hours a day, 7 days a week. Your comments are 
recorded and channelled appropriately. An option 
is available for you to request Microsoft follow-up. 
However, if the matter is urgent we suggest you 
phone the Microsoft Sales Information Centre 
directly. 

Microsoft In Australia on U* * mh» 
Microsoft’s Internet site in Australia has been 
designed for customers who want to be more 
productive and informed about their PCs and 
Microsoft applications. You’ll find not only the 
latest information on Microsoft’s full range of 
applications, operating systems, development 
tools and home products, but you’ll also find 
information on product support offerings, special 
offers, customer programs, services, events, 
industry news relating to Microsoft, and much 
more - 24 hours a day, 7 days a week. 

The Microsoft Web site also has an online 
e-form which provides an easy way to send us 
Microsoft feedback about products, programs and 
services. You can also get pre-sales information 
such as estimated retail pricing and product 
information, and you can request brochures and 
white papers and send any change of address 
details. 

Microsoft Australia on the Net can be found at 
http://www.microsoft.com.au/. 

I.Microsoft Institute of Advanced 
Software Technology 

Hands-on technical courses to help 
programmers take full advantage of the 
latest Microsoft systems software. 
9.00am - 5.00pm EST. 
Telephone: (02) 9870 2250 
Fax: (02) 9870 2255. 

Microsoft Solution Providers 
Authorized Technical Education Centers 

• AlphaWest Pty Ltd - Perth (09) 429 6000 

• Aspect Computing - Sydney (02) 99281188 

Melbourne (03) 9818 0604 Adelaide 

(08) 8379 0466 Canberra (06) 247 7608 

• Auldhouse Computer Services - Chatswood 

(02) 9415 3955 Melbourne (03) 9804 5648 

Brisbane (07) 32212105 

• Citidata - Sydney (02) 99061935 

• Com Tech Communications Pty Ltd - Sydney (02) 

9317 3088 Melbourne (03) 9696 0770 

Brisbane (07) 32212444 Perth (09) 322 5605 

Adelaide (08) 82718600 Canberra (06) 257 

7695 

• Dialog Pty Ltd - Brisbane (07) 3368 2011 

• Educom - Melbourne (03) 9670 0388 

Sydney (02) 9957 1633 Canberra (06) 257 6606 

• Global Knowledge Network - Sydney 

1-800 647 468 Melbourne (03) 9275 3333 

• Imageword - Adelaide (08) 83618533 Brisbane 

(07) 38541149 Canberra (06) 257 5045 Perth 

(09)4818820 

• InfoMat - Melbourne (03) 9888 6399 

• The Training Group of Newcastle - Newcastle 

(049) 672 777 

• The Quill Consultancy - Hobart (03) 622 8277 

• VMARK - Sydney (02) 9290 3811 

IiMicrosoft Authorized Apple Macintosh 
Training Centers 

• Apple Centre - Alice Springs (089) 529 300 

Apple Centre - Darwin (089) 430 649 

• Random Access WA - Perth (09) 278 1000 

• Choice Systems - North Sydney (02) 9957 4314 

• CPM&S Group - Norwood (08) 362 4949 

• Forrest Training - Sydney (02) 9262 2284 

• Logical Solutions Training Centre - Sydney 

(02) 367 8505 Deakin (06) 283 3244 South 

Melbourne (03) 9696 5608 Spring Hill 

(07) 3832 3999 

• The Quill Consultancy - Hobart (002) 238 277 
• The Training Group NSW - Waratah (049) 672 777 

Microsoft Solution Providers 
Authorized Training Centers 

• Aspect Computing - Canberra (06) 247 7677 

• Citidata - Deakin (06) 285 3902 

• Ferntree Computers - Canberra (06) 248 8488 

• ImageWord - Campbell (06) 257 5045 

• MTE - Canberra (06) 247 6333 

• Wizard Computer Training - Canberra 

(06) 275 0730 
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NSW-_ 

• ACCS Australian Centre for Computer Science 
North Sydney (02) 9957 4244 

• Applied Functional Training - St Leonards 
(02) 9906 3773 

• Aspect Computing - North Sydney 
(02) 9928 1188 

• Bolstler Fahey - Sydney (02) 9264 2203 
• Careers Business College - Dariinghurst 

(02) 9283 3388 
• Citidata - St Leonards (02) 9906 1935 
• Drake Training - Sydney (02) 9262 3900 North 

Sydney (02) 9929 0100 Parramatta (02) 9891 
1022 Newcastle (049) 29 4755 

• Educom - North Sydney (02) 9957 5833 
• Ferntree Computers - Sydney (02) 99311600 
• Forrest Training - Sydney (02) 9262 2284 
• ICOM Solutions - Sydney 

(02) 9261 2499 (02) 9891 4277 
• Integrated Business - Sydney (02) 9233 4000 

Caringbah (02) 9526 2455 
• InTouch Consultancy - Campbelltown 

(046) 250 986 
• MTE - Sydney (02) 9261 5555 Parramatta 

(02) 9891 3344 
• Network Logic - Sydney (02) 9233 7500 
• Poliak Partners - Sydney (02) 9262 3777 

Parramatta (02) 9687 1977 
• The Training Group - Newcastle (049) 67 2777 
• Training and Support- North Sydney (02) 9956 

6366 Parramatta (02) 9893 9000 

• Aspect Computing - Adelaide (08) 8379 0466 
• CitiSoft - Parkside (08) 8373 5000 
• Computer Management Centre - Adelaide 

(08) 8223 0600 
• CPM&S Group - Norwood (08) 8362 4949 
• Drake Training - Adelaide (08) 8212 4141 
• Ferntree Computers - Eastwood (08) 8373 0454 
• MTE - Adelaide (08) 8231 3048 
• Poliak Partners - Adelaide (08) 8362 0662 
• Protech - Adelaide (08) 8231 4066 
• The Learning Laboratory - Kent Town 

(08) 8362 4211 

aisL= 
• ACE Training - Brisbane (07) 3236 2434 
• Delta Technology - Spring Hill (07) 3832 5377 
• Drake Training - Brisbane (07) 3229 3827 
• Executrain Queensland - Brisbane 

(07) 3839 4900 
• Ferntree Computers - Milton (07) 3236 1114 
• Insight Training - Spring Hill (07) 3839 8244 
• MTE - Brisbane (07) 3221 3611 
• Technisyst - Brisbane (07) 3229 3150 

Xi!L= 
• Aspect Computing - Hawthorn (03) 9818 0604 
• Business Resolutions - Melbourne 

(03) 9650 4844 
• Computelec Australia - Seaford (03) 9786 7177 
• Drake Training - Melbourne (03) 9245 0444 
• Educom - Melbourne (03) 9670 0388 
• Ferntree Computers - Mount Waverley 

(03) 9541 5600 

94 COAMJNIQUEB 

• Franklin Collins - Melbourne (03) 9600 1577 
• Infomat Australia - Canterbury (03) 9888 6399 
• MTE Melbourne - (03) 9629 5811 
• Ong Training - Melbourne (03) 9529 8522 
• Poliak Partners - Melbourne (03) 9629 2977 
• RMIT Training - Melbourne (03) 9660 5100 
• Reflex Computer Services - Hawthorn 

(03) 9810 4545 
• VECCI (03) 9810 6295 

UB-z 
• AlphaWest Pty Ltd - West Perth (09) 429 6000 
• Australian Training Institutes - West Perth 

(09) 322 6150 
• Drake Training - Perth (09) 321 2600 
• Ferntree Computers - West Perth (09) 322 2730 
• MTE - Perth (09) 324 1142 

Iaz= 
• NDA Computing - Hobart (03) 6224 2660 

Launceston (03) 6334 4910 
• The Quill Consultancy - Hobart (03) 6223 8277 

Microsoft Authorised Support Centres offer a 
range of support services, including on-site 
support, help desk services and mission-critical 
support for all phases of planning, implementing 
and maintaining a client-server system. 
• AT&T Global Information Solutions 1-800 678 666 
• Digital Equipment Corporation - (02) 9561 5999 

or outside Sydney 1-800-657 542 
• Hewlett Packard (03) 9272 2577 
• Wang Australia - 13 2666 

The Microsoft Developer Network is a membership 
program that delivers complete, up-to-date 
information on Microsoft development technology. 
The Development Library, a quarterly CD, is the 
official vehicle for all the technical information 
necessary to program for Windows. The 
Development Platform is Microsoft’s distribution 
mechanism for software development kits and 
device driver kits. Microsoft Developer Network 
Subscribers can have exclusive access to a 
support package for developer products at special 
discounts. Special discounts on membership are 
available to Communique Care and Communique 
Pro members. 

For more details phone: 
(02) 9870 2111 or 1-800 257 253 
outside Sydney 

toft Consulting Services 

MCS provides high-level information technology 
consulting services to large businesses and 
corporations. 

Chris Fagan MCS Practice Manager - 
Australia: Telephone (02) 9870 2200 or fax 
(02) 9805 1108 

NSW - Hugh Jones MCS Branch Manager: 
Telephone (02) 9870 2200 or fax (02) 9805 1108 

ACT - Maneesh Sarvia MCS Branch Manager: 
Telephone (06) 273 2292 or fax (06) 273 2298 

VIC - Chris Worth MCS Branch Manager: 
Telephone (03) 9286 3200 or fax 
(03) 9286 3232 

WA - Gerard O'Neill MCS Branch Manager: 
Telephone (09) 420 8400 or fax (09) 420 8420 

QLD - Dean Dobson MCS Branch Manager: 
Telephone (07) 3218 7000 or fax 
(07) 3218 7099 

Solution Providers 

Microsoft Solution Providers are a network of 
highly skilled professionals who can implement 
and support the very latest technology. Their staff 
have a reliable set of technical skills and 
specialise in the building of complex solutions to 
help organisations. 
ACT - 
• Alternet Systems (06) 239 5540 
• Aspect Computing (06) 247 7677 
• Attachmate Australia (06) 247 2144 
• Australian Technology Resources (06) 2511100 
• CP Consulting (06) 283 6777 
• CSC Australia (06) 2018400 
• Digital Equipment Corporation (Australia) 

(06) 275 4800 
• Ferntree Computer Corporation (06) 248 8488 
• ImageWord (06) 257 5045 
• Ipex Information Technology Group 

(06) 209 8000 
• Praxa (06) 257 5666 
• Select Computer Technology 

(06) 241 5633 
• Softlaw Corporation (06) 242 1982 
• The Software Group (Aust) (06) 282 7022 
• Unisys Australia (06) 274 3544 
NSW- 

• Access I.T. Asia Pacific (02) 9954 3554 
• Advantage LAN Technology (02) 9904 8588 
• Anabelle Bits (02) 9384 8000 
• Applied Micro Systems (Australia) 

(02) 9934 5700 
• Aspect Computing (02) 9928 1188 
• Attachmate Australia (02) 9975 7188 
• Axiom Information Systems (02) 9957 6299 
• Business Computers of Australia Pty Ltd 

(02) 9934 6800 
• Cee Data (02) 9906 6100 
• Ci Technologies (02) 9855 1000 
• Clear Technology Pty Limited (02) 9310 3077 
• Cogita Business Services (02) 9413 4339 
• Computerland Bankstown (02) 9709 5366 
• Connections (TSIP) Pty Ltd (02) 9552 3088 
• Corporate Computer Sales (Australia) 

(02) 9417 5555 
• Cray Communications (02) 9928 0000 
• CSC Australia (02) 99011193 
• Digital Equipment Corporation (Australia) 

(02) 9561 5252 
• Eden Technology (02) 9241 3122 
• Educom Australia (02) 9957 5833 
• Equus Consulting (02) 9261 4567 
• Enterprise Solution Provider (02) 9929 8122 
• Ferntree Computer Corporation (02) 99311600 
• Fujitsu Australia (02) 9410 4555 
• Fusion Technology (02) 9955 7044 
• Future Technologies (02) 9299 1400 
• GEC Alsthom IT (02) 9415 0500 
• Grandmaster Computers (02) 9212 1900 
• Hewlett Packard Australia (02) 9950 7308 
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• Intergraph Corporation (02) 9886 6900 
• Ipex Information Technology Group 

(02) 9209 6666 
• JD Edwards Australia (02) 9816 3100 
• JNA Network Services (02) 9417 6177 
• Lanrex Consulting Services Pty Ltd 

(02) 9416 1100 
• Memorex Telex (02) 9805 5805 
• Metquip Systems (02) 9805 0311 
• MicroHelp (02) 9693 2544 
• NCR (Australia) (02) 9964 8111 
• Network Systems Technology (02) 9499 2900 
• NT Solutions (02) 9212 3999 
• Olivetti Australia (02) 9748 2600 
• Peterborough Software (02) 9975 7277 
• Platinum Software (Aust) (02) 9956 6166 
• PM2 Systems (02) 9956 8222 
• Poliak Partners (02) 9262 3777 
• PowerLAN Technologies (02) 9418 3600 
• Praxa (02) 9433 3333 
• Senteq Information Systems (02) 93910555 
• Siemens Nixdorf Information Systems 

(02) 9430 2100 
• Simply International (02) 9959 4555 
• Sloane Duff & Associates (02) 92111477 
• Software Spectrum (02) 9418 3811 
• Starcom Business Systems (02) 9882 0000 
• State Computer Supplies (02) 9957 1115 
• Strategic Software International (02) 9418 2900 
• Sysygy Computer Networks (02) 9911 7727 
• Tardis Pty Ltd (02) 9807 1777 
• Time-link (02) 9438 3977 
• TR Hall & Associates (02) 9264 5300 
• TSG Australia (02) 9211 3911 
• Unisys Australia (02) 9931 6666 
• WANG Australia (02) 9847 7100 
ULz 
• Digital Equipment Corporation (089) 463 000 

QLP- 
• Applied Micro Systems (Australia) 

(07) 3246 7700 
• Data #3 Business Systems (07) 3371 8088 
• Ferntree Computer Corporation (07) 32361114 
• Ipex Information Technology Group 

(07) 3406 5800 
• Praxa (07) 3369 8100 
• Software Spectrum (07) 3236 2099 
• Sunrise Computer Systems (07) 3368 3338 
• Technology One (07) 3870 2044 
• Unisys (07) 33611888 

SAzl. 
• Applied Micro Systems (Australia) 

(08) 8304 1700 
• Aspect Computing (08) 8379 0466 
• Computer Management Centre (08) 8223 0600 
• CPM&S (08) 8362 4949 
• Digital Equipment Corporation (Australia) 

(08) 8408 4100 
• Ferntree Computer Corporation (08) 8373 0454 
• Ipex Information Technology Group 

(08) 8379 6911 
• Lodin Computer Supplies (08) 8203 4000 
• Matcom Systems (08) 8269 7700 
• Protech Australia (08) 8231 4066 

TA?~ 
• Comstra (03) 6231 5266 
• Sleebs Computer Industries (03) 6234 6477 
• Tasram (03) 62311189 

XULz 
• Applied Micro System (Australia) 

(03) 9245 3700 
• Argus Computer Systems (03) 93291844 
• Aspect Computing (03) 9818 0604 
• Attachmate Australia (03) 9694 6711 
• Business Computers of Australia 

(03) 9282 0555 
• Communication Networks International 

(03) 9696 0500 
• Component Suppliers International 

(03) 9663 7999 
• Computelec (03) 9786 7177 
• Datum Management Systems (03) 9820 1988 
• Digital Equipment Corporation (Australia) 

(03) 9275 3333 
• Ferntree Computer Corporation (03) 9622 8000 
• Hewlett Packard (Australia) (03) 9272 2895 
• InfoMat Australia (03) 9888 6399 
• IPEX Information Technology Group 

(03) 9242 5000 
• MicroHelp (03) 9388 0111 
• MITS (03) 9613 9000 
• NCR (Australia) (03) 9321 3111 
• Oakton Computing (03) 9853 8855 
• Praxa Limited (03) 9690 3811 
• Protech Australia (03) 9690 6600 
• Senteq Information Systems (03) 9643 0999 
• Southern Cross Computer Systems 

(03) 9420 1700 
• Southmark Computer Systems (03) 9228 2004 
• Taskforce Computer Services (03) 9888 9233 
• Unisys Australia (03) 9522 3081 
• WANG Australia (03) 9246 4400 
WA-Z 
• Alpha West (09) 429 6000 
• Applied Micro Systems (Australia) 

(09) 265 9700 
• Australian Technology Resources (09) 483 8111 
• Ferntree Computer Corporation (09) 429 6777 
• Integrated Systems Australia (09) 470 4411 
• Q Technology (09) 367 4022 
• Southmark Computer Systems (09) 268 1500 
• Trilogy Resources (09) 324 1462 

APT-__ 
• LAN Manager User Group - Canberra 

(06) 267 6159 
• PC Users Group - Canberra (06) 239 6511 
NSW- 
• Apple and Macintosh Users Groups - 

Sydney (02) 9476 5792 
• Australian Windows Networking User Group - 

Sydney (02) 9390 6299 
• C Languages Users & Enthusiasts Society 

(CLUES) -Sydney (018) 614 227 
• Central Coast PC User Group - (043) 322 800 
• Club Mac Inc - Sydney (02) 9552 4126 or 

(043) 293 192 
• Fox User Group - Sydney (02) 9746 9500 
• Programming S.I.G. (SPCUG) - Sydney 

(02) 9599 1919 

Microsoft SQL Server User Group (02) 9888 9900 - 

Sydney BackOffice User Group, email: 

boug@aeronaut.com.au - Sydney Windows User 

Group (Excel and Word) (02) 9415 2420 - Sydney 

PC Users Group - Main Meeting and Windows SIG 

(02) 9972 2133 - Sydney PC User Group - Visual 

Basic SIG (02) 9873 3700 - Visual Basic Users 

Group (02) 9877 7225 

ViSLz 

• Access (Database) S.I.G. Melbourne - 

Melbourne (03) 9883 4382 

• FoxPro: The Melbourne Developer’s network - 

Melbourne (03) 9623 7668 

• Melbourne Access Users Group 

(03) 9727 3877 

• Melbourne PC User Groups (03) 9699 6222 

• Microsoft Office Users Group 131 983 

• Retired and Interested Persons Melbourne 

(03) 9803 6229 

• Victorian Mac Users Group - Melbourne 

(03) 9654 7322 

• Visual Basic Users Group (03) 9878 3451 

Old- 

• Apple-Q Inc - Brisbane (07) 3878 2834 

(after 7pm) 

• Brisbane Access Users Group (07) 3300 9999 

• Brisbug PC Users Group Inc (07) 3299 3943 

• Logan City PC User Group - Qld (07) 3208 2332 

• Pine Rivers IBM Compatible Computer Club 

(07) 38811553 

• Sunshine Coast Computer Users Group 

(074) 91 4680 

• Visual Basic Users Group (07) 3835 5610 

• Windows Pacific (formerly Brisbane Windows 

User Group) (07) 3899 1956 

Mzz 

• Computer Club of WA [Inc] (09) 332 6374 

• Perth FoxPro User Group (09) 306 4847 

• Perth PC User Group (09) 399 7264 

• Perth Windows User Group (09) 386 6677 

&9= 

• Adelaide Access for Users Group (08) 8287 1470 

• Adelaide PC Users Group (08) 8331 0766 

• Adelaide Micro Users Group Incorporated 

(08) 8384 3027 

• South Australian Apple Users Club Inc 

(08) 8293 7183 

• South Australian PC Users Group 

(08) 8341 9151 

• Visual Basic Users Group (08) 8223 7932 

ms-  
• The Hobart Computer Users Group 

(03) 6225 1280 
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Across 

1. Quick mod menu is assembled in this favourite magazine 
section. [14] 

9. Sinning within the tavern? [3] 

10. Left (without creating HTML) on time. [5] 

12.1 butter up any old how as a mark of respect. [7] 

13. A poster designed for the harbourside town. [7] 

14. High drama developed f|i§ rope. [5] 

15. Tense (non-cr rrtinaii wrong-doing, it’s said. [4] 

16. News (if done) is in this magazine 

19. A meal - to exist between the drinkseller and your turn at 
pool. [8] 

21. Single player^ issuing from toy© fpss.Jj] 

23. Or a right-wing Instance of rhetoric. [7] 

. 24. Cornered simpering little dev| [3j 

'25. KnockStl;® 

26. Bloodsucking lamprey i$ bapk. for shelter [3] 

■ 27. What a pity! There’s no sign of tea on tie 

28. Spypafcher lurking in endless oasis. [4]' 

29. Which person.is the harlot not concerned with? [3J 

30. Doze in a picnic basket [3] 

32. New SF game drives Catch 22 author round the twist, [10] ■ 

33. Say, why TV? [5] 

34. Begs for admiration, by the sound of it [5] 

35. Sedan abandoned in South American mountains. [5] 

1. A boy with his own story on CD-ROM excitedly out-talked his 
Nan OK. [17] 

2. Tha Magic School Bus meets him and is our smash-hit [8] 

3. Do your hair while in battle (on CD). [6] 

4. It’s common, so only shelter in the wind and the rain. [7] 

5. Navigation aid operating - lo, TRex - re-enter PIN. [16] 

6. Nun, I see, or mysterious mythological animal. [7] 

7. BG chose hot musical mixture for kids' CD-ROM tripper. [17] 

8. Certain coastline echoes [4] 

11. Oh, club is tastily served by Paul Bunyan's pancake chef. [15] 

17. Web and Net together now rolled in one magazine section. 

[11] 
18. Fanciful data’s OK for Paul Bunyan’s states. [7] 

20. Pays cash for extra runs in cricket, so they say. [4] 

21. Excitedly J persuade with top plan. [9] 

22. Pal cut at vandalised new secure proxy server [8] 

31. Give birth to a large furry animal. [4] 

SEND YOUR ENTRY TO: 

The Editor 

Microsoft Communique 

115 Alexander St 

Crows Nest 2065 

AND WIN 
Encarta 97 for 
Windows 95 

Encarta 97 
World Atlas for 
Windows 95 

Golf 3.0 for 
Windows 95. 



Finally, a really easy way to zip and un-zip 
files - just drag and drop!. Now you can com¬ 
press and extract files with just one click, 
view and even run zipped files without unzip¬ 
ping, and manage all your Internet downloads 
with MicroHelp Zip. For Windows 3.x or 
Windows 95. 

PowerDesk is the Windows 95 desktop that 
works the way you do. It combines a fully 
customisable toolbar with an enhanced 
version of the Windows 95 Explorer. You have 
immediate access to everything you need to 
work more quickly and easily. 

Every Windows application puts bits and 
pieces of itself in places you don’t know 
about. And files that seem to belong to one 
program are often shared by another. 
Uninstaller performs an intelligent series of 
scans on your hard drive to discover the 
interrelationships between files, then guides 
you through the safe removal of the ones you 
don’t need. It also allows you to move, dupli¬ 
cate and archive files. Contains Windows 3.x 
and Windows 95 versions. 

ALL THESE PRODUCTS COME WITH UNLIMITED 
FREE TECHNICAL SUPPORT FROM MICROHELP! 

Harvev Norman 
_We’re on the Web! http://www.harvey-norman.com.au_ 

SYDNEY METRO • ARNCLIFFE 9599 1366 • AUBURN 9202 4888 • BALGOWLAH SUPERSTORE 9948 4511 • BLACKTOWN 9831 2155 • CAMPBELLTOWN (046) 28 4088 • CARINGBAH SUPACENTA 
' 9542 7088 • CHATSWOOD WALLACEWAY 9419 6133 • FAIRFIELD 9727 8777 • GORDON 94981499 • MOORE PARK SUPACENTA 9313 6500 • PENRITH (047)321566 • WILEY PARK 9740 6055 NSW 

COUNTRY • ALBURY (060) 41 1944 • ARMIDALE (067) 713788 • BATHURST (063) 32 3399 • COFFS HARBOUR (066) 51 9011 • DENILIQUIN (058) 81 5499 • DUBBO (068) 84 4977 • ERINA (043) 67 6444 
• GRAFTON (066) 43 3266 • INVERELL (067) 21 0811 • LISMORE (066) 21 8888 • MAITLAND (049) 34 2423 • MOREE (067) 52 7531 • MUDGEE (063) 72 6514 • NEWCASTLE (049) 48 4555 • NOWRA 

I (044) 21 5755 • ORANGE (063) 614111 • PARKES (068) 62 2800 • PORT MACQUARIE (065) 81 0088 • TAMWORTH (067) 66 3999 • TAREE (065) 51 3699 • WAGGA WAGGA (069) 21 7100 • WARRAWONG 
] (042) 75 2722 • YOUNG (063)82 5744 ACT • FYSHWICK (06)280 4140 • WODEN PLAZA (06)2822511 BRISBANE METRO • CARINDALE (07)3843 1700 • JINDALEE (07)3279 0244 • MT GRAVATT 

(07)38494299 • WINDSOR (07) 3357 7777 • GOLD COAST (07) 5538 3155 OPEN 7 DAYS QUEENSLAND COUNTRY • SUNSHINE COAST (074)44 8277 OPEN 7 DAYS • BUNDABERG (071) 51 1570 
• CAIRNS (070) 51 8499 • MACKAY (079) 42 2688 • NORTH ROCKHAMPTON (079) 26 2755 ■ TOWNSVILLE (077) 25 5561 VICTORIA SUPERSTORES • DANDENONG (03) 9706 9992 • MARIBYRNONG 

i (03) 9318 2700 • MOORABBIN (03) 9555 1222 • NUNAWADING (03) 9872 6366 VICTORIA COUNTRY • BALLARAT (053) 32 9344 • BENDIGO (054) 47 2333 • GEELONG (052) 74 1077 • MILDURA 
I (039) 416 8033 • SHEPPARTON (058) 23 2530 HN14146 



Build a Better Web Site @ PowerUp! 
Professional Web Site Hosting 

Building a presence on the Internet requires a significant 

investment of time and money. So ensure your Site is a 

complete success by choosing PowerUp Web Hosting Service. 

PowerUp Web Hosting lets you locate your Web Site on our 

High Performance Internet Web Servers. You will also have 

access to our full range of web site services including • Domain 

Name Registrations, ‘Virtual Email Accounts, ‘Automatic 

Email Forwarding, ‘CGI-Scripting, ‘SSL Security, ‘Usage 

Statistics, ‘Primary and Secondary back up strategies, ‘SQL 

Databases and expert advice. And in case you didn't notice, 

we also let you build your web site with Microsoft's 

FrontPage™ and fully support FrontPage™ Extensions. 

Phil 800 800 099 
PowerUp Pty Ltd ACN 068 604 955 

Web http://webhost.powerup.com.au 

Email webhost@powerup.com.au 

Web developers & consultants ask about our dealer program. 

We have taken into account that your Site needs to be 

flexible and able to expand with your business. Our range 

of hosting solutions can meet the needs of small sites ($25 

per month plus setup fee*) through to large private servers 

with live data feeds. 

Our comprehensive information pack, written in ‘Plain 

English’, explains our services and gives you some helpful 

tips and suggestions. 

Whether you're building a new web site or contemplating 

moving an existing one, call us for the PowerUp Web 

Hosting Information Pack. 

To receive your FREE ‘Plain English’ Information Pack photocopy this page and fax | 
the coupon to 1800 640 098. 

Name: 

Company: 

Address: 1 

Suburb: P/C i 

Phone: Facsimile: i 


